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Preface

Thermo™ XReport is the custom reports application for the Thermo Xcalibur™ mass 
spectrometry data system. Use XReport to create custom reports.

To provide us with comments about this document, please click the link below. Thank you in 
advance for your help. 

Related Documentation
Thermo Fisher Scientific provides these documents for the Xcalibur data system:

• Xcalibur Getting Started (Quantitative Analysis) 

• Acquisition and Processing User Guide

• Quantitative Analysis User Guide

• Qualitative Analysis User Guide

• Creating and Searching Libraries User Guide

• XReport User Guide

• Help from within the software

Contents

• Related Documentation

• Safety and Special Notices

• Contacting Us
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Preface
Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

Safety and special notices include the following:

Contacting Us
There are several ways to contact Thermo Scientific for the information you need. 

 To contact Technical Support

Find software updates and utilities to download at mssupport.thermo.com.

 To contact Customer Service for ordering information

 To copy manuals from the Internet

Go to mssupport.thermo.com, agree to the Terms and Conditions, and then click 
Customer Manuals in the left margin of the window. 

IMPORTANT  Highlights information necessary to prevent damage to software, loss of 
data, or invalid test results; or might contain information that is critical for optimal 
performance of the system.

Note  Highlights information of general interest.

Tip  Helpful information that can make a task easier.

Phone 800-532-4752

Fax 561-688-8736

E-mail us.techsupport.analyze@thermofisher.com

Knowledge base www.thermokb.com

Phone 800-532-4752

Fax 561-688-8731

E-mail us.customer-support.analyze@thermofisher.com

Web site www.thermo.com/ms
viii XReport User Guide Thermo Scientific
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Preface
 To suggest changes to documentation or to Help

• Fill out a reader survey online at http://www.surveymonkey.com/s/PQM6P62.

• Send an e-mail message to the Technical Publications Editor at 
techpubs-lcms@thermofisher.com.
Thermo Scientific XReport User Guide ix
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1

Introduction to XReport

XReport is the custom reports feature of the Xcalibur data system. Use XReport to create 
customized reports containing all of the results and important information produced with the 
application. In addition, use XReport to format a report to a style, print the report, and save 
the report in text (.txt file), Microsoft™ Word™ document (.doc file), Microsoft Excel™ 
workbook (.xls file), rich text (.rtf file), portable display ( .pdf file), or Web page (.htm 
or .html file) formats. Use these options to e-mail reports or display them on the Internet.

Create Xcalibur reports containing the following:

• Textual information (for example, sample information)

• Tabulated information (for example, a calibration file table)

• Graphical information (for example, a spectrum or a chromatogram)

The XReport Window
The XReport window is split in four different panes:

• Sections pane 

• Objects pane 

• Template pane 

• Report Template Outline pane 

See Figure 1 for the location of the panes. 

Contents

• The XReport Window

• Overview of Report Templates

• Configuring XReport Objects

• Using XReport
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The XReport Window
Figure 1. XReport window

The Sections pane lists the available sections for the selected application (for example, 
Xcalibur). To add a section to a report, drag it from the Sections pane to the Template pane. 

The Objects pane lists the objects that are available for the currently selected section. To add 
an object to a report, drag it from the Objects pane to the currently selected section in the 
Template pane. 

Use the Template pane to configure a report layout by dragging and arranging objects. 

• To configure a report object, right-click it and choose Properties from the shortcut 
menu. 

• To configure a repeating section, right-click the QL or QN icon in the left margin of the 
page at the top of the sections pane and choose Properties from the shortcut menu. The 
size of the page in this pane corresponds to the size of a standard 8.5 × 11 in. piece of 
paper in either portrait or landscape mode. 

• Adjust the height of sections by dragging the bottom border of the section downward. 
A selected section has a bright blue border around it. 

Sections
pane

Objects
pane

Template pane Template outline pane
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The Report Template Outline pane lists the sections that are in the current report. You can 
move or delete sections from this pane, as well as un-dock, reposition, or close it. 

• To un-dock the pane, drag the top gray portion away from the pane. 

• To redisplay the pane, choose View > Report Template Outline pane.

• To delete a section from a template, click it in the Report Template Outline pane and 
press DELETE. 

• To move a section, drag it up or down in the Report Template Outline pane list. You 
cannot move the header and footer sections. 

• To select and scroll to a section, double-click it.

Overview of Report Templates
This section defines the basic terminology used throughout the software and this manual for 
new users of XReport and the Xcalibur data system. This section defines the following key 
terms: 

• Report Template

• Sections

• Report Objects (for more information, see Appendix B, “Types of Report Objects.” )

• Data Source Files (.pmd, .raw, .rst, .sld, .xcal)

• Report

Report Template

An XReport template is an XReport document (.xrt file) that defines the content, layout, and 
style of a report. Use the template to include sections and report objects (for example, graphs, 
tables, annotation text, or graphics) in a report template. The software generates an Xcalibur 
report after combining a report template with Xcalibur data (data source files).

XReport provides several example report templates for you to use. These are located in the 
Xcalibur\Templates folder. For details about the preconfigured report templates, see 
Appendix A, “Sample XReport Template Files.” 
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Sections

Divide the report template in sections to hold report objects. Add sections to a report 
template using the Sections pane in the XReport window.

The basic types of section used in XReport are as follows:

• Header or Footer Sections

• Repeating Sections

• Nonrepeating Sections

A report object that is placed in a repeating section can behave differently from the same 
report object placed in a nonrepeating section when the software combines a report template 
with data. For information on how a report object functions when it is placed inside or 
outside a repeating section, see Appendix B, “Types of Report Objects.” 

Header or Footer Sections

A header or footer section is a section of the report that is automatically repeated at the top 
and bottom of each page in the resolved report. Header and footer sections can contain 
objects such as a company logo, report information, page numbers, and date stamps.

Repeating Sections

A repeating section is a section of a report template that is automatically repeated for every 
component or peak in a resolved document. Change the properties of a repeating section to 
customize its behavior.

Two types of repeating section can be used in an XReport template:

Nonrepeating Sections

A nonrepeating section usually displays static details associated with data or methods that 
apply once and globally within the system (for example, processing method settings, 
instrument method settings, filename, confirmation ion information, and so on).

Qual repeating section Use a Qual repeating section to display details relating to a 
single Qual peak within some data. The section is repeated for 
all Qual peaks found.

Quan repeating section Use a Quan, or component, repeating section to display 
details relating to a single Quan peak in some data or a 
component configured in a processing method. The section is 
repeated for all Quan peaks or components.
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Report Objects

Report objects are customized tables, graphics, or text that indicate what kind of data appears 
in the report. When the Xcalibur data system combines a report template with data, it 
replaces the report objects in the report template with data to generate a report. See “Report 
Objects” on page 163 for more information.

Report objects include the following: 

• Text Objects

• Table Objects

• Graphic Objects

• Formatting Objects

For a descriptive listing of XReport objects, see Appendix B, “Types of Report Objects.” 

Text Objects

Text objects contain static text labels and associated customized data fields. To customize the 
specific fields to display, right-click the object and choose Properties from the shortcut menu. 
The Configuration dialog box opens. When the software combines a template with data to 
generate a report, it replaces the text object fields with textual information (static text). See 
“Text Objects” on page 182 for more information.

The following Xcalibur text objects are available in XReport:

• Annotation

• Component Ident/Detect/Cal Settings

• Component ISTD Settings Summary

• Component Settings Summary

• Component Sys Suit/Flags Settings

• Instrument Method

• Processing Method - General

• Processing Method - Qual

• Quan ISTD Peak Summary

• Quan Peak Summary

• Report Info

• Sample Header
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Table Objects

When the Xcalibur data system combines a template with data, it replaces table objects with 
tabulated information (creates a populated data table). Configure or change the properties of a 
table object to customize its output. XReport provides the following table objects:

Graphic Objects

When Xreport combines a report template with data, it replaces graphic objects with 
graphical information. Configure or change the properties of a graphic object to customize its 
output. See “Graphic and Formatting Objects” on page 163 for more information. The 
following graphic objects are available in XReport: 

• Bitmap

• Chromatogram

• Component Cal (Calibration) Curve

• Spectrum

• Avalon Qual Events Table

• Avalon Quan Events Table

• Calibration File Table

• Component Cal Level Table

• Component QC Level Table

• Component Spectrum Table

• Dilution Factor Table

• Electronic Signature

• Ion Ratio Confirmation Results Table

• IRC Settings Table

• IRC Summary Table

• Lib. Search Graph Table

• Lib. Search Results Table

• Proc. Method Programs Table

• Proc. Method Sample Reports Settings 
Table

• Proc. Method Summary Reports 
Settings Table

• Qual Peak Table

• Qual Summary Table

• Quan Peak Table

• Quan Summary Table

• Sample Table (Quan Results)

• Sequence Table

• Spectrum Candidate Results Table

• Spectrum List Table
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Formatting Objects

These objects, which only format the report, are available in XReport:

• Columns

• Page Break

Data Source Files

Data source files are files that contain acquired data. For example, there are five types of 
Xcalibur data source files: 

• Processing method (.pmd)

• Raw (.raw)

• Result (.rst)

• Sequence (.sld)

• Calibration (.xcal)

Report 

Generate a report (or resolved document) using a report template. In an Xcalibur report, the 
software combines the report objects in the report template with Xcalibur data. Save and 
present reports in any of these formats: 

• Microsoft Word document (.doc file)

• Text (.txt file)

• Microsoft Excel workbook (.xls file)

• Rich text (.rtf file)

• PDF (.pdf file) 

• Web page (.htm or .html file)
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Configuring XReport Objects
Use the Template pane of the XReport window to configure objects by right-clicking them 
and choosing Properties from the shortcut menu. Set parameters in the configuration dialog 
box that opens. You can configure nearly all items in XReport, including the following:

• Repeating sections

• Tables

• Chromatograms

• Spectra

• Component calibration curves

• Text objects

For specific information on configuring each object, see Chapter 4, “Configuring Objects and 
Sections.” 

Configuring a Repeating Section 

Use the Repeating Section Configuration dialog box to specify:

• The type of repeating section, Qual or Quan

• Whether to exclude Internal Standards or Target Compounds from a Quan repeating 
section

• The order in which peaks and components are repeated

• Any limit on number of peaks to be reported

• How the individual peaks or components are split across pages in the final report

Configuring a Table 

Use the Table Configuration wizard to:

• Specify the columns to be included in the table

• Define and customize table columns

• Specify an order for the table
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Using the Chromatogram Wizard

Use the Chromatogram wizard to:

• Select chromatogram type and peak type

• Use a demonstration (demo) file

• Select plot details

• Select smoothing parameters

• Use MS Quan traces

• Configure the Chromatogram display, style, labeling, axes, and normalization methods

Configuring a Component Calibration Curve 

Use the Component Calibration Curve wizard to specify the name of the component plotted 
for a nonrepeating Component Cal Curve report object in a report.

Using the Data Source Browser

Use the Data Source Browser to select data files that can be used to generate reports from 
within XReport.

Sample XReport Templates

An XReport template is an XReport document (.xrt file) with XReport objects embedded 
within it. You do not have to create personal XReport templates. XReport provides 
customized report templates for you to use with your data. For full details of these report 
templates, see Appendix A, “Sample XReport Template Files.” 

Using XReport
To use XReport, read these topics:

• Starting XReport

• Selecting a Report Template

• Creating and Generating Reports with XReport

• Exiting XReport
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Starting XReport

 To start XReport 

1. From your computer taskbar, double-click  on the desktop, or choose 
Start > All Programs > Thermo Xcalibur > XReport.

When more than one application is installed that uses XReport for reporting (for 
example, both Xcalibur 2.0 and LCquan™ 2.5), the Template Configuration dialog box 
opens (see Figure 2). 

Figure 2. Template Configuration dialog box

2. Select the application for the report template and click OK. 

XReport opens and creates a new template (see Figure 3).
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Figure 3. XReport window, showing a new template

Selecting a Report Template

 To select a report template 

1. In the Reports view, choose File > Open. A browse dialog box opens.

2. To select the required report template, click the template name. If the name does not 
appear, browse to the correct folder.

The template name appears in the File name box. 

3. To view the report template and close the dialog box, click Open.
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Creating and Generating Reports with XReport

There are two distinct stages in the process of producing a customized Xcalibur report using 
XReport:

• Creating a Report Template

• Generating a Report Using a Report Template

These stages are discussed in more detail in these chapters: “Creating a Template” on page 15 
and “Generating a Report” on page 27.

Creating a Report Template

Use XReport to create a customized report template (.xrt file) that defines how the final report 
looks and defines the specific information in the report. 

 To create a report template

1. Click  to start XReport.

A new XReport document appears in the report window (see Figure 3).

2. Add sections and report objects to the report template by dragging items from the 
Available Sections and Available Objects panes to the report preview pane.

3. Configure the sections and report objects included in the report template to adjust their 
properties and customize their output.

Right-click objects and sections to configure and choose Properties from the shortcut 
menu. Set parameters in the configuration dialog boxes. Use the menus, toolbars, or 
mouse to align, resize, and reposition objects.

4. Save the report template.

For more detailed information on how to create and configure a report template, see 
Chapter 2, “Creating a Template,”  and Chapter 4, “Configuring Objects and Sections.” 

Note  The Xcalibur data system provides sample XReport templates for you to use. These 
are .xrt file with XReport objects embedded within them and are located in the 
Xcalibur\templates folder. For details on these report templates, see Appendix A, “Sample 
XReport Template Files.” 
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Generating a Report Using a Report Template

After creating a report template, generate a report (or resolved document) by combining a 
report template with one or more data source files (for example, Xcalibur .pmd, .raw, .rst, .sld, 
and .xcal files). 

There are three ways to generate a report:

• From a report template open in XReport: Search for the required data source files and 
combine the data with the template to generate a report. Preview, print, and save the 
report in .txt, .doc, .xls, .rtf, .pdf, or .htm format.

• From a data processing application (for example, Xcalibur): Associate the data you 
produce in the application with a report template (for example, do this in Quan Browser) 
and combine the data with the template to generate a single report.

• From a data processing application (for example, Xcalibur): Insert the name of the 
template to a processing method (such as Processing Setup) and generate reports 
automatically when you batch process data (such as in Sequence Setup).

Exiting XReport

 To save the report template or report and XReport

Complete or cancel any active dialog boxes and choose File > Exit.

Note  For detailed information on how to generate a report from within the Xcalibur 
data system, see Chapter 3.
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Creating a Template

This chapter explains how to create a personal report template. When you create a personal 
report template, you can save the template and use it to generate an Xcalibur report. For more 
information about generating a report, see Chapter 3.

When you start XReport, XReport creates a new template that includes header and footer 
sections (see Figure 4). Either work with this new template, or choose File > Open to open an 
existing template and select an XReport template (.xrt) file. To create a template, do the 
procedures in this chapter in order.

Figure 4. XReport window, showing a new template

Contents

• Adding, Ordering, and Configuring Sections

• Adding and Configuring Report Objects

• Previewing and Saving the Template
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Adding, Ordering, and Configuring Sections
To begin creating a template, select sections to include in the report template. Choose to 
include Quan-based or Qual-based repeating sections or nonrepeating sections in your report 
template. For a description of the different section types and how repeating sections work, see 
“Configuring a Repeating Section” on page 43.

Topics in this section:

• Adding, Deleting, or Reordering Sections

• Resizing Sections

• Configuring a Repeating Section

Adding, Deleting, or Reordering Sections

To add a section to the report, drag it from the Sections pane (upper left) to the Template 
pane (center). Add only one section to the template at a time.

To delete a section from the report, click it in the Report Template Outline pane (far right) 
and press DELETE. The system prompts you to confirm the deletion. You cannot delete the 
header or footer sections. When the Report Template Outline pane is not visible, choose 
View > Report Template Outline or right-click a section and choose Delete Section from 
the shortcut menu. 

To change the order of the sections in the template, drag them in the Report Template 
Outline pane. Header and footer sections must remain at the top and bottom of the list, 
respectively.

Resizing Sections

To automatically remove the extra space at the top and bottom of a section, select the section 
and choose Layout > Shrink Wrap.

To automatically add a half page of extra space at the bottom of a section, select the section 
and choose Layout > Expand.

To manually add or remove extra space at the bottom of a section, drag the bottom border of 
a section up or down.
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Configuring a Repeating Section

 To configure a Qual or Quan repeating section

1. Scroll to where you can see the QL or QN icon at the top left side of a section in the 
Template pane. 

2. Right-click the icon and choose Properties from the shortcut menu. The Repeating 
Section Properties dialog box opens (see Figure 5).

Figure 5. Repeating Section Properties dialog box

3. Set the parameters and click OK.

Adding and Configuring Report Objects
After adding and configuring sections, select the report objects you want to include in a 
specified section of the report template. Select from these options: text objects, table objects, 
graphic objects, and text, depending on the selections you made in Configuring a Repeating 
Section.

XReport displays the objects that are available for the currently selected section in the Objects 
pane (lower left). The contents of this pane change when you select different sections.

Topics in this section:

• Adding, Deleting, Repositioning, and Resizing Objects

• Aligning Objects

• Centering Objects

• Using the Report Template Grid
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• Using Columns

• Using Page Breaks

• Configuring Objects

• Adding User Text to a Text Object

• Adding a Formula to a Table

• Changing Font Settings

• Changing Page Layout

Adding, Deleting, Repositioning, and Resizing Objects

 To add an object to the report

Drag an object from the Objects pane (lower left) to the currently selected section (in 
blue) in the Template pane (center). Add only one object to the template at a time.

 To delete an object from the report

1. Select the object in the Template pane (center). Blue handlebars on each side and at each 
corner become visible.

2. Press DELETE.

 To reposition an object

Drag the object to the preferred location.

 To resize an object

Drag the object by one of the corner handles (small blue squares) until the object is the 
preferred size.

 To make two or more objects the same size

1. Select the first object to size. The size of the first object selected determines the size of 
subsequent objects.

2. Hold down the SHIFT key and select other objects to resize.

3. Click the button on the toolbar that corresponds to the dimension you want to resize:

Width, Height, or Both ( ).

To resize the columns in a table object, double-click the table. Handles (small blue 
boxes) appear on the interior column borders. Drag the handles to resize the columns. 
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Aligning Objects

 To align one or more objects

1. Select the first object to align. The position of the first object selected determines how 
subsequent objects are aligned.

2. Hold down the SHIFT key and select each object to align.

3. Click the button on the toolbar that corresponds to the edge to align: Left, Right, Top, 
Bottom.

Or click Auto Align to snap all objects to the nearest grid line. 

4. Choose View > Report Template Grid to view the grid lines. To adjust the grid settings, 
choose Layout > Preferences. The Preferences dialog box opens (Figure 6).

Centering Objects

 To center one or more objects

1. Select the first object to center. Hold down the SHIFT key and select each object to 
center.

2. To center the objects on the page, click the Center Horizontally or Center Vertically 
button on the toolbar.

Using the Report Template Grid

The Template pane has a grid built in it. Choose View > Report Template Grid to view the 
grid lines.

To adjust the grid settings, choose Layout > Preferences. The Preferences dialog box opens 
(see Figure 6). Set the spacing between grid lines and whether to snap objects to the grid as 
they are added to the Template pane.
Thermo Scientific XReport User Guide 19



2 Creating a Template
Adding and Configuring Report Objects
Figure 6. Preferences dialog box

Using Columns

Add columns to arrange other reporting objects so that they appear in columns. To add a 
column to the template, drag the column object from the Objects pane to the Template pane.

After adding a column object to the template, you can resize, reposition, and configure it. 

 To configure a column object

1. Right-click the column object.

2. Choose Properties from the shortcut menu. 

The Column Properties dialog box opens (see Figure 7). To learn how to configure 
columns and how columns work with different repeat types, see “Configuring Columns” 
on page 98.
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Figure 7. Column Properties dialog box

You can resize the entire column object (select it and drag the corner handles), but the 
columns within the column object remain equal in size.

After you have finished configuring the columns, drag objects to the columns.

Using Page Breaks

To add a page break to the template, drag the Page Break object from the Objects pane to the 
Template pane. After adding a page break to the template, drag the page break to reposition it. 

If you do not manually insert page breaks, objects automatically shift to a new page when 
there is not enough room on the current page. To preview where these automatic breaks occur, 
choose Layout > Preferences. The Preferences dialog box opens (Figure 6). Select the Show 
Page End check box.

Configuring Objects

 To configure an object

1. Right-click the object.

2. Choose Properties from the shortcut menu. The Properties dialog box opens. 

For information about configuring each of the specific objects, see Chapter 4. For a 
description of each object, including which sections each object can be used in, see 
Appendix B, “Types of Report Objects.” 
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Adding User Text to a Text Object

To add additional customized text headings to text objects, use the <Blank Line > and <User 
Text> Data Items. These items are available for all text objects except the Annotation object 
and the Instrument Method object.

 To add custom text to a text object

1. Right-click the text object and choose Properties from the shortcut menu. The Data 
Page opens. 

2. Select <User Text> in the Available Items list. 

3. To add a text item to the Selected list, click Add. 

4. To position the <User Text> item where you want your text displayed, click Move Up or 
Move Down. 

5. Select the <User Text> item. 

6. Type the text to display in the box below the Selected list and press Apply. 

The Xcalibur data system displays the text you entered in the Selected list.

 To edit a <User Text> item

1. Select the item to edit in the Selected list. 

2. Edit your text in the User box.

3. Press Apply. 

Adding a Formula to a Table

You can create custom formulas in XReport to perform mathematical operations on table data 
and display the result in a table column.

 To add a formula to a table

1. In your XReport template, right-click a table object and choose Properties. The Select 
Table Fields Page opens. 

2. Select one of the User Columns fields in the Available Columns list: [User Column 1], 
[User Column 2], [User Column 3], [User Column 4], or [User Column 5]. 

For the five User Column fields available, you can create up to five separate formulas for a 
single table.

3. Click Next to go to the Configure User Column Parameters Page. 

4. Type a title for this column in the User Column Title box. 

5. Click Edit Formula. The Edit Formula For Dialog Box opens. 
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6. Enter a formula in the Formula box. Formulas can be entered in one of several ways: 

• Type formulas directly in the box. Formulas obey the following syntax rules: 

– The formula must begin with an equals sign (=). 

– Each table column is represented by an alphabetic letter identifier (A, B, C, and 
so on), displayed beneath the column title in the Table object. 

• Type simple mathematical expressions (A+B, A-B, A*B, and A/B), as well as any of 
the functions listed in the Functions list. 

Mathematical formulas are computed on a row-by-row basis. That is, if you 
type =A+B as a formula in a User Column, the results are computed as follows:

– The value in the first row of column A is added to the value in the first row of 
column B, and the result appears in the first row of the User Column. 

– The value in the second row of column A is added to the value in the second row 
of column B, and the result appears in the second row of the User Column. 

– This process is continued until all rows of the table have been completed. 

• Select a function from the Functions list and click Add Function. The Configure 
Function Dialog Box opens. Select the columns to be used with the function. When 
you configure your function and click OK, XReport enters the configured function 
in the Formula box. 

7. When you have entered your formula, click OK to close the Edit Formula For dialog box 
and return to the Table Properties wizard. Continue through the remaining pages of the 
wizard to finish configuring your table. 

Changing Font Settings

Use XReport to change font settings globally or locally for text and table objects. When you 
change the font settings globally, each object added from that point forward appears in the 
new fonts (objects that are already in the template are not updated). When you change font 
settings locally, only the selected objects reflect the new font settings.

 To change the font settings for a single object

1. Select the object and click  on the toolbar to open the Font dialog box, or right-click 
the object and choose Properties from the shortcut menu to open the Properties dialog 
box and display the Font page. Both of these pages provide the same settings.

2. Update the settings and click OK.

 To change the font settings for more than one text or table object at a time

1. Select the first object. 

2. Hold down the SHIFT key while you select the other objects.
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3. Click  on the toolbar. The Font dialog box opens.

4. Update the settings and click OK.

 To globally change the font settings used for all new objects to add to the template

1. Click any section and confirm that no objects are selected.

2. Click  on the toolbar. The Font dialog box opens.

3. Update the settings and click OK.

Changing Page Layout

 To change the page layout 

1. Choose File > Page Setup. The Page Setup dialog box opens (see Figure 8).

2. Change any of the following: header and footer section heights, portrait or landscape page 
orientation, or margins.

3. Click OK to change the page layout.

Figure 8. Page Setup dialog box
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Previewing and Saving the Template
 To preview the appearance of the template 

1. Choose File > Simulate Report. The Preview window opens (see Figure 9). The Preview 
window shows the report with the default data.

Figure 9. Preview window

2. When the report is correct, click Close to close the preview window.

3. To save the template, choose File > Save. To save changes to a locked template choose 
File > Save As and rename the file.

 XReport uses the steroid example data that is shipped with the Xcalibur software as the 
default data set. It consists of the following files:

• steroid.pmd

• steroids02.raw

• steroids02.rst

• steroid.sld

When your template is designed for a very different type of data set than the default data, 
you might not see the results you expect when you preview the template. In that case, 
choose appropriate data sources for the template and create the report as described in 
“Creating a Report Within XReport” on page 27.
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Use XReport to lock a template so that it can never be modified and saved with the same 
filename. To modify a locked template, save it with a different filename. Choose File > 
Open to open a locked template the same way you open any other template.

 To lock the template

1. Choose File > Save As. The Save As dialog box opens (see Figure 10).

Figure 10. Save As dialog box, showing XReport Templates

2. Give the report template an appropriate name and save it in the Xcalibur\templates folder 
with the templates that ship with the Xcalibur software.

3. Select the Lock Template check box and click Save.
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Generating a Report

To generate an Xcalibur report (resolved document), combine a report template with one or 
more Xcalibur data source files (.pmd, .raw, .rst, .sld, .xcal files). 

There are two ways to generate reports:

• Use the XReport Data Source Browser to automatically search for the required data 
source files and combine the data with a template to generate a report. This method 
generates a single report.

• Associate the data you produced in the Xcalibur data system with a report template and 
combine the data with the template to generate a report. This method generates multiple 
reports from the data system.

Creating a Report Within XReport
To create a report within XReport, use these procedures:

• Choosing Data Sources for a Template

• Generating, Saving, and Printing a Report

Choosing Data Sources for a Template

The process of generating a report from an XReport template involves using the Data Sources 
Dialog Box to search for the required data source files. The data source files required to 
generate a report depend on the content (sections and report objects) of the report template. 
To learn which data files are needed for each type of report object, see Appendix B, “Types of 
Report Objects.” 

Contents

• Creating a Report Within XReport

• Creating a Report from the Xcalibur Data System
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Creating a Report Within XReport
 To resolve a template with data

1. To open the template (.xrt file), choose File > Open in XReport.

2. Select the template and click Open.

3. Choose Report > Data Sources. The Data Sources dialog box opens (see Figure 11).

Figure 11. Data Sources dialog box

4. In each box, enter or search for a data file.

5. Click OK.

Note   If you specify an .rst file that references a .raw file and that .raw file does not 
exist or is in the wrong folder, XReport sends an error message. Make sure the .raw file 
is in the correct folder.
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Generating, Saving, and Printing a Report

 To create a report using selected data sources

1. Choose Report > Resolve Report in XReport. The Preview window opens (see 
Figure 12). The Preview window shows a report combined with chosen data sources. 

Figure 12. Preview window

2. Click Save to save the report in the following file formats: Microsoft Word (.doc), 
Microsoft Excel (.xls), Web page (.htm or .html), rich text (.rtf ), PDF (.pdf ), or 
text (.txt).

3. To print the report, click Print.

4. To return to the XReport window, click Close.
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Creating a Report from the Xcalibur Data System
When generating a report, the Xcalibur application combines the data that you produced in 
the data system with a report template. You can generate multiple reports from the data 
system.

Generate a report from the following areas of the application:

• See Generating a Report From Sequence Setup when running a sample or sequence and 
batch processing.

• See Generating a Report From Quan Browser when using the Reports dialog box.

In addition, when generating reports from the Xcalibur data system, create reports containing 
electronic signature information.

Sample Reports and Summary Reports

To set up reporting options in the data system in Processing Setup or Quan Browser, select 
two types of reports: 

• Sample reports to print reports that give information about individual samples 

• Summary reports to print reports that give summary information about an entire 
sequence or set of samples

The example template files included with XReport indicate the specific templates to use to 
generate sample reports or summary reports. For descriptions of sample files, see “Sample 
XReport Template Files” on page 101.

Generating a Report From Sequence Setup

To generate reports from the Sequence Setup window, create a processing method that 
includes the necessary report options on the Reports page of the method.

Use the Sequence Setup window to generate reports when running a sample or sequence or 
batch processing a sequence.

See these topics for more information:

• Setting up Report Options in Processing Setup

• Generating Reports when Running a Sample or Sequence

• Generating Reports when Batch Processing a Sequence

Note  To proceed, you must have a basic understanding of the Xcalibur data system. Refer 
to Xcalibur Getting Started Guide for more information.

Note  Always save and close the report template in XReport before using it to generate a 
report from the Xcalibur data system.
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Setting up Report Options in Processing Setup

 To set up report settings in the Processing Setup window

1. Open the Processing Setup window and set up a processing method. For more 
information, refer to the Acquisition and Processing User Guide.

2. Choose View > Reports. The Reports view opens.

3. To add one or more reports to either the sample or summary report tables:

The sample table lists the reports to be produced for processed samples in a sequence. The 
Summary table lists the reports to be produced for sequences or brackets.

a. Click the Enable column to display a check box and select the check box to enable 
the report.

b. To create a sample table, select the Std, QC, Unk, and Other check boxes.

c. Select the output for the report in the Save As column. Choose from None (this 
prints the report, but does not save it), or .txt, .doc, .html, .pdf, .rtf, or .xls (select 
one of these options to save the report in the selected format).

The Xcalibur data system saves reports created from the processing method in the 
same directory as the source data files and names files. The reports use this format:

data file name template name.xxx

where 

data file name is the name of the data file from which the report was generated

template name is the name of the template used to generate the report 

xxx is the suffix (for example, .doc or .pdf ) indicating the file type

When more than one report is generated from the same data file and template, 
XReport adds a date stamp before the suffix.

d. Double-click the Report Name column to select an XReport template (.xrt file) to use 
for this report.

4. Save the processing method.

Generating Reports when Running a Sample or Sequence

 To generate reports when running a sample or a sequence

1. Set report options in a processing method as described in Setting up Report Options in 
Processing Setup.

2. In the Xcalibur Sequence Setup window, open the sequence.

3. Specify the processing method that includes all of the report options in the Proc Meth 
column.
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4. When running a sequence, drag the leftmost column to specify the rows to be processed 
from the current sequence. The application highlights the selected rows.

When running a sample, select the leftmost column of the sample row.

5. Choose Actions > Run This Sequence or Actions > Run This Sample. The Run 
Sequence (see Figure 13) or Run Sample dialog box opens.

Figure 13. Run Sequence dialog box

The application displays the sequence rows or sample selected in step 4 in the Run Rows 
box.

6. Select the Reports check box in the Processing Actions area.

7. Set all of the other parameters.

8. Click OK. The Xcalibur application starts processing the selected sample or samples.
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Generating Reports when Batch Processing a Sequence

 To generate reports when batch processing a sequence

1. Set report parameters in the processing method as described in “Setting up Report 
Options in Processing Setup” on page 31.

2. In the Xcalibur Sequence Setup window, open the sequence.

3. Enter the processing method that includes all of the report options in the Proc Meth 
column.

4. Specify the rows to be processed from the current sequence by dragging the leftmost 
column. The Xcalibur application highlights the selected rows. 

5. Choose Actions > Batch Reprocess. The Batch Reprocess Setup dialog box opens (see 
Figure 14).

Figure 14. Batch Reprocess Setup dialog box

The Xcalibur data system displays the sequence rows selected in step 4 in the 
Process Rows box.
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6. If necessary, change the rows to be processed by entering the first and last row to be 
processed in the Process Rows box. The format is either nRow for one sample or 
First Row# – Last Row# for multiple samples.

7. Select Quan or Qual processing actions and select from active options. 

8. Select from these XReport processing options: 

• To create reports while batch processing, select the Reports check box.

• To print reports for the samples displayed in the Process Rows box, select the Print 
Sample Reports option. You defined the Sample report parameters in the Reports 
view of the Processing Setup window.

• Select the Print Summary Reports option to print reports for the samples that are 
displayed in the Process Rows box. You defined the summary report parameters in the 
Reports view of the Processing Setup window.

• Select programs, spreadsheet, and advanced options. 

9. Click OK. The Xcalibur application initiates batch processing of the selected samples.

Generating a Report From Quan Browser

 To generate a report from the Quan Browser window

1. Open the Quan Browser window. The Xcalibur application displays the Open dialog box.

2. To select a sequence, select an .sld file with samples to use in the reports.

3. Click Open.

4. Choose View > Reports Dialog. The Reports dialog box opens (see Figure 15).
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Figure 15. Reports dialog box in the Quan Browser window

5. To make a row of the sample reports area active, click the Enable box in the first row and 
click the Enable box again. A check box appears in the box.

6. Click the check box. When you click the check box again, the application displays the 
word Yes in the Enable box to indicate that the entire row of options is selected.

7. To select the report type to print for the sample, click one of the following boxes: Stds, 
QCs, Unks, or Other. A check box control appears.

8. Click the check box. When you click the check box again, the application displays the 
word Yes in the Enable box to indicate that reports are to be printed for all selected 
samples of this sample type.

9. Repeat steps 6 and 7 to print reports for needed sample types.

10. To display the Open Report Template dialog box, double-click the Report Template 
Name box. Select the previously prepared report template document and click Open. The 
Xcalibur data system displays the full path and the file name of the report template .xrt 
document in the Report Template Name box.

11. To print reports for each report template document, repeat steps 5 through 10 for the 
next row. 

12. To make all of the sample reports you have selected for printing available, click the 
Include Sample Reports check box at the bottom of the Reports dialog box. Click 
the Include Summary Report check box to make summary reports available.
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13. To open the Select Report Samples dialog box, click Select Samples. The samples 
available from the .sld file opened in step 2 appear in the Sample Choices box (see 
Figure 16).

Figure 16. Select Report Samples dialog box

14. Select the samples: 

• For a group of contiguous samples, click the first of the sequence, scroll until you see 
the last sample in the sequence and, while holding down the SHIFT key, click the last 
sample in the sequence. The data system highlights the selected sequence. 

• For a group of non-contiguous samples, hold down CTRL while you click each 
sample to select or clear it. The data system highlights the selected samples. 

15. To copy the selected samples to the Selected Samples area, click Add.

16. To return to the Reports dialog box, click OK.

17. To print reports, click Print Reports. Prior to printing reports, the Xcalibur application

• Displays the Printer Activity icon at the bottom of the Quan Browser window.

• Combines the data in the sample file with the selected Report Template document.

• Adds the report printing tasks to the processing queue and displays the Printing 
message box.

After printing the reports, the application returns you to the Quan Browser window. 
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The application saves reports created from the processing method in the same directory as the 
source data files and names files. The reports use this format: 

data file name template name.xxx

where 

data file name is the name of the data file from which the report was generated,

template name is the name of the template used to generate the report, and 

xxx is the suffix (for example, .doc or .pdf ) indicating the file type.

When more than one report is generated from the same data file and template, XReport adds 
a date stamp before the suffix.

Creating a Signed Report

When generating reports from Quan Browser or by batch processing in Sequence Setup, you 
can create signed reports containing electronic signatures. 

 To create a signed report

1. Create a report template containing the Electronic Signature table object or choose one of 
the preconfigured templates supplied with XReport. All of the preconfigured templates 
contain the Electronic Signature table object in the footer. 

2. Confirm that the Xcalibur Authorization Manager settings are set to require electronic 
signatures at the report generating step. See Configuring Authorization Manager Settings 
for Signed Reports for that process. 

3. Generate the report.

Configuring Authorization Manager Settings for Signed Reports

In order to produce signed reports with electronic signatures, configure the Xcalibur 
Authorization Manager Settings to require signatures. The Xcalibur data system 
administrators must perform this configuration before setting permissions in either Quan 
Browser or Sequence Setup.

 To set permissions for producing signed reports from Sequence Setup

1. Choose Start > All Programs > Thermo Foundation 1.0 > Authorization Manager. 
The Authorization Manager window opens (see Figure 17). 

2. Expand the Home Page entry. In the directory tree, expand the Sequence Operations 
entry in the permission level pane. 

3. Select Batch Reprocess from the list of operations below Sequence Operations.

4. Select Signature List in the Permission Level area.
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5. In the Signature List Groups area, select a group from the Available groups list and 
click >> to move it to the Signatures req’d list. The members of this group must type their 
logon names and passwords to electronically sign the report when it is generated.

6. To require signatures from additional groups, repeat step 5 to add them to the Signatures 
req’d list. 

7. To require a signature from the current user when the report is generated, select the 
Current User Must Sign check box.

At this point, the settings should be similar to the settings in Figure 17. 

Figure 17. Sequence Setup settings for producing signed reports 

Note  If you do not have any groups available or if the groups do not contain the 
correct members, refer to the Xcalibur Administrator’s Guide for information on how 
to create and modify groups.
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 To set permissions for producing signed reports from Quan Browser

1. Choose Start > All Programs > Thermo Foundation 1.0 > Authorization Manager. 
The Authorization Manager window opens (see Figure 18). 

2. In the tree directory, expand the Quan Browser entry and expand the Print entry.

3. Select Print Reports.

4. In the Permission Level area, select Signature List.

5. In the Signature List Groups area, select a group from the Available groups list and 
click >> to move it to the Signatures req’d list. The members of this group are required to 
type their logon names and passwords to electronically sign the report when it is 
generated.

6. To require signatures from additional groups, repeat step 5 to add them to the Signatures 
Req’d list. 

7. To require a signature from the current user when the report is generated, select the 
Current User Must Sign check box.

At this point, the settings should be similar to the settings in Figure 18. 

Note  If you do not have any groups available or if the groups do not contain the 
correct members, refer to the Xcalibur System and 21 CFR Part 11 Compliance 
Administrator Guide for information on how to create and modify groups. 
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Figure 18. Quan Browser settings for producing signed reports 

8. Click OK to save the settings and close the Authorization Manager dialog box. 
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Generating Signed Reports

Once you have a template containing an Electronic Signatures object, generate the report as 
described in “Generating Reports when Batch Processing a Sequence” on page 33 or in 
“Generating a Report From Quan Browser” on page 34. The Xcalibur data system prompts 
you to type signature information when the report is generated. Each user whose signature is 
required must type their logon name and password to sign the report. Figure 19 displays an 
example of a signature dialog box.

Figure 19. Example of a signature dialog box 
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Configuring Objects and Sections

You can configure the following objects and sections in XReport. When you configure an 
object, you can change or edit only the individual properties of that specific object. When you 
add another object of the same type to the report, XReport inserts it with the default settings.

Configuring a Repeating Section
There are two different types of repeating sections in XReport:

Contents

• Configuring a Repeating Section

• Configuring a Text Object

• Configuring an Annotation Object

• Configuring a Table Object

• Configuring a Bitmap Object

• Configuring a Chromatogram

• Configuring a Component Calibration Curve

• Configuring a Spectrum

• Configuring Columns

Qual repeating 
section

Displays details related to a single Qual peak in some data. The 
section is repeated for all Qual peaks found.

Quan repeating 
section

Displays details related to a single Quan peak in some data or a 
component configured in a processing method. The section is 
repeated for all Quan peaks or components.
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In the Repeating Section Properties dialog box, specify these parameters:

• Whether to exclude internal standards or target compounds from a Quan repeating 
section

• The repeat order for peaks and components

• Any limit on the number of peaks to be reported

• How the individual peaks or components are split across pages in the final report

 To configure a Qual or Quan repeating section

1. Scroll to where you can see the QL or QN icon at the top left side of the Template pane 
and right-click the icon. 

2. Choose Properties from the shortcut menu. The Repeating Section Properties dialog box 
opens (see Figure 20). This dialog box has three pages: Exclude (available for a Quan 
repeating section only), Ordering, and Page Breaks.

Figure 20. Exclude page in the Repeating Section Properties dialog box

3. When configuring a Quan repeating section, use the Exclude page to exclude specific 
elements from the process and discard any components that have not been found.

a. From the Exclude Component Type list, define the exclusions for the Quan repeating 
section by selecting one of the following options:

• None (no exclusions) - the default

• Internal Standards

• Target Compounds

b. To discard any components that have not been found, select the Show Only Found 
Components check box.
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4. Click the Ordering tab to display the Ordering page. Use this page to change the default 
ordering of processed results, defining the order of peaks and components in either a 
Qual or Quan repeating section (see Figure 21). 

Figure 21. Ordering page in the Repeating Section Properties dialog box

a. To specify the order for the repeating section in the Repeating Section Ordering area, 
select one of the following options from the Order By list:

• RT (Retention Time) - the default

• Component Name (Quan only)

• Peak Height Intensity

• Peak Area Intensity

• Peak Response Intensity (Quan only)

• Component Concentration (Quan only)

b. To define the direction for the ordering in the Ordering Direction area, select one of 
the following options: 

• Ascending: Sort data in ascending order

• Descending: Sort data in descending order

c. To set a maximum number of peaks or components to order (up to 999) in the Limit 
Repeating Records maximum area, select the Limit number of reported peaks or 
components check box and select a value from the active box.

5. Click the Page Breaks tab to display the Page Breaks page. Use this page to define the 
layout for the individual peaks that appear in the Qual or Quan repeating section in the 
final report (see Figure 22).
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Figure 22. Page Breaks page in the Repeating Section Properties dialog box

Select the option either to print each peak on its own pages or to avoid page breaks 
between the individual peaks. 

6. When you have made selections in the Repeating Sections Properties dialog box, 
click OK. 

7. Choose File > Save to save any changes.

Configuring a Text Object
To configure a text object, right-click the object and choose Properties. A dialog box opens 
(see Figure 23), named for the type of object you chose. For a description of each text object, 
including which section each object is in, see Appendix B, “Types of Report Objects.” 
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Figure 23. Data page in the Sample Header dialog box 

Use the dialog box to configure a text object within the report. 

Use the Text Object Properties dialog box for these tasks:

• Configuring Text Fields

• Adding Custom Text Fields

• Configuring Text Attributes

• Setting Text Fonts

Configuring Text Fields

 To configure the text object

1. To include a custom title for the object, select the Include the title on the resolved 
report check box on the Data page of the Text Object Properties Dialog Box.

2. Click Include and type a name in the active Title box.

3. Select the items to include from the Available Items list.

• Select an item and click Add.

• Double-click an item.
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• To move all available fields, click Add All.

The fields you have chosen appear in the selected list.

4. Select the fields in the Selected list that you do not want to include and click Remove.

5. To change the order of the selected items in the Selected list box, select an item and click 
Move Up or Move Down.

6. To edit a data label, select it in the Selected list and edit its text in the Data label box. 
Headings cannot be edited. However, use User Text items to add custom Headings to a 
text object. See Adding Custom Text Fields. 

7. Click OK to save your changes and close the dialog box.

Adding Custom Text Fields

Add a custom text field to the text object to use as a heading or annotation. 

 To add a custom text field

1. On the Data page, select <User Text> in the Available Items list and click Add (see 
Figure 24). 

Figure 24. Adding a custom text field
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2. Select <User Text> in the Selected list.

3. Type the text in the text area and press ENTER (see Figure 25).

Figure 25. Customizing a text field

4. Click OK to save your changes.
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Configuring Text Attributes

To configure text attributes, right-click a text object in the template and choose Properties 
from the shortcut menu. A dialog box opens. Click the Attributes tab (see Figure 26).

Figure 26. Attributes page in the Sample Header Properties dialog box

 To configure attributes

1. To format the text in columns, select the number of columns in the Number Of Columns 
area.

2. To include data labels in the object in the Horizontal Spacing area, select the Include 
data label check box.

3. To add extra space between data labels and data, select the Include spacing between a 
label and its data check box.

4. Select a line spacing option in the Vertical Spacing area.

5. Click OK to save your changes.
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Setting Text Fonts

To set text fonts, right-click a text object and choose Properties from the shortcut menu. A 
dialog box opens and you can select a font type for the title, heading, data label, and data. 
Click the Font tab (see Figure 27).

Figure 27. Setting fonts

 To set the font for a specific type of text for each button on the page

1. Click a text type button. The Font dialog box opens (see Figure 28).

Figure 28. Font dialog box
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2. Make the font selections and click OK.

Configuring an Annotation Object
You can include an annotation object in any section type. 

 To configure the Annotation object

1. Right-click the annotation object in the template and choose Properties from the 
shortcut menu. The Annotation Properties dialog box opens (see Figure 29).

Figure 29. Data page in the Annotation Properties dialog box

2. On the Data page, click the box on the Annotation Properties dialog box to get a cursor. 
Delete the words Enter your text here and type annotation text.

3. On the Attributes page, select the number of columns to display annotation text in the 
Number of columns area (see Figure 30).

Note  The Heading Font selection is also used for User Text. See “Adding Custom 
Text Fields” on page 48.
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Figure 30. Attributes page in the Annotation Properties dialog box

4. In the Horizontal alignment area, select an alignment option for the annotation text: 
Left, Center, or Right.

5. In the Vertical spacing area, select a spacing option for the annotation text line: Single, 
1.5 lines, or Double.

6. On the Font page, configure the font by setting the font parameters (see Figure 31).

Figure 31. Font page in the Annotation Properties dialog box

7. Click OK to save your changes.
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Configuring a Table Object
 To configure a table object

1. Right-click the table object.

2. Choose Properties from the shortcut menu. The Table Properties wizard opens (see 
Figure 32), named for the type of table you selected. For a description of each table, 
including the sections where a table can appear, see Appendix B, “Types of Report 
Objects.” 

Figure 32. Select Table Fields page

Using the Table Properties wizard, configure a table object included in the report template by 
changing its properties. Use the wizard for the following:

• Choosing Table Columns

• Configuring Custom (User) Columns

• Specifying Table Sort Order

• Setting Table Fonts

• Setting Additional Table Properties
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Choosing Table Columns

To select the columns to include in the table (see Figure 32), use the Select Table Fields page 
of the Table wizard. The columns available for a table appear in alphabetical order, but can be 
added to a report template in any order. Your column options to select depend on the type of 
table object you are configuring.

 To select options for the Select Table Fields page of the Table wizard

1. To include a custom title for the table, type the title in the Title box and select the 
Include the title on the resolved report check box.

2. To select the columns to include in the table from the Available Columns list, choose one 
of these options.

• Select an item and click Add.

• Double-click an item.

• To move all available fields, click Add All.

The fields you have chosen appear in the selected list.

3. Type the column heading text in the Column Header box. 

4. To arrange the order of the selected columns in the Selected Columns list, click Move Up 
or Move Down.

5. Click Next to go to the next page of the wizard.

Configuring Custom (User) Columns

The Configure User Column Parameters page of the Table wizard appears only if you chose to 
include custom User Columns in the table. Use this page to define parameters for each User 
Column in the table (see Figure 33).

You can use the User Columns to define mathematical formulas for calculating table data. 
Formulas obey the following syntax rules:

• The formula must begin with an equals sign (=). 

• Each table column is represented by an alphabetic letter identifier (A, B, C, and so on) 
that appears beneath the column title in the Table object. 

Note   All table objects have user columns available for selection. Use the user 
columns to define formulas for calculating table data and to display the results in the 
table. For more information on user columns, see Configuring Custom (User) 
Columns.
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• The mathematical expressions are kept simple, for instance, type A+B, A-B, A*B, or A/B. 
This is true as well for any of the functions listed in the Functions list of the Edit Formula 
dialog box. Formulas are computed on a row-by-row basis. That is, if you type =A+B as a 
formula in a User Column, the results are computed as follows:

a. The Xcalibur data system adds the value in the first row of column A to the value in 
the first row of column B and displays the result in the first row of the User Column.

b. The data system adds the value in the second row of column A to the value in the 
second row of column B and displays the result in the second row of the User 
Column.

c. The data system continues this process until all rows of the table have been 
completed.

Figure 33. Configure User Column Parameters page

The Xcalibur application displays the User Columns you have selected for the table in the 
User Columns list.
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 To define each user column

1. Select a user column in the User Columns list.

2. Type a title for the user column in the User Column Title area.

3. Click Edit Formula in the User Column Formula area. The Edit Formula dialog box 
opens (see Figure 34).

Figure 34. Edit Formula For dialog box

For the selected column, edit a formula for the user column and configure valid fields and 
associated functions. Below the functions list is a brief description of each function at the 
bottom of the dialog box.

4. To enter a formula in the Formula box, select a function from the Functions list and click 
Add Function or type directly in the box.

5. When you click Add Function, a configuration dialog box opens for that function. For 
example, for the Average function, choose the column to average.

6. To return to the Configure User Column Parameters page, click OK.

7. Click Next to go to the next page of the wizard.
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Specifying Table Sort Order

Use the Set Table Sort Filter page of the Table wizard to define a method for sorting table data 
when you generate a report (see Figure 35).

Figure 35. Set Table Sort Filter page

XReport displays the columns selected for the table in a list on the left side of the dialog box. 
Set the order for the table using any of the selected columns. Use up to three columns for 
ordering the table: The first order takes precedence over the second order, which takes 
precedence over the third order. 

 To define a method for ordering data in the table 

1. To select a variable to provide the first level of sorting for the table, double-click the item 
in the column list to move it to the First Order box.

2. To define how to sort the First Order column data in the Current Sorting Configuration 
area, select one of the following options:

• Ascending: Sort data in ascending order.

• Descending: Sort data in descending order.

3. To define the second and the third variable used to order table columns, repeat the first 
two steps.

4. To move to the Font page, click Next.
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Setting Table Fonts

Use the final page of the Table wizard, the Set Table Font page, to set the font type for 
elements in the table (see Figure 36).

Figure 36. Set Table Font page

 To define the font for a specific element

1. Click the appropriate button. The Font dialog box opens (see Figure 37).

Figure 37. Font dialog box

2. Select font options and click OK. Repeat the process as needed for other table elements.
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Setting Additional Table Properties

After completing the Table wizard, additional Properties dialog boxes appear for the following 
table objects:

• Library Search Graphics Table Properties

• Library Search Results Table Properties

• Sample Table Properties

• Spectrum List Table Properties

• Electronic Signature Table Properties

Library Search Graphics Table Properties

To set Library Search Graphics Table properties, right-click the table and choose Properties 
from the shortcut menu. The Table Properties wizard opens. When you complete the wizard 
and click Finish, the Library Search Graphics Table Properties dialog box opens (see 
Figure 38). Click Cancel to close the dialog box.

Figure 38. Library Search Graphics Table Properties dialog box

 To set parameters in this dialog box

1. Type the total number of search results to display in the table in the 
Max # of hits to display box.

2. To display column labels, select the Display Column Labels check box.

3. To show the peak spectrum, select the Show Peak Spectrum check box.

4. Click OK. Choose File > Save to save any changes made.
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Library Search Results Table Properties

To set Library Search Results Table properties, right-click the table and choose Properties 
from the shortcut menu. The Table Properties wizard opens. When you complete the wizard, 
the Library Search Results Table Properties dialog box opens (see Figure 39).

Figure 39. Library Search Results Table Properties dialog box

 To set parameters in this dialog box

1. Type the total number of search results to display in the table in the Max # of hits to 
display box.

2. Click OK.

Sample Table Properties

To set Sample Table properties, right-click the table and choose Properties from the shortcut 
menu. The Table Properties wizard opens. After completing the wizard, the Sample Table 
Properties dialog box opens (see Figure 40).

Figure 40. Sample Table Properties dialog box
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 To set parameters in this dialog box

1. To include standards, QCs, blanks, or unknowns in the Sample table, select the 
corresponding check boxes.

2. Click OK.

Spectrum List Table Properties

To set Spectrum List Table properties, right-click the table and choose Properties from the 
shortcut menu. The Table Properties wizard opens. After completing the wizard, the 
Spectrum List Table Properties dialog box opens (see Figure 41).

Figure 41. Options page in the Spectrum List Table Properties dialog box

This dialog box has four pages:

• Options Page

• Plot Type Page

• Enhancement Page

• Display Page

Options Page

 To set parameters on the Options page

1. Select or clear the Use processing method properties ... check box (see Figure 41).

When you select this check box, the application hides the parameters on the Plot Type 
and Enhancement pages.

2. To use the ISTD peak when repeating on a component, select the corresponding check 
box. You must select the Use processing method properties for plot type... check box to 
activate the ISTD peak option. (This option only applies when this object is used in a 
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Quan repeating section. It is not available when the Spectrum List Table is used in a Qual 
Repeating Section.)

3. Click OK.

Plot Type Page

Before viewing and selecting the parameters on the Plot Type page, clear the Use processing 
method properties... check box on the Options page and click the Plot Type tab.

 To set parameters on the Plot Type page 

1. Type the mass range to display in the Mass range box. Separate the values by a dash: 
lowmass-highmass. Type * to display the entire range (see Figure 42).

Figure 42. Plot Type page in the Spectrum List Table Properties dialog box

2. Select the type of detector that you are using from the Detector list: MS or PDA.

3. Type the time range to display in minutes in the Time box. Type the values separated by a 
dash: firsttime-secondtime. Type * to display the entire range.

4. Enter the scan filter to use with the data in the Scan Filter list.

5. Type or search in the Demo File box for the name of the file you to use as a 
demonstration file for the settings in the template.

6. Click OK.
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Enhancement Page

 To set parameters on the Enhancement page 

1. To add smoothing to the data, select the Enable check box in the Smoothing area (see 
Figure 43).

Figure 43. Enhancement page in the Spectrum List Table Properties dialog box

2. To select a type of smoothing, select Boxcar or Gaussian from the Type list.

3. Select the number of smoothing points (odd numbers from 3 to 15) to be used in the 
Points list.

4. To refine the data, select the Enable check box in the Refine area.

5. To define an area for drawing a peak, type the number of seconds on either side of the 
specified point. A reasonable initial value for the window is the peak width in seconds. 

6. Type the cutoff point for peaks in the Noise Threshold box. To show all peaks in the 
spectrum, type 0. Return to this box to eliminate more noise. Slowly increase the value 
until the noise peaks are eliminated. Use this setting to eliminate peaks generated from 
baseline noise. 

7. To turn on a first baseline region that is used for assessing background subtraction, select 
one or both of the Time Range check boxes. Type the time range to use in the box.

The Background Subtraction area shows details of background subtraction if applied to 
the spectrum. The background contribution is determined by averaging the scans from 
one or two baseline regions. 

8. Click OK.
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Display Page

 To set parameters on the Display page

1. To display all peaks in the spectrum, select the All Peaks check box or, to limit the display 
to the strongest peaks, type a value in the Top box (see Figure 44).

Figure 44. Display page in the Spectrum List Table Properties dialog box

2. To order the data by mass or by intensity, select the appropriate option in the Order by 
area.

3. Type a value representing the relative abundance range of mass peaks to include in the 
table in the Normalization area.

4. Click OK.

Electronic Signature Table Properties

Use the Electronic Signature table object to specify whether the Created By signature block 
appears before or after the Signed By signature block. 

 To configure the Electronic Signature table object

1. Right-click the Electronic Signature table object and choose Properties from the shortcut 
menu. The Electronic Signature Properties dialog box opens (see Figure 45).
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Figure 45. Electronic Signature Properties dialog box

2. To display the Created By signature block before the Signed By signature block, select the 
Created by first option in the Signature Information Order area or, to display the Signed 
By block before the Created By block, select the Signed by first option. 

3. Click OK.

Configuring a Bitmap Object
 To configure the bitmap object

1. Right-click the bitmap object and choose Properties from the shortcut menu. The 
Bitmap Properties dialog box opens (see Figure 46).

Figure 46. Bitmap Properties dialog box

2. Enter the name of the image file. Choose one of the following file 
formats: .bmp, .dib, .gif, .jpg, or .ico.

3. To set the size of the bitmap image to the size of the original file, click Reset to original 
size. 

4. Click OK.
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Configuring a Chromatogram
 To configure a chromatogram report object

1. Right-click the object and choose Properties from the shortcut menu. The 
Chromatogram Properties dialog box opens (see Figure 47). 

Figure 47. Chromatogram Properties dialog box

2. Click Configure. The Chromatogram Properties wizard opens.

The Chromatogram wizard guides you through the process of changing the properties of 
a chromatogram report object contained in the report template.

The XReport Chromatogram wizard displays different pages and contains different 
options depending on the type of section containing the chromatogram and the selections 
for the Chromatogram Type and Peak Type properties.

Table 1 lists the wizard pages and their order. Each wizard page is described in a topic 
below. See the appropriate topic to learn how to complete each wizard page.
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When the chromatogram report object to be configured is contained in a Quan or Qual 
repeating section, the default Chromatogram Type is Quan or Qual Result Based with no 
explicit Peak Type set. The next page of the wizard (Use Container Supplied Quan (or Qual) 
asks you to confirm this.

Table 1. Possible Chromatogram wizard pages, given the section type, in order of appearance 

Nonrepeating section Repeating section

Page in the XReport Chromatogram wizard Raw Quan Qual Quan Qual

Use Container Supplied Quan Peak •

Use Container Supplied Qual Peak •

Select Chromatogram Type • • • •*

* This page is not displayed if you selected Explicitly Specify the Chromatogram’s Behavior on the Use Container Supplied Quan or Qual 
peak page.

•

Select Demo File • • • • •

Select the Quan Peak • •**

** This page is only displayed if you selected Explicitly Specify the Chromatogram’s Behavior on the Use Container Supplied Quan or Qual 
peak page.

Select Component •

Select the Qual Peak • •

Select Mass Spectrum Quan Traces to Display • •

Configure How the Peak Window Will Look • • • •

Select Plot Details •

Select Enhance Details •

Select Chromatogram Style • • • • •

Select the Peak Labeling • • • • •

Select How the Chromatogram Axis Will Be Configured • • • • •

Configure Normalization for the Chromatogram • • • • •

Note   When you click the All Qual Peaks option for a Qual Result Based Chromatogram, 
the wizard page order is the same as for the Qual Result Based Chromatogram Type 
without the Select Qual Peak page.
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Use Container Supplied Quan Peak Page

Use the Use Container Supplied Quan Peak page to display the details of the internal standard 
associated with the implicit Quan peak or ignore the implicit Quan peak and explicitly 
configure the chromatogram type.

 To explicitly configure a Quan-based chromatogram type

1. To display the details of the internal standard associated with the implicit Quan peak, 
select the Use Quan peak’s associated Internal Standard check box in the Implicit Quan 
peak options area (see Figure 48).

Figure 48. Use Container Supplied Quan Peak page

2. To ignore the implicit Quan peak supplied by the container and explicitly configure the 
chromatogram type, select the Explicitly specify the chromatogram’s behaviour check 
box in the Explicit chromatogram type area.

3. Click Next to go to the next page of the wizard.
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Use Container Supplied Qual Peak Page

Use the Use Container Supplied Qual Peak page to ignore the implicit Quan peak and 
explicitly configure the chromatogram type.

 To explicitly configure a Qual-based chromatogram type

1. To ignore the implicit Quan peak supplied by the container and explicitly configure the 
chromatogram type, select the Explicitly specify the chromatogram’s behaviour check 
box in the Explicit chromatogram type area (see Figure 49).

Figure 49. Use Container Supplied Qual Peak page

2. Click Next to go to the next page of the wizard.

Select Chromatogram Type Page

Use the Select Chromatogram Type page to set the chromatogram type for the chromatogram 
report object being configured in the report template.

 To select a chromatogram type 

1. Define the chromatogram type in the Chromatogram Type area (see Figure 50) by 
selecting one of the following options:

• Raw file based chromatogram

• Quan results based chromatogram

• Qual results based chromatogram
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Figure 50. Select Chromatogram Type page

2. If you select a Qual results based chromatogram in step 1, select the Show all Qual peaks 
in result file check box to display all Qual peaks in a resolved Xcalibur report. This is a 
Peak Type setting.

3. Click Next to go to the next page of the wizard.

Select Demo File Page

Use the Select Demo File page to associate a demonstration file (.raw or .rst file) with a 
chromatogram report object. A demo file shows how the chromatogram report object appears 
in the report template and in wizard page previews with its current settings when applied to 
real Xcalibur data. 

The appearance of the Select Demo File page depends on the chromatogram type and the 
peak type settings chosen in the Chromatogram Type page of the wizard.

• Raw File Based Chromatogram

• Quan Result Based Chromatogram

• Qual Result Based Chromatogram - Explicit Peak

• Qual Result Based Chromatogram - All Available Peaks
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Raw File Based Chromatogram

When configuring a chromatogram report object based on a raw file, use this procedure to 
select a file. 

 To select a demo file for a raw file-based Chromatogram

1. To associate a demo file with the chromatogram report object, select the Use demo file 
check box (see Figure 51).

Figure 51. Select a raw file based chromatogram

2. To search for the required demo file (.raw file), click the browse button in the Demo File 
area. The Select Raw Data File dialog box opens.

3. Select a demo file and click Open. Click Next to go to the next page of the wizard.
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Quan Result Based Chromatogram

When configuring a chromatogram report object based on Quan results, use this procedure to 
select a file. 

 To select a demo file for a Quan-based chromatogram

1. To associate a demo file with the chromatogram report object, select the Use demo file 
check box (Figure 52).

Figure 52. Selecting a Quan result based chromatogram

2. To search for the required demo file (.raw file), click the browse button in the Demo File 
area. The Select Raw Data File dialog box opens.

3. Select a demo file and click Open.

4. To specify the peak to demo, click the browse button in the Demo Peak area. The Select a 
Peak dialog box opens.

5. Select a peak from the list located in the result file. 

6. Click OK to apply the selection and return to the wizard.

7. Click Next to go to the next page of the wizard.
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Qual Result Based Chromatogram - Explicit Peak

When configuring a chromatogram report object based on Qual Results with an explicit Peak 
Type required, use this procedure to select a file. 

 To select a demo file for a Qual-based chromatogram

1. Select the Use demo file check box to associate a demo file with the chromatogram report 
object (see Figure 50 on page 71).

Figure 53. Selecting an explicit peak in a Qual result based chromatogram

2. To search for the required demo file (.raw file), click the browse button in the Demo File 
area. The Select Raw Data File dialog box opens.

3. Select a demo file and click Open. 

4. To specify the peak to demo, click the browse button in the Demo Peak area. The Select a 
Peak dialog box opens.

5. Select a peak from the list located in the result file. 

6. Click OK to apply the selection and return to the wizard.

7. Click Next to go to the next page of the wizard.
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Qual Result Based Chromatogram - All Available Peaks

When configuring a chromatogram report object that is Qual result based with Show all Qual 
peaks set (peak type setting), use this procedure to select a file.

 To select a demo file for all available peaks

1. To associate a demo file with the chromatogram report object (see Figure 51), select the 
Use demo file check box.

2. To search for the required demo file (.raw file), click the browse button in the Demo File 
area. The Select Raw Data File dialog box opens.

3. Select a demo file and click Open. Click Next to go to the next page of the wizard.

Select the Quan Peak Page

Use the Quan Peak page to explicitly specify the Quan peak (component) for a Quan results 
based chromatogram report object.

 To specify a Quan peak 

1. To specify the Quan peak, type the text name of the component in the Quan Peak area 
(see Figure 54). 

Figure 54. Select the Quan Peak page

2. To search for the required processing method file (.pmd), click the browse button. The 
Select Component dialog box opens.

a. Select a processing method file. 

b. Choose a component in the Use the Select Component dialog box. Click OK to 
return to the wizard. The Next button is active only after you have entered a 
component.
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3. Select the Use Quan peak’s associated Internal Standard check box of the Quan peak to 
use the selected the associated internal standard of the Quan peak instead of the Quan 
peak.

4. Click Next to go to the next page of the wizard.

Select the Qual Peak Page

Use the Select the Qual Peak page to explicitly specify the Qual peak for a Qual Results Based 
chromatogram report object.

 To specify a Qual peak 

1. To specify the Qual peak in the Qual Peak to Display area, type the appropriate retention 
time in the Retention time box (see Figure 55).

Figure 55. Select the Qual Peak page

The Next button is active only after you have selected a component in the Retention time 
box. Set the retention time to any time within the start and end peak boundaries.

2. Click Next to go to the next page of the wizard.

Note   Select a valid peak for XReport to resolve the report correctly. If the file used to 
resolve the report does not contain the specified peak, the Xcalibur data system 
removes the chromatogram from the resolved report.

Note   Select a valid retention time for XReport to resolve the report correctly. If the 
file used to resolve the report does not contain the specified retention time, the 
chromatogram is removed from the resolved report.
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Select Mass Spectrum Quan Traces to Display Page

Use the Select Mass Spectrum Quan Traces to Display page to configure the Quan Traces 
property for MS data. (This page is only applicable to MS data and is inactive for other 
detector types.)

When a chromatogram report object displays a Quan component, there are potentially six 
traces associated with the component, as follows: 

• Quan Mass (QM) Trace - the actual component peak

• Up to five Confirmation Ions

Select any of these possible six traces to be displayed in the Chromatogram or display all 
available traces of the component.

 To specify a Quan trace 

1. Select the Quan trace in the Quan Traces area to be used from the Quan Traces list (see 
Figure 56).

Figure 56. Select Mass Spectrum Quan Traces To Display page

2. Select All Quan Traces from the list.

3. To normalize all the traces the same way, select the Common normalization for all 
traces check box.

4. Click Next to go to the next page of the wizard.

Note  The Ion Ratio Confirmation settings on this page apply only to GC-MS data.
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Configure How the Peak Window Will Look Page

Use the Configure How the Peak Window Will Look page to control the display of the 
baselines (Quan and Qual peaks) and the peak window width (active for Qual peak and Quan 
peak in some cases) when a peak from a result file is set to display in a Chromatogram.

 To configure the Peak window 

1. Select the Show Baselines check box to display the baselines for a Chromatogram peak 
(Quan or Qual) (see Figure 57). When you clear this option, XReport does not display 
the baselines, peak tracing, or full peak annotation.

Figure 57. Configure How the Peak Window Will Look page

2. To manually override the default value of the peak window width (the default is peak 
width plus 1 min), select the Set Custom Window Width check box. Use the Custom 
width edit box to type a value for the window width (min). The default value for this field 
is 0.75 min.

3. Click Next to go to the next page of the wizard.

Select Plot Details Page

Use the Select Plot Details page to configure how the plot is drawn when raw data is being 
displayed in a chromatogram report object.

 To configure a plot on a raw file-based chromatogram

1. Select the type of detector used to generate the raw file from the Detector list in the 
Plot Type area (see Figure 58). The type of detector determines the available traces.
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Figure 58. Select Plot Details page

2. Type in the offset of the start of a chromatogram trace in the Delay box. This box is 
available only when you select a non-MS detector type, such as UV or PDA.

3. From the Filter list, select the processing applied to a subset of the scans in a .raw file. 

This option is available only when you select MS detectors. The list displays scan filter 
options stored in the selected demo .raw file. If no demo file is selected, type a valid filter 
string.

4. From the Trace lists, select the following:

a. From the first list, select a basic chromatogram type, for example, TIC.

b. From the second list, select a logical operator: + or -. Selecting an operator makes the 
third list active. 

c. From the third list, select a second chromatogram type to add to, or subtract from, 
the first trace (for example, Mass Range). The list features valid plot types.

The list of valid traces depends on the detector used to generate the data as follows:

Detection Valid traces

MS Mass Range, TIC, and Base Peak

Analog Analog 1-4

A/D card A/D Card Ch 1-4

PDA Wavelength Range, Total Scan, and Spectrum Maximum

UV Channel A-D
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5. Depending on the type of chromatogram you select, do the following: 

a. If you choose MS detector types, specify the mass or mass range for Mass Range or 
Base Peak Traces in the Mass list as follows: 

If you choose Base Peak ± Mass Range or Mass Range ± Mass Range plot 
combinations in step 4 above, the identification page displays a Mass (m/z) field for 
each trace type.

b. If you choose other detector types, use this field to specify the wavelength or 
wavelength range for the chromatogram. If you use a plot combination such as 
Wavelength Range + Wavelength Range, an additional Wavelength (nm) box appears 
for you to specify the second wavelength range.

The valid range depends on the configured detector. The format is 
Low Mass/Wavelength–High Mass/Wavelength. Separate entries by a dash with no 
spaces. For example, for the range m/z 123 through 456, type: 123-456.

6. Specify the lower and upper time limits for the plot (in minutes to 1 decimal place) in the 
Time Range box. Separate entries by a dash with no spaces. 

Type * (the default setting) to display the complete time range for the plot.

7. Select the Fixed Scale check box to set the y-axis maximum to a specific value.

Selecting the Fixed Scale check box activates the Normalize To area on the final page of 
the wizard and the box where you type the maximum y-axis value on the current page. 

8. Select the Autofilter check box to repopulate a chromatogram view with the following:

• A plot showing the chromatogram without any scan filters

• Plots for each scan filter applied to the chromatogram

9. Click Next to go to the next page of the wizard.
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Select Enhance Details Page

Use the Select Enhance Details page to enhance a chromatogram plot by applying smoothing 
(see Figure 59).

Figure 59. Select Enhance Details page

 To enhance a chromatogram 

1. To apply smoothing to the chromatogram, select the Enable Smoothing check box.

2. To select a type of smoothing, select Boxcar or Gaussian from the Type list in the 
Smoothing Details area.

3. Select the number of smoothing points (odd numbers from 3 to 15) to use in the 
Points list.

4. Click Next to go to the next page of the wizard.

Select Chromatogram Style Page

Use the Select Chromatogram Style page to determine the appearance of the chromatogram.

 To define styles for a chromatogram 

1. To define the plotting style, select one of the following options in the Plotting area (see 
Figure 60):

• Point To Point: Display point-to-point peak profiles.

• Stick: Display the chromatogram as vertical lines.
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Figure 60. Select Chromatogram Style page

2. To define the plotting arrangement, select one of the following options in the 
Arrangement area:

• Stack (2D): Stack plots vertically (same x axis) with no overlap (own y axis).

• Overlay (3D): Overlay plots vertically (same x axis). Use the 3D arrangement when 
you selected Multiple Quan Traces on the Select Mass Spectrum Quan Traces page of 
the wizard.

3. When you select an Overlay (3D) arrangement, set the following in the active 3D area:

a. To set the Elevation angle (from 0 to 60 degrees) for the 3D plot style, adjust the 
Elevation slider bar. Either drag the Elevation slider bar or click the Elevation slider 
left or right arrows until you reach the desired angle. 

b. To set the skew angle for the 3D plot style, adjust the Skew slider bar. Either drag the 
Skew slider or click the Skew slider left or right arrow until you reach the desired 
angle (from 0 to 45 degrees).

c. To add a backdrop to 3D plots, select the Draw Backdrop check box.

4. Click Next to go to the next page of the wizard.

Select the Peak Labeling Page

Use the Select The Peak Labeling page to choose the type and style of peak labels. From this 
page, click Advanced to open a dialog box to set advanced labeling options.

• Basic Options

• Advanced Options (Quan)

• Advanced Options (Qual)
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Basic Options

 To select peak labeling options

1. To label peaks with the time in minutes in the chromatogram plot, select the Retention 
Time check box in the Label With area (see Figure 61). The data system displays RT 
before the label.

Figure 61. Select the Peak Labeling page

2. To label peaks with the number of mass scans at peak maximum, select the Scan Number 
check box. The data system displays S# before the label.

3. To label the base peak in the mass spectrum of the chromatogram peak, select the 
Base Peak check box. The data system displays BP before the label.

4. To label peaks with the signal-to-noise ratio at the peak maximum, select the 
Signal-to-Noise check box. The data system displays SN before the label.

5. To label peaks with flags providing supplemental information about the peak data, select 
the Flags check box. When a peak is saturated, the data system displays an S above the 
peak.

6. To label peaks with the integrated area of the peaks, select the Area check box. The data 
system displays AA before the label when detected automatically or MA when detected 
manually.

7. To label peaks with the apex height, select the Height check box. The data system 
displays AH before the label when detected automatically or MH when detected 
manually.

8. To offset a label from its normal position to avoid conflict with another label, select the 
Offset check box in the Label Styles area. Type the number for the offset (for the number 
of characters) in the Size box. 
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9. To use vertical, rather than horizontal, labels, select the Rotated check box. 

10. To place a rectangular outline around each peak label, select the Boxed check box.

11. To limit the labeling of peaks to those exceeding the specified percentage of the base peak, 
set the Label threshold box to a percent value between 100 and 0. 

12. Click Next to go to the next page of the wizard.

Advanced Options (Quan)

Click Advanced in the Select The Peak Labeling page. The Advanced Quan Peak Annotation 
Options dialog box opens. When you set Advanced Labeling options, the data system labels 
only the Quan peak.

 To set advanced Quan peak annotation options

1. To activate advanced Quan peak options, select the Use advanced Quan peak 
annotation check box (see Figure 62).

Figure 62. Advanced Quan Peak Annotation Options dialog box

2. To label the Quan peak with the component name, select the Component Name check 
box in the Custom Peak Labels area.

3. To label the Quan peak with the component key, select the Component Key check box.

4. To specify a custom label, select the Custom Text Label check box. Type a custom label 
for the Quan peak in the active box.

5. To label the Quan peak with the retention time, select the Retention Time check box. 
When you turn on this check box, the Labels page shows the change when you return 
to it.
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6. In the RT Labeling area, select the type of unit for the retention time from the Units list.

7. Select the number of decimal places to be displayed in the retention time label from the 
Decimals list.

8. Click OK to save the changes and close the dialog box.

Advanced Options (Qual)

Click Advanced in the Select the Peak Labeling page. The Advanced Qual Peak Annotation 
Options dialog box opens. When you set Advanced Labeling options, the Xcalibur data 
system labels only the Qual peak.

 To set advanced Qual peak annotation options 

1. To activate the advanced Qual peak options, select the Use advanced Qual peak 
annotation check box (see Figure 63).

Figure 63. Advanced Qual Peak Annotation Options dialog box

2. To specify a custom label, select the Custom Text Label check box in the active Custom 
Peak Labels area. Type a custom label for the Qual peak in the box.

3. To label the Qual peak with the retention time, select the Retention Time check box. 
When you turn on this check box, the Labels page shows the change when you return 
to it.

4. In the RT Labeling area, select the type of unit for the retention time from the Units list.

5. Select the number of decimal places to be displayed in the retention time label from the 
Decimals list.

6. Click OK to save the changes and close the Advanced Qual Peak Annotation Options 
dialog box.
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Select How the Chromatogram Axes Will Be Configured Page

Use the Axes page to set chromatogram axes label and display options. 

 To specify the appearance for chromatogram axes 

1. To set the name of the x axis in the X Axis area, type it in the Name box (see Figure 64).

Figure 64. Select How the Chromatogram Axes Will Be Configured page

2. To offset the axis label from the chromatogram, select the Offset check box.

3. To split the chromatograms into two or more separate graphs with equal time ranges, 
select the Split time range check box. 

4. Type the number of split time range graphs displayed for each chromatogram in the 
Divisions box. This box is active only when you select the Split Time Range check box.

5. In the Y Axis area, select either the From Detector option in the Label area to use the 
detector-specific label for the y axis (stored in the .raw file) or the Custom option to use 
your own label.

6. To specify the setting for the y-axis units, select either Absolute or Relative in the Units 
area.

7. If you have chosen to use a Custom label for the y axis, type a y-axis name in the 
Name box.

8. To offset the axis label from the chromatogram, select the Offset check box.

9. To go to the next page of the wizard, click Next.
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Configuring a Chromatogram
Configure Normalization for the Chromatogram Page

Use the Normalization page to select the normalization (y-axis scaling) method used for the 
chromatogram.

 To specify normalization options 

1. Define the normalizing method in the Normalize method area (see Figure 65) by 
selecting one of the following options:

• Auto zero: Optimize the y axis automatically for each chromatogram.

• Intensity range (%): Set the range manually. Type the minimum and maximum 
intensity required for the y axis. The valid range is –200.00 to +200.00%.

Figure 65. Configure Normalization for the Chromatogram page

2. Define a peak to use for normalization in the Normalize each plot area by selecting one of 
the following options:

• Largest peak in subsection: Normalize each split time range to the largest peak in 
the division.

• Largest peak in selected time range: Normalize the spectrum to the largest peak in 
the displayed time range.

• Largest peak in all times: Normalize the spectrum to the largest peak in the entire 
chromatogram.

The Normalize each plot area is active when you select a .raw-based chromatogram and you 
have selected the Fixed Scale check box on the Plot Type Page (see “Plot Type Page” on 
page 63).
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Finishing the Chromatogram Wizard

To change selections in the Chromatogram wizard, click Back to go back through the 
previous pages. When the page is done, click Finish.

Configuring a Component Calibration Curve
To configure a Component Calibration Curve object, right-click it and choose Properties 
from the shortcut menu. The Component Calibration Curve Properties dialog box opens (see 
Figure 66).

Figure 66. Component Calibration Curve Properties dialog box

If your report has a nonrepeating Component Cal Curve report object, use the Component 
Calibration Curve wizard to specify the name of the component.

 To specify the name of the component 

1. To search for the required processing method file (.pmd), click the browse button. A 
dialog box opens. By default, the wizard searches in the Xcalibur\methods folder.

2. To open a file, select it and click Open. The Select Component dialog box opens (see 
Figure 67).
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Configuring a Spectrum
Figure 67. Select Component dialog box

3. Select the required component from the list available for the chosen processing method 
and click OK. The Component Name page opens, displaying the specified name of the 
component in the box.

4. Click OK.

Configuring a Spectrum
To configure a Spectrum report object, right-click it and choose Properties from the shortcut 
menu. The Spectrum Properties Dialog Box opens to the Options page (see Figure 68).

Figure 68. Options page
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Configuring a Spectrum
Use the XReport Spectrum Control Properties pages to do the following:

• Configure Options

• Configure Plot Types

• Enhance Spectra

• Configure Spectrum Style

• Configure Peak Labels

• Configure Axes

• Select Normalization Options

• Specify a Peak

To configure the Spectrum report object, make selections on each page based on these 
corresponding procedures. 

Configure Options 

To configure Spectrum options, use the Options Page. 

 To configure Spectrum options

1. To use processing method properties for Plot type and Enhance information, select the 
Use processing method properties for plot type and enhance info check box (see 
Figure 68 on page 89).

When you select this check box, the options on the Plot type and Enhance pages are not 
available.

2. To use the Internal Standard peak when repeating on a component, select the Use ISTD 
peak when repeating on component check box. This option is only available when you 
select the Use processing method properties for plot type and enhance info check box. 

Configure Plot Types

When raw data is being displayed in a Spectrum report object, use the Plot Type Page to 
configure how the plot is drawn.

If you selected the Use processing method properties for plot type and enhance info check box 
on the Options page, this page is blank.
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Configuring a Spectrum
 To configure plot types

1. Specify the mass or mass range for MS detector types in the Mass Range box (see 
Figure 69). 

Figure 69. Plot type page

For PDA detector types, use this parameter to specify the wavelength or wavelength range 
(nm). Type the lower and upper limits for the plot. Separate entries by a dash (no spaces). 
To use the entire mass/wavelength range, type an asterisk:*.

2. Select the type of detector used to generate the raw file from the Detector list. Valid types 
are MS and PDA. The type of detector determines the available Plot types.

3. Select the time of the mass scan in the host chromatogram in the Time box. Type a new 
value or range as required.

4. From the Scan Filter list, select a filter or type a new one in the box using the scan filter 
format.

5. Click the browse button in the Demo File box and select the file. This box shows the path 
and filename of the demo file (.raw) used to generate the selected plot. 

Enhance Spectra

Use the Enhance Page to apply smoothing (the refine algorithm) to the spectrum and set 
background subtraction time ranges.

If you selected the Use processing method properties for plot type and enhance info check box 
on the Options page, this page is blank.
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Configuring a Spectrum
 To define spectrum enhancement options

1. To turn on spectrum smoothing, select the Enable check box in the Smoothing area (see 
Figure 70).

Figure 70. Enhance page

2. To select a type of smoothing, select Boxcar or Gaussian from the Type list.

3. Type the number of points for spectrum smoothing in the Points list. Type an odd 
number from 3 (minimum smoothing) to 15 (maximum smoothing).

4. To turn Refine spectrum enhancement on or off, select the Enable check box in the 
Refine area.

5. To apply the refining algorithm and specify a length of time for mass chromatograms, 
type a value in the Window box indicating the number of seconds on either side of the 
specified point. A reasonable initial value is the peak width in seconds.

6. To eliminate peaks generated from baseline noise, type 0 (this shows all peaks in the 
spectrum) in the Noise threshold box. After you close this box to display the results, you 
can open the box again to increase the value until noise peaks are eliminated. 

7. To specify a first baseline region used for assessing the background, select the 
Time Range 1 check box in the Background Subtraction area. Type the time range in 
the box.

The Background Subtraction area shows details of background subtraction when this 
value has been applied to the spectrum. The background contribution is determined by 
averaging the scans from one or two baseline regions.

8. To specify a second baseline region used for assessing the background, select the 
Time Range 2 check box. Type the time range in the box.
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Configuring a Spectrum
Configure Spectrum Style 

To set parameters that determine the appearance of the spectrum, use the Style Page (see 
Figure 71).

Figure 71. Style page

 To set plotting options

To define the plotting style, select one of the following options in the Plotting area:

• Automatic: Choose the graphic style based on the data acquisition method used for 
the active spectrum.

• Point to Point: Display a point-to-point peak profile. 

• Stick: Display spectral mass peaks as vertical lines.

• Shade: Display the spectrum as a shaded representation of intensity in each amu 
band for the active spectrum.
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Configuring a Spectrum
Configure Peak Labels 

To choose the type and style of peak labels, use the Labels Page.

 To configure peak labels

1. To label spectrum peaks with m/z value, select the Mass check box (see Figure 72) in the 
Label With area. 

Figure 72. Labels page

2. To label spectrum peaks with flags, select the Flags check box. Flags provide supplemental 
information about the peak data. For example, when a peak is saturated, the Xcalibur 
data system displays an S above the peak.

3. To specify that other spectrum peaks are labeled relative to that value, type a value in the 
Relative to box.

4. Type the number of decimal places to be used in the labels in the Decimals box. 

5. To move a label from its normal position to avoid conflict with another label, select the 
Offset check box in the Label Styles area. Choose the number for the offset (for the 
number of characters) in the Size box. 

6. To use vertical, rather than horizontal, labels, select the Rotated check box. 

7. To place a rectangular outline around each peak label, select the Boxed check box. This 
option does not apply to flags. 

8. To limit the labeling of peaks to those exceeding the specified percentage of the base peak, 
type a percent in the Label Threshold% box.
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Configuring a Spectrum
Configure Axes 

To set spectrum axis labels and display options, use the Axis Page.

 To configure axis options

1. Type the x-axis name in the Name box in the X Axis area (see Figure 73). 

Figure 73. Axis page in the Spectrum Properties dialog box

2. To offset the axis label from the spectrum, select the Offset check box.

3. To split the spectra into two or more separate graphs with equal ranges, select the 
Split mass range check box. Type the number of split range graphs displayed for each 
spectrum in the Divisions box.

4. Select one of the following options in the Y Axis area under Label:

• From detector: Use the detector-specific label for the y axis (stored in the .raw file).

• Custom: Use your own label.

5. To specify the setting for the y-axis units, select the Absolute or the Relative option.

6. Type a y-axis name in the Name box.

7. To move the axis label away from the spectrum, select the Offset check box.
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Select Normalization Options

Use the Normalization Page to select normalization options for spectrum plots.

 To select normalization options

1. To define the normalization method, select one of the following options in the Normalize 
method area (see Figure 74).

• Auto zero: Automatically optimize the y axis.

• Intensity Range (%): Set the y-axis range. Use the box to type the minimum and 
maximum intensity. The valid range is –200.00 to +200.00%.

Figure 74. Normalization page

2. To define the peak that the spectrum is normalized to, select one of the following options 
in the Normalize To area:

• Largest peak in subsection: Normalize each split mass range to the largest peak in 
the division.

• Largest peak in mass range: Normalize the spectrum to the largest peak in the 
displayed mass range.

• Largest peak in scan: Normalize the spectrum to the largest peak in the entire 
spectrum.

3. To define how multiple scans are normalized, select one of the following options in the 
Normalize multiple scans area:

• Individually: Normalize each mass plot individually.

• All the same: Normalize all mass plots equally.
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Configuring a Spectrum
Specify a Peak 

To explicitly specify the peak to display in the Spectrum report object, use the Peak Page.

 To specify a peak

1. To specify a specific type of peak to appear in the spectrum, select the Enable explicit 
peak type check box (see Figure 75).

Figure 75. Peak page

2. To specify the peak type to appear in the Spectrum, select the Quan Peak option to 
specify a Quan peak or select the Qual Peak option to specify a Qual peak. 

3. For a Quan peak, type a name for the component in the Peak Identification area. For a 
Qual peak, type the retention time (any time between the start time and end time of the 
peak) or click the browse button. The Select a Peak dialog box opens. Select a peak and 
click OK to close the dialog box.
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Configuring Columns
To configure a column object, right-click it and choose Properties from the shortcut menu. 
The Column Properties Dialog Box opens.

After you have configured a column object, drag objects to the columns.

 To configure a column object

1. Select the number of columns to use in the Number of columns area (see Figure 76).

Figure 76. Column Properties dialog box

2. If the column object is in a nonrepeating section, configure the Repeat type. The Repeat 
type options are not available in Quan repeating or Qual repeating sections. In the Repeat 
type area, select Sample repeat or Summary repeat by clicking the appropriate option. 
For an example of using the two repeats, see Set Sample Repeat Options and Set 
Summary Repeat Options.

3. If you selected Summary repeat, select whether you would like to repeat from Left to 
right or from Top to bottom by clicking the appropriate option.

4. To start each sample on a new row, select the New sample new row check box. 

Set Sample Repeat Options

Use the Sample repeat option to present information relating to a raw file of a single sample 
and the results created when processing it. Use this repeat type as a layout tool to indicate 
where objects are placed on the page of the resolved report.

Note   The Sample repeat and Summary repeat options are applicable only in 
nonrepeating report sections. These options are not available in other types of report 
sections.
98 XReport User Guide Thermo Scientific



 4 Configuring Objects and Sections
Configuring Columns
For example, when you place a 2-column object in a nonrepeating section, add a Quan-based 
chromatogram to the left column and combine or resolve the template using data of 1 sample 
with 4 components, the report appears as in Figure 77.

Figure 77. 2-column object behavior in a nonrepeating section, with a chromatogram object

In another example, place a 2-column object in a nonrepeating section and add a 
chromatogram and a text object to the left column and a spectrum to the right column. 
Combine (resolve) the template using data of 1 sample with 4 components. All objects in the 
column are repeated for a single sample, and the report appears as in Figure 78. 

Figure 78. 2-column object behavior in a nonrepeating section, with chromatogram and spectrum 
objects

Set Summary Repeat Options

Use the Summary repeat option to present information relating to all of the samples in an 
Xcalibur sequence and the results created when processing them. 

For example, when you place a 2-column object in a nonrepeating section, add a 
chromatogram (in either column), and combine (resolve) the template using data of 2 samples 
with 4 components each, the report appears as in Figure 79.
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Note   The Sample repeat and Summary repeat options are applicable only in 
nonrepeating report sections. These options are not available in other types of report 
sections.
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Figure 79. 2-column object behavior in a nonrepeating section, with a chromatogram, Left to right 
option

If you choose instead the Top To Bottom option, the report appears as in Figure 80.

Figure 80. 2-column object behavior in a nonrepeating section, with a chromatogram, Top to 
bottom option

If you place an object in the right column and leave the left column empty, XReport combines 
the data as if the object is placed in the left column, as illustrated above.

If you place an object in each column, the Xcalibur data system ignores the Top to bottom 
and Left to right options. The report appears as in Figure 81.

Figure 81. 2-column object behavior in a nonrepeating section, with chromatogram and spectrum 
objects
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Sample XReport Template Files

The Xcalibur data system provides several sample XReport templates for you to use when 
creating your own reports. This appendix provides details of these report templates stored at 
the following location:

Xcalibur\templates 

Table 2. Sample XReport template files

Report template file name Data source files Description/Use

CalibrationFile.xrt .raw, .xcal Generates sample reports with 
calibration data.

CompCalReport.xrt

CompCalReport_Avalon.xrt

CompCalReport_Genesis.xrt

CompCalReport_ICIS.xrt

.rst, .raw, .pmd, .sld Generates summary reports showing 
processing method details, calibration 
curve, and sample table (Quan 
results). Can be used from Batch 
Processing and Quan Browser in the 
Xcalibur data system.

CustLibrSearRept.xrt

LibrarySearchReport.xrt

.rst, .raw Generates Qual sample reports that 
display Qual peaks and library search 
details. Use from Batch Processing in 
the Xcalibur data system.

IonRatioConfirmation.xrt .rst, .raw, .pmd Generates a Quan sample report 
containing non-graphical ion ratio 
confirmation results.

IonRatioConfirmationGraphical.xrt

IonRatioConfirmationGraphical 
Simple.xrt

IonRatioConfirmationGraphical 
Stacked.xrt

.rst, .raw, .pmd Generates Quan sample reports 
containing graphical ion ratio 
confirmation results. These report 
templates take advantage of the 
explicit confirmation ion settings 
available when using the XReport 
Chromatogram wizard. 

PeakIntegration.xrt .rst, .raw, .pmd Generates a Quan sample report 
containing peak integration data 
generated using Genesis.
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ProcessingMethod.xrt

ProcessingMethod_Avalon.xrt

ProcessingMethod_Genesis.xrt

ProcessingMethod_ICIS.xrt

.pmd Generates processing method sample 
reports. Use from Processing Method 
Setup in the Xcalibur data system.

QualPeakReport.xrt .rst, .raw Generates a simple Qual sample 
report.
Use for data from Batch Processing in 
the Xcalibur data system.

QuanPeakResults_ESTD.xrt

QuanPeakResults_ISTD.xrt

QuanResults.xrt

QuanSimple.xrt

.rst, .raw, .pmd Generates Quan sample reports. Can 
be used from Batch Processing or 
Quan Browser in the Xcalibur data 
system.

QuantifySampleReport.xrt .sld, .pmd, .rst, .raw Generates a Quan summary report 
containing chromatograms and a 
Quan summary table. 

SequenceReport.xrt .sld Generates a summary report showing 
the sequence being processed. Use 
from batch processing in the Xcalibur 
data system. Refer to the section 
“Processing a Batch of Samples” in 
Chapter 5 of the Acquisition and 
Processing User Guide.

SpectrumCandidates.xrt .rst, .raw Generates a Quan summary report 
(only applicable to GC/MS). Use 
from batch processing or Quan 
Browser in the Xcalibur data system.

Table 2. Sample XReport template files

Report template file name Data source files Description/Use
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B

Types of Report Objects

The following tables list the report objects you can place onto a report template: text objects, 
table objects, graphic objects, and formatting objects. The tables briefly describe an object and 
indicate in which sections the object is available.

Text Objects
The table below lists the text objects.

Contents

• Text Objects

• Table Objects 

• Graphic Objects

• Formatting Objects 

Table 3. Text objects  (Sheet 1 of 3)

Text object Data source file Description Section placement

Annotation none Displays static text. Use this object for 
adding headings or comments.

Any

Component Ident/Detect/Cal 
Settings

.pmd Displays the peak detection, calibration, 
and integration parameters for a single 
component.

Quan repeating

Component ISTD Settings 
Summary

.pmd Displays a summary of the configuration 
details for each component’s ISTD 
configuration in the Quantitation 
section of a processing method.

Quan repeating

Component Settings Summary .pmd Displays a short list of peak detection 
and integration parameters for a 
specified component.

Quan repeating
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Component Sys Suit/Flags 
Settings

.pmd Displays Calibration, Quantitation, and 
Detection flags and system suitability 
parameters to specify automatic 
chromatographic checks that assign a 
pass/fail qualification to a target peak. 

Quan repeating

Instrument Method .raw Displays general instrument method 
parameters. This text object does not 
have any editable properties. 

Nonrepeating

Processing Method - General .pmd Displays general processing method 
parameters, including date created, 
date modified, baseline definition, 
chromatography type (LC/GC).

Nonrepeating

Processing Method - Qual .pmd Displays Qual processing method 
parameters, including the following:

• Identification
• Spectrum Enhancement
• Detection Options
• Advanced Detection Options
• Library Search Constraints
• Library Search Options

Nonrepeating

Quan ISTD Peak Summary .rst, .pmd Displays summary parameters for a 
Quan component’s associated ISTD 
peak. For example: 

• ISTD NameBase Line
• Actual RTSignal To Noise
• Response Expected RT

Quan repeating

Quan Peak Summary .rst, .pmd Displays Component Peak summary 
parameters, for example: 

• Actual RT% Diff
• Calculated AmountArea Ratio
• Response Area ISTD
• Base Line Specified Amount
• Signal To Noise 

Quan repeating, 
header or footer

Table 3. Text objects  (Sheet 2 of 3)

Text object Data source file Description Section placement
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Table Objects
Table Objects
The table below lists the table objects.

Report Info none Displays general information about the 
report itself.

Header or footer

Sample Header .raw, .sld Displays general information about a 
sample, for example:

• Sample Name
• Operator
• Sample Type
• Run Time
• Acquisition Date

Nonrepeating, 
header or footer

Table 3. Text objects  (Sheet 3 of 3)

Text object Data source file Description Section placement

Table 4. Table objects  (Sheet 1 of 3)

Table object Data source file Description Section placement

Avalon Qual Events Table .pmd Displays details of the Avalon peak 
detection algorithm events configured in 
the Qual section of a processing method.

Nonrepeating

Avalon Quan Events Table .pmd Displays details of the Avalon peak 
detection algorithm events configured 
for a component in the Quan section of 
a processing method. 

Quan repeating

Calibration File Table .xcal, .sld, .raw Displays component names, response 
factors, and %RSD of standards. 

Nonrepeating

Component Cal Level Table .pmd Shows the calibration levels, amounts, 
and acceptance test values defined for a 
specific component. 

Quan repeating, or 
Nonrepeating

Component QC Level Table .pmd Shows the QC levels, amounts, and 
percent test values defined for a specific 
component. 

Quan repeating

Component Spectrum Table .pmd Displays m/z and intensity data for up to 
fifty spectrum peaks. The Xcalibur 
application uses this data to identify 
components when the Spectrum Peak 
Identification Method is specified in the 
processing method. This object is used 
only for GC chromatography. 

Quan repeating
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Dilution Factor Table .rst Displays the names of calibration levels 
and dilution factors for components that 
are not internal standards.

Nonrepeating

Electronic Signature none Displays up to five electronic signatures 
in table format. This object is not 
editable in XReport.

Any

Ion Ratio Confirmation Results 
Table

.rst Displays the following data about each 
qualifier ion, based on search criteria 
specified in the processing method:

• Mass
• Coelution test pass/fail
• Ion Ratio Test Target %
• Ion Ratio Test Window % 

Quan repeating

IRC Settings Table .pmd Displays up to five qualifier ions within 
tolerance limits to confirm the detection 
of a target analyte. The ions are specified 
in the processing method. 

Quan repeating

IRC Summary Table .rst Displays all of the information for the 
confirmation ion for each component. 
Most useful when the Name column is 
the first column.

Nonrepeating

Lib. Search Graph Table .rst, .raw Displays the graphical results from a 
library search on a Qual peak (for 
example, Hit Spectrum, Delta, and 
Compound Structure).

Qual repeating

Lib. Search Results Table .rst, .raw Displays the results of a Library Search 
on a Qual peak (for example, Name, 
Probability, RSI, SI, CAS#, Area).

Qual repeating

Proc. Method Programs Table .pmd Displays a list of programs to be run by 
the Xcalibur data system after the 
sample has been analyzed and the data 
has been processed. The data system 
runs the programs in the order listed.

Nonrepeating

Proc. Method Sample Reports 
Table

.pmd Displays Sample Report information for 
each sample in a sequence, including 
Template name and the Report file 
name. Specify Sample Type in the 
processing method.

Nonrepeating

Table 4. Table objects  (Sheet 2 of 3)

Table object Data source file Description Section placement
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Proc. Method Summary Reports 
Table

.pmd Displays Summary Reports to be issued 
after processing the samples in a 
bracketed or non-bracketed sequence.

Nonrepeating

Qual Peak Table .rst Displays information specific to 
chromatogram peaks detected by 
qualitative analysis for a single sample.

Nonrepeating

Qual Summary Table .sld, .rst Displays information specific to 
chromatogram peaks detected by 
qualitative analysis for all samples in a 
sequence.

Nonrepeating

Quan Peak Table .rst, .pmd Displays information specific to 
component peaks detected by 
quantitative analysis for a single sample.

Nonrepeating

Quan Summary Table .sld, .rst, .pmd Displays information specific to 
component peaks detected by 
quantitative analysis for all samples in a 
sequence.

Nonrepeating

Sample Table (Quan Results) .sld Displays system suitability and flag 
processing results for each component in 
a sample, and repeats this information 
for every sample in a sequence.

Quan repeating

Sequence Table .sld Displays the contents of the sequence 
file.

Nonrepeating

Spectrum Candidate Results 
Table

.rst Displays the results of spectrum 
candidate processing for GC/MS data 
on a per component basis. Parameters 
include the following:

• Forward fitStart RT
• Reverse fitEnd RT
• MatchArea
• Found RTHeight

Nonrepeating

Spectrum List Table .rst, .raw Displays the text equivalent of the 
Spectrum graphic object. The 
Spectrum List Table contains a header 
and lists values for the m/z, intensity, 
and relative intensity. 

Qual or Quan 
repeating

Table 4. Table objects  (Sheet 3 of 3)

Table object Data source file Description Section placement
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Graphic Objects
The table below lists the graphic objects.

Formatting Objects
The table below lists the formatting objects.

Table 5. Graphic objects 

Graphic object Data source file Description Section placement

Bitmap .bmp, .dib, .gif,
.jpg, or .ico

Displays a graphical image, for example, 
a company logo.

Any

Chromatogram .raw, .rst Displays a graphical trace that can show 
either raw data or processed data for any 
acquisition device supported by the 
Xcalibur application (MS, Analog, 
A/D Card, PDA, UV).

Qual or Quan repeating 
and nonrepeating 
sections

Component Cal Curve .rst, .pmd Shows the calibration curve used to 
quantify a specified component. The 
curve is specified in the processing 
method as response versus amount of 
standard.

Quan repeating - repeats 
on component peak

Nonrepeating - uses the 
specified component.

Spectrum .raw, .rst Displays a graphical spectrum that can 
show either raw data or processed data 
for any acquisition device supported by 
the Xcalibur application (MS, PDA).

Qual or Quan repeating 
and nonrepeating 
sections

Table 6. Formatting objects 

Graphic object Data source file Description Section placement

Columns none Specify the layout and repeating 
properties of graphic and text objects.

Any

Page Break none Insert a manual page break in the report. Qual or Quan repeating 
and nonrepeating 
sections
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C

Sample Report

This appendix contains a sample Xcalibur report that is generated when you use 
PeakIntegration.xrt (located in the Xcalibur\templates folder) to generate a Quan sample 
report that contains certain peak integration data. The sample report uses the steroids02.rst 
data file from the Xcalibur\examples\data folder.

Contents

• Peak Integration Report, Page 1

• Peak Integration Report, Page 2

• Peak Integration Report, Page 3

• Peak Integration Report, Page 4
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Peak Integration Report, Page 1
Peak Integration Report, Page 1
Peak Integration Report

Data File: steroids02 Original Data Path: C:\pitcon\trial2 Current Data Path: C:\Xcalibur\example

s\data

Sample Type: Std Bracket Start Sample ID: Sample02 Sample Name:

Operator: jackc Acquisition Date: 02/28/96 11:20:31 AMRun Time(min): 3.79

Comments: Vial: 1 Scans: 336

Low Mass(m/z): 100.00 High Mass(m/z): 375.00 Sample Weight: 0.00

ISTD Amount: 0.000 Calibration Level: 3 Dilution Factor: 1.00

Instrument Method: C:\pitcon\trial2\steroidMSMSis

Original Processing Method: C:\pitcon\trial2\steroidmsmsIS

Current Processing Method: C:\Xcalibur\examples\methods\steroid
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Peak Integration Report, Page 2
Peak Integration Report

methyltestosteronehydrocortisone

Expected

Retention

Time (min): 0.6

Retention

Time Window

(sec): 30.00000

View Width

(min): 1.00000

Retention

Time

Reference: No

Genesis

Minimum Peak

Height (S/N): 3.00

Genesis

Smoothing

Points: 7

Detector Type: MS

Valley

Detection

Enabled: No

Genesis

Constrain Peak

Width Enabled: No

RT: 1.49 - 2.49 SM: 7G
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1.99 NL: 9.60E4

m/z= 
266.6-267.6+
284.7-285.7 F: + c Full 
ms2 303.30 [ 
100.00-310.00]  MS  
Genesis steroids02

RT: 0.18 - 1.18 SM: 7G

0.5 1.0

Time (min)

0

10

20

30

40

50

60

70

80

90

100

e
c

n
a

d
n

u
b

A 
e

vit
al

e
R

RT: 0.68 NL: 5.01E5

m/z= 
266.6-267.6+
308.6-309.6 F: + c Full 
ms2 363.30 [ 
150.00-375.00]  MS  
Genesis steroids02

Expected

Retention

Time (min): 2.0

Retention

Time Window

(sec): 30.00000

View Width

(min): 1.00000

Retention

Time

Reference: Yes

Genesis

Minimum Peak

Height (S/N): 3.00

Genesis

Smoothing

Points: 7

Detector Type: MS

Valley

Detection

Enabled: No

Genesis

Constrain Peak

Width Enabled: No

Component Name: hydrocortisone Actual RT(min): 0.67783 Calculated Amount: 4.95592

Response: 1892942.72621 Base Line: BB Signal To Noise: 707.56

%Diff: -0.88 Area Ratio: 2.763 Area(cts-sec): 1892942.72621

Specified Amount: 5.00000
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Peak Integration Report

methyltestosteronedeoxycorticosterone

Expected

Retention

Time (min): 1.4

Retention

Time Window

(sec): 30.00000

View Width

(min): 1.00000

Retention

Time

Reference: No

Genesis

Minimum Peak

Height (S/N): 3.00

Genesis

Smoothing

Points: 7

Detector Type: MS

Valley

Detection

Enabled: No

Genesis

Constrain Peak

Width Enabled: No

RT: 1.49 - 2.49 SM: 7G
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m/z= 
266.6-267.6+
284.7-285.7 F: + c Full 
ms2 303.30 [ 
100.00-310.00]  MS  
Genesis steroids02

RT: 0.90 - 1.90 SM: 7G
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RT: 1.40

1.70
1.21

Expected

Retention

Time (min): 2.0

Retention

Time Window

(sec): 30.00000

View Width

(min): 1.00000

Retention

Time

Reference: Yes

Genesis

Minimum Peak

Height (S/N): 3.00

Genesis

Smoothing

Points: 7

Detector Type: MS

Valley

Detection

Enabled: No

Genesis

Constrain Peak

Width Enabled: No

Component Name: deoxycorticosterone Actual RT(min): 1.39533 Calculated Amount: 5.10841

Response: 1040530.60245 Base Line: BB Signal To Noise: 148.23

%Diff: 2.17 Area Ratio: 1.519 Area(cts-sec): 1040530.60245

Specified Amount: 5.00000
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Peak Integration Report

methyltestosteroneprogesterone

Expected

Retention

Time (min): 3.2

Retention

Time Window

(sec): 30.00000

View Width

(min): 1.00000

Retention

Time

Reference: No

Genesis

Minimum Peak

Height (S/N): 3.00

Genesis

Smoothing

Points: 7

Detector Type: MS

Valley

Detection

Enabled: No

Genesis

Constrain Peak

Width Enabled: No

RT: 1.49 - 2.49 SM: 7G
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1.99 NL: 9.60E4

m/z= 
266.6-267.6+
284.7-285.7 F: + c Full 
ms2 303.30 [ 
100.00-310.00]  MS  
Genesis steroids02

RT: 2.67 - 3.67 SM: 7G
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RT: 3.17

2.89

Expected

Retention

Time (min): 2.0

Retention

Time Window

(sec): 30.00000

View Width

(min): 1.00000

Retention

Time

Reference: Yes

Genesis

Minimum Peak

Height (S/N): 3.00

Genesis

Smoothing

Points: 7

Detector Type: MS

Valley

Detection

Enabled: No

Genesis

Constrain Peak

Width Enabled: No

Component Name: progesterone Actual RT(min): 3.16867 Calculated Amount: 4.94898

Response: 2995893.97127 Base Line: BB Signal To Noise: 344.16

%Diff: -1.02 Area Ratio: 4.373 Area(cts-sec): 2995893.97127

Specified Amount: 5.00000
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XReport Reference

This appendix provides reference material about XReport, including the Xreport window and 
dialog boxes. 

Reports View 

Use XReport or the Reports view of the Processing Setup window to specify how the Xcalibur 
data system produces reports for samples and sequences. The data system provides several 
standard report formats. You can export results in a number of file formats including .xls 
and .html.

For more information about the Reports view of the Processing Setup window, go to the 
Acquisition and Processing User Guide.

XReport Toolbar Buttons

Contents

• Reports View

• XReport Dialog Boxes

• Report Sections

• Report Objects

• Report Templates

Table 7. Toolbar buttons  (Sheet 1 of 3)

Button Description

New Create a new report template for the program you select. 

Open Find and open .xrt files.

Save Save the current template as an .xrt file. This option is not available if you are 
using a locked template. In this case, choose File > Save As and save the 
template with a different name. 
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Reports View
Cut Remove the currently selected objects and place them on the clipboard.

Copy Copy the currently selected objects to the clipboard.

Paste Insert the contents of the clipboard in the currently selected section. 

Align Left Align the left edges of the currently selected objects to the left edge of the first 
selected object. 

To select more than one object, click and drag a selection box around the 
objects or hold down the SHIFT key and click each object.

Align Right Align the right edges of the currently selected objects to the right edge of the 
first selected object.

To select more than one object, click and drag a selection box around the 
objects or hold down the SHIFT key and click each object.

Align Top Align the top edges of the currently selected objects to the top edge of the first 
selected object.

To select more than one object, click and drag a selection box around the 
objects or hold down the SHIFT key and click each object.

Align Bottom Align the bottom edges of the currently selected objects to the bottom edge of 
the first selected object.

To select more than one object, click and drag a selection box around the 
objects or hold down the SHIFT key and click each object.

Auto Align Snap all objects (selected or not) in the current section to the nearest upper and 
right gridlines. 

Center Horizontally Center the current object on the page so that it is an equal distance from the 
left and right sides of the page. 

Center Vertically Center the current object on the page so that it is an equal distance from the 
top and bottom sides of the page. 

Make Same Height Enlarge all selected objects (except for the first selected) to match the height of 
the first selected object. 

Make Same Width Enlarge all selected objects (except for the first selected) to match the width of 
the first selected object. 

Table 7. Toolbar buttons  (Sheet 2 of 3)

Button Description
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Reports View
XReport Menus

The XReport window has the following menus:

• File Menu

• Edit Menu

• View Menu

• Layout Menu

• Report Menu

• Help Menu

File Menu

Make Same Height and 
Width

Enlarge all selected objects (except for the first selected) to match the height 
and the width of the first selected object. 

Shrink Wrap Shrink the template workspace to remove all unused workspace at the bottom 
of the section. 

Expand Enlarge the template workspace to the full height of the section size. 

Zoom

Increase or decrease the magnification of the template display. 

Font Change the font that is used in the currently selected object or change the 
global font settings if no object is selected. 

Resolve Report Combine your report template with your data and view, save, and print your 
report. 

Help Open Xcalibur Help. 

Table 7. Toolbar buttons  (Sheet 3 of 3)

Button Description

Table 8. File menu commands  (Sheet 1 of 2)

Command Description

New Create a new template. 

Open Open a previously saved template. 
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Reports View
Edit Menu

View Menu

Save Save the current template.
Note  This option is not available if you are using a locked template. In this case, choose 
File > Save As and give the template a different name. 

Save As Save the current template with a different file name. 

Page Setup Define page layout and margin settings. 

Recently Used Files View the most recently opened template files. To open the template, select a filename in 
the list. 

Close Close the current template. 

Exit Close XReport. 

Table 9. Edit menu commands 

Command Description

Cut Remove the currently selected objects and place them on the clipboard.

Copy Copy the currently selected objects to the clipboard.

Paste Insert the contents of the clipboard in the currently selected section. 

Clear Delete the currently selected objects. 

Select All Select all of the objects in the currently selected section. 

Edit Object Change the current object. For example, to enable resizing of columns in the table object.

Properties Configure the current object. For example, for a bitmap object, you can select the source 
file. 

Delete Section Delete the currently selected section. This option is not available when objects are selected.

Table 10. View menu commands

Command Description

Report Template Grid View or hide the grid in the current section. To change your grid settings, choose 
Layout > Preferences. 

Report Template 
Outline

View or hide the Report Template Outline pane. This pane displays an overview of all 
sections and objects in your report template and opens at the right side of the XReport 
window.

Toolbars View or hide the toolbars. 

Status Bar View or hide the status bar at the bottom of the XReport window.

Table 8. File menu commands  (Sheet 2 of 2)

Command Description
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Reports View
Layout Menu

Table 11. Layout menu commands 

Command Description

Align >
Left

Align the left edges of the currently selected objects to the left edge of the first selected 
object. 

To select more than one object, click and drag a selection box around the objects or hold 
down the SHIFT key and click each object.

Align >
Right

Align the right edges of the currently selected objects to the right edge of the first selected 
object.

To select more than one object, click and drag a selection box around the objects or hold 
down the SHIFT key and click each object.

Align >
Top

Align the top edges of the currently selected objects to the top edge of the first selected 
object.

To select more than one object, click and drag a selection box around the objects or hold 
down the SHIFT key and click each object.

Align >
Bottom

Align the bottom edges of the currently selected objects to the bottom edge of the first 
selected object.

To select more than one object, click and drag a selection box around the objects or hold 
down the SHIFT key and click each object.

Align >
Auto 

Snap all objects (selected or not) in the current section to the nearest upper and right 
gridlines. 

Make Same Size >
Width

Enlarge all selected objects (except for the first selected) to match the width of the first 
selected object. 

Make Same Size >
Height

Enlarge all selected objects (except for the first selected) to match the height of the first 
selected object. 

Make Same Size >
Both

Enlarge all selected objects (except for the first selected) to match the height and the width 
of the first selected object. 

Center In Page >
Vertical

Center the current object on the page so that it is an equal distance from the left and right 
sides of the page. 

Center In Page >
Horizontal

Center the current object on the page so that it is an equal distance from the top and 
bottom sides of the page. 

Shrink Wrap Shrink the current section to fit all of the objects that it contains. 

Expand Enlarges the current section so you can add additional objects. 

Preferences Change grid settings, enable actions, and view or hide template configuration dialog box. 
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Reports View
Report Menu

Help Menu

Table 12. Report menu commands

Command Description

Data Sources Specify the data files for the report. 

Simulate Report View your template before adding real data. 

Resolve Report Display the report with data filled in. Select data in the Data Sources dialog box.

Print Report Print the current report. 

Table 13. Help menu commands

Command Description

Xcalibur Help View Xcalibur Help.

Glossary View the glossary. 

How to Use Help View How to Use Help.

About XReport Open the About XReport dialog box. 

The About XReport dialog box displays the version number of XReport, along with 
copyright information.
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XReport Dialog Boxes
XReport Dialog Boxes
• Configure Repeating Section Dialog Box

• Chromatogram Properties Dialog Box and Wizard

• Spectrum Properties Dialog Box

• Table Properties Wizard

• Edit Formula For Dialog Box

• Configure Function Dialog Box

• Spectrum List Table Properties Dialog Box

• Average Scan Filter Selection Dialog Box

• Library Search Graphics Table Properties Dialog Box

• Library Search Results Table Properties Dialog Box

• Sample Table Properties Dialog Box

• Text Object Properties Dialog Box

• Bitmap Properties Dialog Box

• Column Properties Dialog Box

• Configure Component Calibration Curve Dialog Box

• Data Sources Dialog Box

• Electronic Signature Properties Dialog Box

• Font Dialog Box

• Preferences Dialog Box

• Preview Window

• Save As Dialog Box

• Template Configuration Dialog Box

Configure Repeating Section Dialog Box 

Use the Configure Repeating Section dialog box to customize the following settings for your 
repeating section:

• Including or exclude internal standards or target compounds from a Quan repeating 
section 

• Specifying the order in which peaks and components are repeated 
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• Defining any limit on the number of peaks reported 

• Specifying page breaks in the final report 

The Configure Repeating Section dialog box has these pages:

• Exclude Page

• Ordering Page

• Page Breaks Page 

Exclude Page

Use the Exclude page to indicate components to exclude from a Quan repeating section, and 
whether or not to discard any components that have not been found.

Ordering Page

Set parameters on the Ordering page to indicate the order for peaks or components in the 
repeating section.

Table 14. Exclude page parameters 

Parameter Description

Repeating Section Excludes 

Exclude Component Type Exclude specific compounds from the Quan configurations: 

• None

• Internal Standards

• Target Compounds 

Show Only Found 
Components

Discard any components that have not been found.
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Page Breaks Page

Set parameters on the Page Breaks page to indicate where to apply page breaks in your report. 

Chromatogram Properties Dialog Box and Wizard

The Chromatogram Properties dialog box displays a preview of the current chromatogram 
settings. To change these settings, click Configure. The Chromatogram Properties wizard 
opens. Use this wizard to configure any of these settings for the Chromatogram report object 
that is contained in your report template:

• Chromatogram and peak type 

Table 15. Ordering page parameters 

Parameter Description

Repeating Section Ordering 

Order By Choose a value that determines the order for the peaks or components in the section:

• RT 

• Component Name 

• Peak Height Intensity 

• Peak Area Intensity 

• Peak Response Intensity 

• Component Concentration 

Ordering Direction 

Ascending or Descending Choose an order for the peaks or components in the section by the property in the 
Order By list from lowest to highest (ascending) or hightest to lowest (descending).

Repeating Records Maximum

Limit number of reported 
peaks or components to 

Limit the total number of peaks or components that are included in the repeating 
section. 

Table 16. Page Breaks page parameters 

Parameter Description

Each peak contained on its own page(s) Insert a page break before and after each peak in the repeating 
section. 

No page breaks between the individual peaks Remove page breaks between each peak in the repeating section.

Page break before the repeating section Insert a page break before the repeating section. 

Page break after the repeating section Insert a page break after the repeating section. 
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• Use of a demo file 

• Plot details 

• Smoothing parameters 

• Use of MS Quan traces 

• Chromatogram display, style, labeling, axes, and normalization methods 

This wizard displays different pages and contains different options, depending on the type of 
section containing the chromatogram report object and the selections for the chromatogram 
type and peak type properties. This wizard can contain the following pages:

• Advanced Qual Peak Annotation Options

• Advanced Quan Peak Annotation Options

• Configure the Look of the Peak Window

• Configure Normalization For The Chromatogram 

• Select A Peak Dialog Box

• Select Chromatogram Style

• Select Chromatogram Type

• Select Component

• Select Demo File

• Select Enhance Details

• Select How the Chromatogram Axes Will Be Configured

• Select Mass Spectrum Quan Traces to Display

• Select Plot Details

• Select the Peak Labeling

• Select the Qual Peak

• Select the Quan Peak

• Use Container Supplied Qual Peak

• Use Container Supplied Quan Peak

Advanced Qual Peak Annotation Options 

Set advanced Qual peak annotation parameter on the Advanced Qual Peak Annotation 
Options page. When you set advanced labeling options, only the Qual peak is labeled. 
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XReport Dialog Boxes
Note  If you are in a Quan or nonrepeating section, choose a Qual results-based 
chromatogram.

Table 17. Advanced Qual Peak Annotation Options page parameters 

Parameter Description

Use Advanced Qual Peak Annotation Turn on the advanced Qual peak options. 

Custom Peak Labels 

Custom Text Label Label the Qual peak with a custom label. 

Retention Time Label the Qual peak with the retention time. 

RT Labeling 

Units Define the units for the retention time. 

Decimals Specify the number of decimal places to be displayed in the retention time 
label. 
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Advanced Quan Peak Annotation Options 

Set advanced Quan peak annotation parameters on the Advanced Quan Peak Annotation 
Options page. When you set advanced labeling options, only the Quan peak is labeled.

Configure the Look of the Peak Window 

Set parameters on the Configure How The Peak Window Will Look page to control the 
display of baselines (Quan and Qual peaks) and the peak window width (Qual peak and in 
some cases Quan peaks) when a peak from a result file is set to display in a chromatogram. 

Note  If you are in a Qual or nonrepeating section, choose a Quan results-based 
chromatogram.

Table 18. Advanced Quan Peak Annotation Options page parameters 

Parameter Description

Use Advanced Quan Peak 
Annotation 

Turn on the advanced Quan peak options. 

Custom Peak Labels 

Component Name Label the Quan peak with the component name. 

Component Key Label the Quan peak with the component key. 

Custom Text Label Label the Quan peak with a custom text label.

Retention Time Label the Quan peak with the retention time. 

RT Labeling 

Units Specify the units for the retention time.

Decimals Define the number of decimal places to be displayed in the retention time label. 

Overlaid QI Identifier 

Show QI Peak Label Label overlaid qualifier ion peaks with a label identifying the qualifier ion. This option 
is only available when you select

• The All Quan Traces option on the Select Mass Spectrum Quan Traces to Display 
page.

• The Overlay (3D) option on the Select Chromatogram Style page. 
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Configure Normalization For The Chromatogram

Set parameters on the Configure Normalization For The Chromatogram page to select the 
normalization (y-axis scaling) method used for the chromatogram. 

Select A Peak Dialog Box 

Use the Select A Peak dialog box to select a peak in a demo file that opens in the report 
preview. 

Table 19. Configure How the Peak Window Will Look page parameters 

Parameter Description

Show Baselines View the baselines for a chromatogram peak (Quan or Qual). If you do not select 
this option, the Xcalibur data system hides the baselines, peak tracing, and full peak 
annotation. 

Set Custom Window Width Override the default value of the peak window width (the default is peak width plus 
one min) manually. This option is always available for Qual peaks and is sometimes 
available for Quan peaks. 

Custom Width (min) Define the Custom window width. The default value is 0.75 min. 

Table 20. Configure Normalization for the Chromatogram page parameters 

Parameter Description

Normalize Method 

Auto Zero Optimize the y axis automatically for each chromatogram. 

Intensity Range Set the range manually. Type the minimum and maximum intensity 
required for the y axis. The value can be from –200.0% to +200.0%. 

Normalize Each Plot To 

Largest Peak In Subsection Normalize each split time range to the largest peak in the division.

Largest Peak In Selected Time Range Normalize the chromatogram to the largest peak in the displayed time 
range. 

Largest Peak In All Times Normalize the chromatogram to the largest peak in the entire 
chromatogram.

Table 21. Select a Peak dialog box parameters

Parameter Description

Result File Select the name of the result file to be the demo file. 

Peak Type Define the peak type (Quan or Qual) in the result file. 

Peak List View the list of peaks that are in the result file. 
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Select Chromatogram Style

Use the Select Chromatogram Style page to determine the appearance of the chromatogram. 

Select Chromatogram Type

Set the chromatogram type for the chromatogram report object being configured in your 
report template on the Select Chromatogram Type page. 

Table 22. Select Chromatogram Style page parameters 

Parameter Description

Plotting

Point-to-Point (see 
Figure 60)

Display point-to-point peak profiles. 

Stick Display the chromatogram as vertical lines. 

Arrangement

Stack (2D) Stack plots vertically (same x axis) with no overlap (one y axis for each plot). 

Overlay (3D) Move plots vertically (same x axis) with an optional horizontal skew (y-axis time offset). 
When selected, the 3D display options are turned on. Use the 3D arrangement if you 
selected Multiple Quan Traces on the Select Mass Spectrum Quan Traces to Display page. 

3D

Elevation Set the elevation angle (amount of overlay) from 0 to 60 degrees for the 3D plot style. 

Skew Set the skew angle (time offset) from 0 to 45 degrees for the 3D plot style. 

Draw Backdrop Add a drawn perspective backdrop to 3D plots. 

Table 23. Select Chromatogram Type page parameters 

Parameter Description

Chromatogram Type 

Raw File Based Chromatogram Indicate the chromatogram is based on a raw file. 

Quan Results Based Chromatogram Indicate the chromatogram is based on Quan results. 

Qual Results Based Chromatogram Indicate the chromatogram is based on Qual results. 

Show All Qual Peaks In Result File Display all Qual peaks in the finished report.
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Select Component

Set parameters on the Select Component page to select a component to display when 
configuring a chromatogram.

Select Demo File 

Set parameters on the Select Demo File page to associate a demo file (.raw or .rst) with a 
chromatogram report object. Use the demo file to see how the chromatogram report object 
appears with its current settings when applied to real data.

The appearance of the Select Demo File page depends on the chromatogram type and the 
peak type settings chosen in the Chromatogram Type page. 

Table 24. Select Component page parameters 

Parameter Description

Processing View the name of the currently selected processing method (.pmd) file. 

Component List View a list of components found in the processing method file. 

Table 25. Select Demo File page parameters

Parameter Description

Use Demo File 

Use Demo File Connect a demo file with the chromatogram report object. 

Demo File Specify the path to the demo file. 

Demo Peak 

Quan Component Specify the Quan peak to use in the demo file. Click the Browse button. The Select A Peak 
Dialog Box opens. 

This box appears only if you are configuring a Quan based chromatogram. 

Qual Peak RT Specify the Qual peak to use in the demo file. Click the Browse button. The Select A Peak 
Dialog Box opens. 

This box appears only if you are configuring a Qual based chromatogram, and not showing 
all Qual peaks. Select these options on the Select Chromatogram Type page. 
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Select Enhance Details 

Set parameters on the Select Enhance Details page to enhance a chromatogram plot by 
applying smoothing. 

Select How the Chromatogram Axes Will Be Configured 

Set chromatogram axes labels and display parameters on the Select How The Chromatogram 
Axes Will Be Configured page. 

Table 26. Select Enhance Details page parameters 

Parameter Description

Enable Smoothing Apply smoothing to the chromatogram. 

Smoothing Details 

Type Define the type of smoothing algorithm applied to the chromatogram, either Boxcar or 
Gaussian.

Points Specify the number of smoothing points to use in the smoothing algorithm. 

Table 27. Select How the Chromatogram Axes Will Be Configured page parameters 

Parameter Description

X axis 

Name View or change the name of the x axis.

Offset Move the x-axis label away from the chromatogram. 

Split Time Range Split the chromatogram into two or more separate graphs with equal time ranges. 

Divisions Define the number of split time range graphs to be displayed for each chromatogram. 

Y axis 

Label

From Detector Use the detector-specific label for the y axis (stored in the .raw file). 

Custom Use your own label for the y axis. 

Units

Absolute Use absolute units for the y axis. 

Relative Use relative units for the y axis. 

Name Define the custom name of the y axis. This box is available only when you click the Custom 
option in the Label area. 

Offset Move the y axis label away from the chromatogram. 
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Select Mass Spectrum Quan Traces to Display

Set parameters on the Select Mass Spectrum Quan Traces To Display page to configure the 
Quan Traces property for MS data. Options on this page only apply to MS data and are 
ignored for other detector types. When a chromatogram report object displays a Quan 
component, there are potentially six traces associated with the component: the Quan Mass 
(QM) trace - the actual component peak - and up to five qualifier ions.

Select any of these possible six traces to be displayed in the chromatogram or display all of the 
available traces of the component. 

Select Plot Details

Set parameters on the Select Plot Details page to configure how the plot is drawn when you 
configure a raw file-based chromatogram. 

 To configure a plot

1. If you are in a Qual or Quan repeating section, the Use Container Supplied Qual or 
Quan Peak page opens. Select the Explicitly Specify The Chromatogram's Behavior check 
box and click Next.

2. On the Select Chromatogram Type page, select a raw file based chromatogram and follow 
the pages of the wizard until the Select Plot Details page opens.

Table 28. Select Mass Spectrum Quan Traces to Display page parameters 

Parameter Description

Quan Traces 

Quan Traces Specify the Quan traces to display. 

Common Normalization 
For All Traces 

Normalize all of the traces the same way. 

This check box is available only when you select All Quan Traces from the Quan Traces 
list. 

Table 29. Select Plot Details page parameters  (Sheet 1 of 3)

Parameter Description

Plot Type 

Detector View the type of detector used to generate the raw file.

Delay (min) Specify the delay for the start of the chromatogram trace.

Filter View the processing that is applied to a subset of the scans in the .raw file. The list displays 
scan filter options that are stored in the selected demo .raw file. If no demo file is selected, 
type a valid filter string. 

This option is only available when an MS detector is selected. 
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Trace The first list indicates the basic chromatogram type, for example, TIC.

The second list indicates a logical operator: + or –. 

The third list indicates a second chromatogram type to add to, or subtract from, the first 
trace. For example, Mass Range. 

The list of traces depends on the detector used to generate the data as follows:
• Detector Type 
• Valid Traces 
• MS
• Mass Range, TIC, Neutral Fragment, and Base Peak 
• Analog
• Analog 1–4 
• A/D Card 
• A/D Card Ch. 1–4 
• PDA
• Wavelength Range, Total Scan, and Spectrum Maximum 
• UV
• Channel A–D 

Mass (m/z) Define the display for the mass or mass range for Mass Range or Base Peak traces for 
MS detector types as follows:

If you choose Base Peak ± Mass Range or Mass Range ± Mass Range plot combinations, 
the identification page displays a Mass (m/z) field for each trace type.

If you use other detector types, use this field to specify the wavelength or 
wavelength range for the chromatogram. If you use a plot combination such as 
Wavelength Range + Wavelength Range, an additional Wavelength (nm) box opens.

The valid range depends on the configured detector. The format is 
low mass /wavelength–high mass /wavelength. Separate entries with a dash, no spaces. For 
example, for the range m/z 123 through 456, type 123–456. 

Time Range (min) Specify the upper and lower time limits for the plot in minutes, to one decimal place. 
Separate entries by a dash, with no spaces.

The default setting is “*”, which means to display the entire time range for the plot. 

Table 29. Select Plot Details page parameters  (Sheet 2 of 3)

Parameter Description
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Trace The first list indicates the basic chromatogram type, for example, TIC.

The second list indicates a logical operator: + or –. 

The third list indicates a second chromatogram type to add to, or subtract from, the first 
trace. For example, Mass Range. 

The list of traces depends on the detector used to generate the data as follows:
• Detector Type 
• Valid Traces 
• MS
• Mass Range, TIC, Neutral Fragment, and Base Peak 
• Analog
• Analog 1–4 
• A/D Card 
• A/D Card Ch. 1–4 
• PDA
• Wavelength Range, Total Scan, and Spectrum Maximum 
• UV
• Channel A–D 

Mass (m/z) Define the display for the mass or mass range for Mass Range or Base Peak traces for 
MS detector types as follows:

If you choose Base Peak ± Mass Range or Mass Range ± Mass Range plot combinations, 
the identification page displays a Mass (m/z) field for each trace type.

If you use other detector types, use this field to specify the wavelength or 
wavelength range for the chromatogram. If you use a plot combination such as 
Wavelength Range + Wavelength Range, an additional Wavelength (nm) box opens.

The valid range depends on the configured detector. The format is 
low mass /wavelength–high mass /wavelength. Separate entries with a dash, no spaces. For 
example, for the range m/z 123 through 456, type 123–456. 

Time Range (min) Specify the upper and lower time limits for the plot in minutes, to one decimal place. 
Separate entries by a dash, with no spaces.

The default setting is “*”, which means to display the entire time range for the plot. 

Table 29. Select Plot Details page parameters  (Sheet 2 of 3)

Parameter Description
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Select the Peak Labeling

Set parameters on the Select the Peak Labeling page to choose the type and style of peak 
labels. 

Select the Qual Peak 

Fixed Scale Set the y-axis maximum to a specific value. Clear this check box to activate the Normalize 
To area on the Configure Normalization For The Chromatogram page. 

Autofilter Repopulate a chromatogram view with

• A plot showing the chromatogram without any scan filters 

• Plots for each scan filter applied to the chromatogram 

Table 29. Select Plot Details page parameters  (Sheet 3 of 3)

Parameter Description

Table 30. Select the Peak Labeling page parameters 

Parameter Description

Label With

Retention Time Label the peaks with the time in minutes, prefixed by RT. 

Scan Number Label the peaks with number of mass scans at peak maximum, prefixed by S#. 

Base Peak Label the base peak in the mass spectrum of the chromatogram peak, prefixed by BP.

Signal To Noise Label the peaks with the signal-to-noise ratio at the peak maximum, prefixed by SN. 

Flags Label the peaks with flags providing supplemental information about the peak data. For 
example, if a peak is saturated, the data system displays an S above the peak. 

Area Label the peaks with the integrated area of the peaks, prefixed by AA if detected 
automatically or MA if detected manually.

Height Label the peaks with the apex height, prefixed by AH if detected automatically or MH if 
detected manually.

Label Styles

Offset Move a label away from its normal position to avoid conflict with another label. 

Size Specify the offset size, measured in number of characters. 

Rotated Use vertical rather than horizontal mass labels. Flags are always displayed unrotated. 

Boxed Place a rectangular outline around each peak mass label. Flags are not boxed.

Label Threshold Limit the labeling of peaks to those exceeding the specified percentage of the base peak. 

Advanced Set advanced labeling options. Only the Quan or Qual peak is labeled if you click this 
option. 
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Set the parameter on the Select the Qual Peak page to explicitly specify the Qual peak for a 
Qual results-based chromatogram report object. 

Select the Quan Peak 

Set parameters on the Select the Quan Peak page to explicitly specify the Quan peak 
(component) for a Quan results-based chromatogram report object. 

Use Container Supplied Qual Peak 

Set the parameter on the Use Container Supplied Qual Peak page to ignore the implicit Qual 
peak and explicitly configure the chromatogram type.

Table 31. Select the Qual Peak page parameters 

Parameter Description

Qual Peak To Display 

Retention Time (min) The retention time of the Qual peak. The retention time can be any time between the 
start and end peak boundaries.

You must select a valid retention time to combine template and data correctly. If the file 
used to resolve the report does not contain the specified retention time, the Xcalibur 
data system removes the chromatogram from the report. 

Table 32. Select the Quan Peak page parameters 

Parameter Description

Quan Peak 

Quan Peak Set the name of the Quan peak. To select a processing method (.pmd) file and select a 
component, click the Browse button. The Select Component dialog box opens. 

Use Quan Peak's Associated 
Internal Standard 

Use the associated internal standard of the Quan peak instead of the Quan peak.

You must select a valid peak for XReport to resolve the report correctly. If the file used 
to resolve the report does not contain the specified peak, the chromatogram is removed 
from the resolved report. 

Table 33. Use Container Supplied Qual Peak page parameters 

Parameter Description

Explicit Chromatogram Type 

Explicitly Specify 
The Chromatogram's Behaviour

Ignore the implicit Quan peak supplied by the container and 
explicitly configure the chromatogram type. 
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Use Container Supplied Quan Peak

Set parameters on the Use Container Supplied Quan Peak page to either display the details of 
the internal standard associated with the implicit Quan peak or ignore the implicit Quan peak 
and explicitly configure the chromatogram type. 

Spectrum Properties Dialog Box 

Use the Spectrum Properties dialog box to configure the settings for your spectrum report 
object. 

Spectrum Properties dialog box pages:

• Axis Page

• Enhance Page

• Labels Page

• Normalization Page

• Options Page

• Peak Page

• Plot Type Page

• Style Page

Table 34. Use Container Supplied Quan Peak page parameters

Parameter Description

Implicit Quan Peak Options 

Use Quan Peak's Associated 
Internal Standard

View the details of the internal standard associated with the implicit Quan peak. 

Explicit Chromatogram Type 

Explicitly Specify 
The Chromatogram's 
Behaviour

Ignore the implicit Quan peak supplied by the container and explicitly configure the 
chromatogram type. 
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Axis Page

Set spectrum axis labels and display options on the Axis page. 

Enhance Page

Specify spectrum enhancement details on the Enhance page. 

Table 35. Axis page parameters 

Parameter Description

X axis 

Name View or change the name for the x axis.

Offset Move the axis label away from the spectrum.

Split Mass Range Split the spectrum into two or more separate graphs with equal ranges.

Divisions View the number of split range graphs for each spectrum. 

Y axis 

Label

From Detector Use the detector-specific label for the y axis (stored in the raw file). 

Custom Use your own label for the y axis.

Name Specify the name for the y axis if you selected Custom label above. 

Offset Move the axis label away from the spectrum. 

Units

Absolute Use absolute units on the y axis.

Relative Use relative units on the y axis. 

Note  Clear the Use Processing Method Properties For Plot Type And Enhancement Info 
check box on the Options Page to modify the Enhance page parameters.

Table 36. Enhance page parameters  (Sheet 1 of 2)

Parameter Description

Smoothing

Enable Turn on spectrum smoothing. 

Type Specify the type of smoothing algorithm to apply to the spectrum. Choose from Boxcar or 
Gaussian. 

Points Specify the number of points for spectrum smoothing. This must be an odd number from 3 
(minimum smoothing) to 15 (maximum smoothing). 

Refine

Enable Turn on refine spectrum enhancement. 
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Labels Page

Choose the type and style of peak labels on the Labels page. 

Window Define an area for drawing a peak by specifying the number of seconds on either side of the 
specified point. A reasonable initial value is the peak width in seconds. 

Noise Threshold Specify the cutoff point for peaks. Type 0 to show all peaks in the spectrum and slowly 
increase the value until the noise peaks are eliminated. Use this setting to eliminate peaks 
generated from baseline noise. 

Background Subtraction 

This area shows details of background subtraction if it was applied to the spectrum. The background contribution is 
determined by averaging the scans from one or two baseline regions. 

Time Range 1 Add a first baseline region that is used for assessing the background. When you click this 
option, the Xcalibur data system activates a box. Type the time range to use in the box.

Time Range 2 Add a second baseline region that is used for assessing the background. 

Table 36. Enhance page parameters  (Sheet 2 of 2)

Parameter Description

Table 37. Labels page parameters 

Parameter Description

Label With 

Mass or Wavelength Label the peaks with m/z values (if MS is selected as the detector on the Plot Type Page) or 
wavelength values (if PDA is selected as the detector on the Plot Type Page). 

Flags Label spectrum peaks with flags. Flags provide supplemental information about peak data. 
For example, if a peak is saturated, the Xcalibur data system displays an S above the peak. 

Relative To Move the m/z labels for the peaks away from the peaks by the specified amount. 

Decimals Specify the number of decimal places to be used in mass labels.

Label Styles 

Offset Move a label from its normal position to avoid conflicts with other labels. 

Size Specify the offset size to use (in number of characters).

Rotated Use vertical rather than horizontal mass labels. Flags are always displayed unrotated. 

Boxed Place a rectangular outline around each peak mass label. Flags are not boxed.

Label Threshold Specify a peak height level, in percent of the base peak. Above that level, XReport labels a 
peak. 
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Normalization Page

Select normalization options for spectrum plots on the Normalization page. 

Options Page

Set spectrum parameters on the Options page. 

Table 38. Normalization page parameters 

Parameter Description

Normalize Method 

Auto Zero Optimize the y axis automatically. 

Intensity Range Set the y-axis range. Use the box to type the minimum and maximum intensity. The 
valid range is from –200.00 to 200.00%. 

Normalize To 

Largest Peak In Subsection Normalize each split mass range to the largest peak in the division. 

Largest Peak In Range Normalize the spectrum to the largest peak in the displayed mass range. 

Largest Peak In Scan Normalize the spectrum to the largest peak in the entire spectrum. 

Normalize Multiple Scans 

Individually Normalize each mass plot individually.

All The Same Normalize all mass plots equally. 

Table 39. Options page parameters 

Parameter Description

Use Processing Method 
Properties For Plot Type 
and Enhance Info 

Use properties from the selected processing method to set plot type and enhance 
information for the spectrum.

Use ISTD Peak When 
Repeating On Component 

Use the selected ISTD (internal standard) peak when repeating on a component. Select 
the Use Processing Method Properties For Plot Type and Enhance Info option to 
modify this parameter. 
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Peak Page

Set parameters on the Peak page to explicitly specify the peak to display in the spectrum report 
object. 

Plot Type Page

Configure how the spectrum is drawn on the Plot Type page. 

Table 40. Peak page parameters 

Parameter Description

You can explicitly specify the peak that you want to appear in a spectrum control 

Enable Explicit Peak Type Activate controls so you can specify the type of peak to appear in the spectrum. 

Peak Type 

Quan Peak Specify a Quan peak. 

Qual Peak Specify a Qual peak. 

Peak Identification 

Component Name Define the name of the Quan peak or the retention time of the Qual peak. If you are 
entering a Qual peak, you can type any time between the start time and end time of the 
peak. 

Note  The parameters in the Plot Type page are enabled only when you clear the Use 
Processing Method Properties For Plot Type And Enhancement Info check box on the 
Options Page. 

Table 41. Plot Type page parameters 

Parameter Description

Mass Range or 
Wavelength Range 

Specify the mass or mass range for MS detector types. For PDA detector types, use this box 
to specify the wavelength or wavelength range (nm).

Type the upper and lower limits for the plot. Separate entries by a dash, with no spaces.

To use the entire mass or wavelength range, type an asterisk (*). 

Detector View the type of detector that was used to generate the raw file. Valid types are MS and 
PDA.

The type of detector determines the available plot types. 

Time View or change the time of the mass scan in the host chromatogram. Type a new value or 
range as required.
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Style Page

Set parameters on the Style page that determine the appearance of the spectrum. 

Table Properties Wizard 

Use the Table Properties wizard to customize the following settings for your table:

• Which columns to include in the table 

• Custom table column settings 

• Table sort order 

The Table Properties wizard has these pages:

• Configure User Column Parameters Page

• Select Table Fields Page

• Set Table Sort Filter Page

• Set Table Font Page

Scan Filter Specify the scan filter to apply to your data. Select a filter from the list or type a new filter 
using the scan filter format. 

Demo File Specify the path and filename of the demo file (raw file) that is used to generate a preview of 
the selected plot. 

Table 41. Plot Type page parameters 

Parameter Description

Table 42. Style page parameters 

Parameter Description

Plotting

Automatic Choose the graphic style based upon the data acquisition method that was used for the 
active spectrum. 

Point To Point Display point-to-point peak profiles. 

Stick Display the spectral mass peaks as vertical lines. 

Shade Display the spectrum as a shaded representation of intensity in each amu band for the active 
spectrum.
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Configure User Column Parameters Page

Configure any custom (User) columns that you selected to include in your table on the 
Configure User Column Parameters page. Complete the parameters on this page for each 
custom column that you selected. 

Select Table Fields Page 

Choose the columns for the table on the Select Table Fields page. The columns available for a 
table are given in alphabetical order, but can be added to a report template in any order. The 
columns that you can select depend on the type of table object that you are configuring. 

Table 43. Configure User Column Parameters page parameters 

Parameter Description

User Columns Define the custom columns to include in your table. Select the column to customize. 

User Column Title 

User Column Title Provide a descriptive title for the column. 

User Column Formula

User Column Formula View the formula for the current column (read-only box). To edit the formula, click Edit 
Formula.

Edit Formula Change your formula. 

Table 44. Select Table Fields page parameters  (Sheet 1 of 2)

Parameter Description

Title View the custom title of the selected object.

Include The Title In 
The Resolved Report 

Include the custom title in the final report. 

Available Columns View columns that are available for the selected table.

A user column is a column that you can configure to display what you want on a later page 
of the wizard. 

Add Add one or more columns to the table. Select one or more columns from the Available 
Columns list and click Add to add them to the table. 

Add All Add all of the available columns to the table. 

Remove Remove one or more columns from the table. Select one or more columns from the Selected 
list and click Remove to remove them from the table.

Remove All Remove all of the columns from the selected list. 

Selected View the columns that are currently selected to be included in the table. The columns are 
listed in the order that they appear in the table. 

Column Header View the heading for the currently selected column. 
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Set Table Sort Filter Page

Set parameters on the Set Table Sort Filter page to define the order for table data when you 
generate a report using the chosen table object in the report template. 

Decimal Setting View or change the number of digits displayed after the decimal point for values displayed 
in this column. This parameter is only available for some table fields. 

Move Up Move a column up in the Selected list. Select a column in the Selected list and click 
Move Up to move the column up in the list. This action moves the column to the left in the 
finished table. 

Move Down Move a column down in the Selected list. Select a column in the Selected list and click 
Move Down to move the column down in the list. This action moves the column to the 
right in the finished table.

Table 44. Select Table Fields page parameters  (Sheet 2 of 2)

Parameter Description

Note  This page is not available for the Library Search Graphics Results table. 

Table 45. Set Table Sort Filter page parameters 

Parameter Description

Column List View the list of columns that are currently selected for the table.

Current Sorting Configuration

First Order -
Ascending/Descending 

Select the first column that the Xcalibur data system uses to sort the table. Select to sort in 
ascending or descending order. 

Second Order -
Ascending/Descending

Select the second column that the data system uses to sort the table. For instance, use this 
option in columns that have identical entries in the First Order column. Select to sort in 
ascending or descending order.

Third Order -
Ascending/Descending

Select the third column that the data system uses to sort the table. For instance, use this 
option in columns that have identical entries in the First Order and Second Order columns. 
Select to sort in ascending or descending order.

Buttons

Add Add the selected column to the next available sort order.

Remove Remove the last selected sort order.
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Set Table Font Page

Configure the formatting of the currently selected table object on the Font page.

Edit Formula For Dialog Box 

Edit a formula for use in a custom column of your table on the Edit Formula For dialog box. 
For more information on formula syntax, see “Adding a Formula to a Table” on page 22. 

Table 46. Set Table Font page parameters 

Parameter Description

Title Font,
Heading Font,
Cell Font 

Set and view the font settings for all of the title, headings, and cells in the table object. To 
configure your font, click the button. The Font Dialog Box opens.

Table 47. Edit Formula For dialog box parameters  (Sheet 1 of 2)

Parameter Description

Formula View the current formula. Type in this box directly or add functions from the list. 

Functions

A list of available functions. A brief description of each of the functions appears at the bottom of the dialog box when 
each function is selected.

Function

ABS

AND

AVERAGE

COUNT

FALSE

INT

MAX

MIN

Syntax

ABS(x)

AND(x,y)

AVERAGE(x1, 
x2, ...,xn)

COUNT(list)

FALSE

INT(x)

MAX(x1, x2, ...,xn)

MIN(x1, x2, ...,xn)

Description

Return the positive value of a number of a formula regardless of its 
actual positive or negative value. 

Return the value 1 if the logical expressions x and y are both true, 
or the value 0 if either expression is false.

Return the average of the list of values. 

Return the count of the number of items in a list. 

Return 0 (zero). 

Return the number to the left of the decimal place in the value or 
formula x. 

Return the largest value in a list. 

Return the smallest value in a list. 
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Configure Function Dialog Box

Configure the settings for a function in a formula for use in a custom column of your table in 
the Configure Function dialog box. 

The Configure Function dialog box varies, depending on which function you are configuring.

FALSE and TRUE: No configuration options. 

ABS, AVERAGE, INT, MAX, MIN, PRODUCT, ROUND, SIGN, SUM: Select one or 
more columns to perform the function on. These expressions all have the same options, but 
ROUND has the additional option to select the number of decimal places. 

AND, NOT, and OR: enter one (NOT) or two (AND and OR) expressions to be evaluated. 
These expressions all have the same options.

COUNT: Enter a list. 

MOD: Select either a column or a value for each of the first and second parameters. 

Spectrum List Table Properties Dialog Box 

Function

MOD

NOT

OR

PRODUCT

ROUND

SIGN

SUM

TRUE

Syntax

MOD(x,y)

NOT(x)

OR(x,y)

PRODUCT(x1,
x2, ...,xn)

ROUND(x,y)

SIGN(x)

SUM(x1, x2, ...,xn)

TRUE

Description

Return the remainder from dividing the value x by the value y a 
number of times in integers. 

Return the value 0 (zero, false) if the logical expression x is true, or 
the value 1 (true) of the expression x is false. 

Return the value 1 (true) if either or both logical expressions x and 
y are true, or the value 0 (zero, false) if both expressions are false. 

Return the result of multiplying a list of values. 

Return the value of x rounded to the specified number of decimal 
places y; x can be either a number or a result of a formula. 

Return the value 1 if x is a positive value, or the value -1 if x is a 
negative value. 

Return the sum of a list of values or formulas. 

Return 1. 

Add Function Configure the currently selected function and add it to the current formula.

Table 47. Edit Formula For dialog box parameters  (Sheet 2 of 2)

Parameter Description
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Use the Spectrum List Table Properties dialog box to configure settings that apply to the 
Spectrum List table.

The Spectrum List Table Properties dialog box has the following pages:

• Display Page

• Enhancement Page

• Options Page

• Plot Type Page

Display Page

Configure display parameters for the Spectrum List table on the Display page. 

Table 48. Display page parameters 

Parameter Description

Display

All Peaks Display all peaks in the Spectrum List table. 

Top Limit the number of peaks in the table to a specified number. 

Order By 

Mass/Intensity 

or

Wavelength/Intensity

Toggle between ordering the data in the Spectrum List table by mass (or wavelength if the 
PDA Detector is selected) or intensity. 

Normalization

Intensity Range Specify the relative abundance range of mass peaks that are included in the table. The valid 
range is –200.000 to 200.000%. 

To change the range of relative abundances, type the minimum and maximum relative 
abundance to display in the Intensity Range box, separated by a dash. For example, to 
display all peaks in a mass spectrum with relative abundances ranging from 50 to 100%, 
type 50.000–100.000. XReport excludes spectrum peaks with relative abundances that 
range from 0.000 to 49.999% from the table. 
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Enhancement Page

Configure spectrum enhancement parameters for the Spectrum List table on the 
Enhancement page. 

Note  Clear the Use Processing Method Properties For Plot Type And Enhancement 
Info check box on the Options Page to modify parameters on the Enhancement page. 

Table 49. Enhancement page parameters 

Parameter Description

Smoothing

Enable Turn on spectrum smoothing. 

Type Specify the type of smoothing algorithm to apply to the spectrum. Choose from Boxcar or 
Gaussian. 

Points Specify the number of points for spectrum smoothing. This must be an odd number from 3 
(minimum smoothing) to 15 (maximum smoothing). 

Refine

Enable Turn on refine spectrum enhancement. 

Window Define an area for drawing a peak by specifying the number of seconds on either side of the 
specified point. A reasonable initial value is the peak width in seconds. 

Noise Threshold Specify the cutoff point for peaks. Type 0 to show all peaks in the spectrum and slowly 
increase the value until the noise peaks are eliminated. Use this setting to eliminate peaks 
generated from baseline noise. 

Background Subtraction 

This area shows details of background subtraction if it was applied to the spectrum. The background contribution is 
determined by averaging the scans from one or two baseline regions. 

Time Range 1 Activate a first baseline region that is used for assessing the background. Clicking this option 
activates a box. Type the time range to use in the box.

Time Range 2 Activate a second baseline region that is used for assessing the background. 
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Options Page

Configure general parameters relating to the Spectrum List table on the Options page. 

Plot Type Page

Configure plot information for the Spectrum List table on the Plot Type page. 

Table 50. Options page parameters 

Parameter Description

Use Processing Method 
Properties For Plot Type 
And Enhancement Info 

Use the information in the processing method when determining the plot type and 
other enhancement details. 

Use ISTD Peak When 
Repeating On Component 

Include internal standard peaks in the spectrum list. This parameter is only applicable 
to the Quan nonrepeating and is not available when this object is used in a Qual 
nonrepeating. 

Note  Clear the Use Processing Method Properties For Plot Type And Enhancement 
Info check box on the Options Page to modify the parameters in the Plot Type page.

Table 51. Plot Type page parameters  (Sheet 1 of 2)

Parameter Description

Mass/
Wavelength

For Detector = MS: 

View or change the current mass range of the active spectrum. To change the mass range, 
type the first mass and last mass of the scan in the Mass Range box. The format is 
First Mass–Last Mass. For example to display mass/charge 100 through 200, type 100–200. 

For Detector = PDA: 

View or change the current wavelength range in nanometers. To change the wavelength 
range, input the short wavelength and long wavelength of the scan in the Wavelength Range 
box. The format is Short Wavelength–Long Wavelength. For example, to display a wavelength 
range of 195 through 795 nanometers, type 195–795. 

Detector View or change the currently selected detector data type: 

• MS 

• PDA 

Time View or change the time range (in minutes) for the active spectrum. The valid range is 0.00 
to 200.00 minutes. To select a time range, type the lower and upper time limits in minutes, 
separated by a dash (no spaces) in the Time box. For example, to select a time range from 
0.10 to 9.10 minutes, type: 0.10–9.10. 
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Average Scan Filter Selection Dialog Box

Configure the average scan filter that is used for the Spectrum List table in the Average Scan 
Filter Selection dialog box.

Display the Plot Type page, and type an asterisk (*) in the Time box.

Library Search Graphics Table Properties Dialog Box 

Configure additional parameters that apply to the Library Search Graphics Table in the 
Library Search Graphics Table Properties dialog box. 

Scan Filter View or change the scan filter used for the active spectrum. Select a filter from the list or use 
the scan filter format to type a scan filter in the Filter box. This box is available only for MS 
detectors. 

Demo File View the filename of the demo file that is used in the template.

Table 51. Plot Type page parameters  (Sheet 2 of 2)

Parameter Description

Table 52. Average Scan Filter Selection dialog box parameters 

Parameter Description

Scan Filter View a list of all scan filters in the time range. If there is more than one scan type in the 
selected time range, choose one scan type to average.

Table 53. Library Search Graphics Table Properties dialog box parameters

Parameter Description

Max # Of Hits To 
Display

Specify the maximum number of matches from the library search to display in the Library 
Search Graphics table. 

Display Column Labels Display labels at the top of the columns in the table. 

Show Peak Spectrum Display the peak spectrum in the table. This check box is available only when you have 
selected to include the Hit Spectrum column in the Table Properties dialog box. 
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Library Search Results Table Properties Dialog Box 

Configure an additional parameter that applies to the Library Search Results Table in the 
Library Search Results Table Properties dialog box. 

Sample Table Properties Dialog Box 

Configure additional settings that apply to a Sample table in the Sample Table Properties 
dialog box. 

Text Object Properties Dialog Box

Use the Text Object Properties dialog box to configure the settings of the currently selected 
text object.

This dialog box has the following pages:

• Data Page

• Attributes Page

• Font Page

Table 54. Library Search Results Table Properties dialog box parameters 

Parameter Description

General

Max # Of Hits To 
Display

Specify the maximum number of matches from the library search to display in the Library 
Search Results table. 

Table 55. Sample Table Properties dialog box parameters

Parameter Description

Include Standards Include data from standards in the Sample table.

Include QCs Include data from QCs in the Sample table.

Include Blanks Include data from blank samples in the Sample table.

Include Unknowns Include data from unknown samples in the Sample table.
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Data Page

Indicate what text appears in the text object on the Data page. 

The Data page of the Text Object Properties dialog box changes depending on the text object 
you select.

To create an Annotation object, you can type the annotation text to add to your report. You 
can either type the text directly in the box or copy and paste it in. Paste text in the box by 
either right-clicking in the box and choosing Paste from the shortcut menu, or by pressing 
CTRL+V. Add line breaks by pressing the ENTER key while the cursor is still in the box. 

Table 56. Data page parameters  (Sheet 1 of 2)

Parameter Description

Title The custom title of the selected object.

Include The Title In The Resolved 
Report 

Include the custom title in the final report. 

Available Items 

This box lists the items that are available to add to the text object. To add an item to the Selected list, select it to 
highlight it and click Add. 

The Available Items list varies, depending on which text object is selected:

• Component ISTD Settings Summary
• Component Settings Summary
• Component Sys Suit/Flags Settings
• Instrument Method
• Processing Method - General
• Processing Method - Qual
• Quan ISTD Peak Summary
• Quan Peak Summary 
• Report Info 
• Sample Header

Add Add the currently highlighted item in the Available Items list to the 
Selected list. 

Add All Add all of the items in the Available Items list to the Selected list. 

Remove Remove the currently highlighted item from the Selected list. 

Remove All Remove all of the items from the Selected list. 

Selected

This box lists the items that are already selected to be displayed in the text object.

Move Up, Move Down Rearrange the order of the items in the Selected list by moving the 
currently highlighted item up or down in the list. 
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Attributes Page

Format the currently selected text object on the Attributes page. 

Font Page

Format the currently selected text object on the Font page.

The parameters in the Font page depend on whether you are configuring an annotation or 
other text object.

The Annotation Font page has the standard Microsoft Windows font chooser. Here you can 
choose font, font size, color, emphasis, and so on. 

Bitmap Properties Dialog Box

Data Label Show the data label or heading text for the currently highlighted data label 
or heading in the Selected list. Edit the data labels or headings by typing in 
this box. 

Decimal Setting Specify the number of digits displayed after the decimal point for values 
displayed with the selected data label. This parameter is only available for 
some data labels. 

Table 56. Data page parameters  (Sheet 2 of 2)

Parameter Description

Table 57. Attributes page parameters 

Parameter Description

Number of Columns

1, 2, or 3 Display the data in 1, 2, or 3 columns.

Horizontal Spacing 

Include Data Label Show or hide the data labels adjacent to the data.

Include Spacing Between Data Label and Its 
Data

Add space between data labels and the data so that all data values are 
aligned. 

Vertical Spacing 

Single, 1.5 Lines, or Double Set the amount of space between each line in the text object.

Table 58. Font page parameters 

Parameter Description

Title Font,
Heading Font,
Data Label Font,
Data Font

Set and view the font settings for all of the title, headings, data labels, and data in the text 
object. 

To configure your font, click . The Font Dialog Box opens.
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Specify the filename of the currently selected bitmap in the Bitmap Properties dialog box. 

Table 59. Bitmap Properties dialog box parameters 

Parameter Description

Bitmap File Specify the filename for the currently selected bitmap. Type the full path or click the Browse 
button to browse for the file. 

Reset to Original Size Reset the size of the image in the template to the original size in the file. 
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Column Properties Dialog Box

Set parameters in the Column Properties dialog box to specify the number of columns for the 
column object and whether to repeat by sample or summary. 

Table 60. Column Properties dialog box parameters  (Sheet 1 of 2)

Parameter Description

Number of Columns 

2, 3, 4, or 5 Specify the number of columns in the column object. 

Repeat Type - Sample repeat 

View information relating to a particular raw file of a sample and the results created when processing it. Use this 
repeat type as a layout tool to indicate where objects are placed on the page of the resolved report.

Example 1: When you place a 2-column object in a Quan repeating section, add a chromatogram to the right 
column, and resolve the template given data of 1 sample with 4 components each, the report appears as follows: 

Example 2: Place a 2-column object in a Quan repeating section, add a chromatogram to the left column, a spectrum 
to the right column, and a text object below the column. Then, combine the data with the template given data of 1 
sample with 4 components. All objects in the section are repeated by sample, and the report appears as follows: 

Resolve

Sample 1

Chrom 1

Chrom 2

Chrom 3

Chrom 4

Chrom

Resolve

Sample 1

Chrom

Text

Spec Chrom 1

Text

Spec 1

Chrom 2

Text

Spec 2

Chrom 3

Text

Spec 3

Chrom 4

Text

Spec 4
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Repeat Type - Summary repeat 

View information relating to all of the samples in an Xcalibur sequence and the results created when processing them. 
This setting is ignored when the column object is not located in a nonrepeating section. 

Example 3: If you place a 2-column object in a nonrepeating section, add a chromatogram (in either column), and 
resolve the template given data of 2 samples with 4 components each, the report appears as follows: 

If you choose instead the Top To Bottom option, the report appears as follows:
 

If you place an object in the right column, and leave the left column empty, the data is resolved as if the object is placed 
in the left column, as illustrated above.

If you place an object in each column, the Xcalibur data system ignores the Top To Bottom and Left To Right 
options. The report appears as follows: 

If you click the New Sample New Row option, data for a new sample always starts on a new row. 

Table 60. Column Properties dialog box parameters  (Sheet 2 of 2)

Parameter Description

Chrom 1

Chrom 3

Resolve

Sample 1
Chrom 2Chrom

Chrom 4

Chrom 1

Chrom 3

Chrom 2

Chrom 4
Sample 2

Left to
right

Chrom 1

Chrom 2

Resolve

Sample 1
Chrom 3Chrom

Chrom 4

Chrom 1

Chrom 2

Chrom 3

Chrom 4
Sample 2

Top to
bottom

Chrom 1

Chrom 2

Resolve

Sample 1

Spec 1Chrom

Spec 2

Chrom 3

Chrom 4

Spec 3

Spec 4

Text

Spec

Chrom 1

Chrom 2
Sample 2

Spec 1

Spec 2

Chrom 3

Chrom 4

Spec 3

Spec 4

Text
Thermo Scientific XReport User Guide 155



D XReport Reference
XReport Dialog Boxes
Configure Component Calibration Curve Dialog Box

Set parameters in the Configure Component Calibration Curve dialog box to specify the 
component name that a nonrepeating Component Calibration Curve report object is plotted 
for in your report. 

Data Sources Dialog Box

Select data files to apply to the current report in the Data Sources dialog box. 

Electronic Signature Properties Dialog Box

Configure the order of information displayed in the Electronic Signature Table object in the 
Electronic Signature Properties dialog box.

Table 61. Configure Component Calibration Curve dialog box parameters 

Parameter Description

Component Name Specify the name of the component to display in your component calibration curve.

Click the Browse button to open a dialog box and select a processing method file. After 
you select a processing method file, XReport provides a list of the components to 
choose from in that file. After you select a component, XReport returns to the 
Configure Component Calibration Curve Dialog Box and adds the selected component 
to the Component Name box. 

Table 62. Data Sources dialog box parameters 

Parameter Description

Calibration File Select the calibration (.xcal) file to apply to the current report.

Processing Method File Select the processing method (.pmd) file to apply to the current report.

Raw Data File Select the raw (.raw) file to apply to the current report.

Result File Select the result (.rst) file to apply to the current report.

Sequence List File Select the sequence list (.sld) file to apply to the current report.

Table 63. Electronic Signature Properties dialog box parameters 

Parameter Description

Signature Information Order

Created By First Display the Created By signature block first. This block displays the electronic signature 
information for the person who created the report.

Signed By First Display the Signed By signature block first. This block displays the electronic signature 
information for the people who signed the report.
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Font Dialog Box

Use the Font dialog box to select the global fonts for all objects in your report or customized 
fonts for the selected objects in the report. 

This dialog box has three pages that are the same as in the individual Font Properties pages 
that you access when you configure an individual object:

• Annotation (see “Font Page” on page 152)

• Text (see “Font Page” on page 152)

• Tables (see “Table Properties Wizard” on page 141)

Preferences Dialog Box

Set grid and configuration options for your report in the Preferences dialog box. 

Preview Window 

Preview and adjust the appearance of your report using the parameters in the Preview window. 
To open this window, choose Report > Simulate Report. XReport displays a preview of your 
template filled with sample data. In previewing the appearance of your report, adjust your 
template before you combine it with actual data. Choose Report > Resolve Report to see a 
preview of your report combined with your actual data. 

Table 64. Preferences dialog box parameters 

Parameter Description

Grid Spacing

Width Set the width between gridlines. (1 gridline unit = 0.1 inches) 

Height Set the height between gridlines. (1 gridline unit = 0.1 inches) 

Actions

Snap To Grid Snap objects to the grid. For Snap To Grid to work, the grid must be displayed (choose 
View > Report Template Grid). 

Show Page End Display a dashed blue line that indicates the location for page breaks.

Show Template 
Configuration

Show the Template Configuration Dialog Box when you open XReport or choose File > 
New. Use the Template Configuration dialog box to select a type of report to create (for 
example, Xcalibur 2.0). This option is available only when two or more types of report 
templates are installed on the system (for example, both Xcalibur and LCQuan™.) 
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Save As Dialog Box

Use the Save As dialog box to save your report template. 

The Save As dialog box is the standard Microsoft Save dialog box, with the addition of a Lock 
Template check box. If you select this check box, the template cannot be saved with the same 
name again. It can, however, be opened, edited, and resolved with data. To save an edited 
version, save it as a different filename. 

The title bar of XReport indicates whether the displayed template is locked or unlocked. For a 
locked template, Locked appears in the title bar. For an unlocked template, nothing appears in 
the title bar. 

There is no audit trail when a new template is created or when an existing template is 
changed.

Table 65. Preview window parameters 

Parameter Description

Print Print your report preview. This option is available only for resolved reports, not for 
simulated reports. 

Save Save your report in the following formats (available only for resolved reports, not simulated 
reports):

• Microsoft word document (.doc) 

• Microsoft Excel workbook (.xls) 

• Web page (.htm or .html) 

• Plain text (.txt) 

• Rich text format (.rtf ) 

• Adobe™ PDF (.pdf ) 

Next Page/Prev Page Scroll the preview to the next or previous page in the report. 

First Page/Last Page Scroll the preview to the first or last page in the report. 

Page X of Y View X, the current page, and Y, the total number of pages in the report. Type in a new 
value for X to scroll to that page. 

Two Page View the preview two pages at a time. 

Zoom In / Zoom Out Increase or decrease the size of the report in the preview window. 

Close Close the preview window and go to XReport. 

Help View XReport Help. 
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Template Configuration Dialog Box

Select the type of report to create in the Template Configuration dialog box. This dialog box 
is only displayed if you have more than one type of report installed (for example, Xcalibur and 
LCquan). 

Report Sections
You can divide your report template into sections and add report objects to those sections. To 
add sections into a report template, drag them from the Sections pane.

The types of sections used in XReport are as follows:

• Nonrepeating Section 

• Report Header and Footer

• Qual Repeating Section

• Quan Repeating Section

A report object that is placed in a repeating section can behave differently from the same 
report object placed in a nonrepeating section. See “Report Objects” on page 163 for 
information on how a report object functions when it is placed inside or outside a repeating 
section.

Nonrepeating Section

A nonrepeating section is any portion of a report template that is not classified as a repeating 
section. A nonrepeating section usually displays static details associated with either data or 
methods that apply once and globally within the system. 

A nonrepeating section can have these objects:

Formatting Objects 

• Page Break

Table 66. Template Configuration dialog box parameters 

Parameter Description

Report Types View a list of available report types. Select the program for which you would like to create a 
report. 

Do Not Show This 
Dialog Again 

Hide this dialog box when you open XReport or choose File > New again. To redisplay this 
dialog box, choose Layout > Preferences and select the Show Template Configuration 
check box. 
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• Columns

Graphic Objects 

• Electronic Signature Table

• Bitmap

• Chromatogram

• Component Cal Curve

• Spectrum

Table Objects 

• Avalon Qual Events Table

• Calibration File Table

• Component Cal Level Table

• Dilution Factor Table

• IRC Summary Table

• Processing Method Programs Table

• Processing Method Sample Reports Settings Table

• Processing Method Summary Reports Settings Table

• Qual Peak Table

• Quan Peak Table

• Sequence Table

• Spectrum Candidate Results Table

Text Objects 

• Annotation 

• Instrument Method 

• Processing Method - General

• Processing Method - Qual

• Sample Table
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Report Header and Footer

The report header and footer sections contain data to be repeated at the top and bottom of 
each page in your report, for example, the report date, page number, and a company logo.

A Report Header or Footer section can have these objects:

Formatting Objects 

• Columns

Graphic Objects 

• Bitmap

• Electronic Signature Table

• Table Objects

Text Objects 

• Annotation 

• Report Info

• Sample Header

Repeating Sections

A repeating section is a section of a report template that is automatically repeated for every 
component or peak in a resolved document. You can change the properties of a repeating 
section to customize its behavior. XReport can have two types of repeating sections:

• Qual Repeating Section

• Quan Repeating Section

Qual Repeating Section

A Qual Repeating section displays details relating to a single Qual peak within some data. 
This section is then repeated for all Qual peaks found. 

A Qual Repeating section can have these objects:

Formatting Objects 

• Page Break

• Columns

Graphic Objects 
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• Electronic Signature Table

• Bitmap

• Chromatogram

• Spectrum

Table Objects 

• Library Search Graphics Table

• Library Search Results Table 

• Spectrum List Table 

Text Objects 

• Annotation 

Quan Repeating Section

A Quan repeating section is also called a Component section. Its purpose is to display details 
relating to a single Quan peak in some data or a component configured in a processing 
method. This section is then repeated for all Quan peaks or components. 

A Quan repeating section can have the following objects:

Formatting Objects 

• Page Break

• Columns

Graphic Objects 

• Electronic Signature Table

• Bitmap

• Chromatogram

• Component Cal Curve

• Spectrum

Table Objects 

• Avalon Quan Events Table

• Component Cal Level Table

• IRC Settings Table

• Component QC Level Table
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• Component Spectrum Table

• IRC Settings Table

• Spectrum List Table

• Sample Table 

Text Objects 

• Annotation 

• Component IdentDetectCal Settings

• Component ISTD Settings Summary

• Component Settings Summary 

• Component Sys Suit/Flags Settings

• Quan ISTD Peak Summary

• Quan Peak Summary

Report Objects
Report objects are predefined chunks of data that you can drag to the XReport template from 
the Objects pane. When you combine a report template with Xcalibur data (data source files), 
XReport replaces the report objects in the template with data to generate an Xcalibur report.

Report objects include the following:

• Graphic and Formatting Objects

• Table Objects

• Text Objects

Graphic and Formatting Objects

Graphic objects display graphics. Graphic objects can be configured and customized. The 
graphic object is replaced with a graphic when a report template is resolved with Xcalibur 
data. Formatting objects help to configure the layout of the report. 

The following graphic and formatting objects are available in XReport:

Chromatogram Bitmap

Spectrum Columns

Component Cal Curve Page Break
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Chromatogram

The Chromatogram object displays a graphical trace that can show either raw data or 
processed data for any acquisition device that is supported by the Xcalibur data system (MS, 
Analog, A/D card, PDA, UV). 

Required data file: .raw, .rst 

Section placement: Qual, Quan, and nonrepeating sections 

Spectrum

The Spectrum object displays a graphical spectrum that can show either raw data or processed 
data for any acquisition device supported by the Xcalibur data system (MS, PDA). 

Required data file: .raw, .rst 

Section placement: Qual, Quan, and nonrepeating sections

Component Cal Curve

The Component Cal[ibration] Curve object displays the calibration curve that is used to 
quantify a specified component. The curve is specified in the processing method as the 
response versus the amount of standard. 

Required data file: .pmd, .rst 

Section placement: Quan or nonrepeating sections. For the nonrepeating section, specify 
which component to display in the Configure Component Calibration Curve Dialog Box. 

Bitmap

The Bitmap object displays a graphical image, for example, a company logo.

Required data file: .bmp, .dib, .gif, .jpg, or .ico

Section placement: possible in all sections.

Columns

Use the Columns object to manipulate the layout and repeating properties of graphic and text 
objects. Format the columns in the Column Properties Dialog Box. 

Required data file: none 

Section placement: possible in all sections. 
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Page Break

Use the Page Break object to insert a manual page break in your report. 

Required data file: None 

Section placement: Possible in Qual repeating, Quan repeating, and nonrepeating sections. 

Table Objects

Table objects contain tabular information. The columns of table objects can be added, 
deleted, and ordered. You can also create custom columns. The columns in the table fill with 
data when a report template is resolved with Xcalibur data.

These table objects are available in XReport:

Avalon Qual Events Table Library Search Results Table

Avalon Quan Events Table Processing Method Programs Table

Calibration File Table Processing Method Sample Reports Settings 
Table

Component Cal Level Table Processing Method Summary Reports Settings 
Table

Component QC Level Table Qual Peak Table

Component Spectrum Table Quan Peak Table

Dilution Factor Table Qual Summary Table

Electronic Signature Table Quan Summary Table

Ion Ratio Confirmation Results Table Sample Table

IRC Settings Table Sequence Table

IRC Summary Table Spectrum Candidate Results Table

Library Search Graphics Table Spectrum List Table
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Avalon Qual Events Table

The Avalon Qual Events table displays details of the Avalon peak detection algorithm events 
configured in the Qual section of a processing method.

Required data file: .pmd

Section placement: Nonrepeating section

This table has the following possible fields: 

• Time (ms) 

• Kind 

• Event OPCode 

• Event 

• Value 

• Value 2 

• User Columns 1 to 5 

Avalon Quan Events Table

The Avalon Quan Events table displays details of the Avalon peak detection algorithm events 
configured for a component in the Quan section of a processing method.

Required data file: .pmd

Section placement: Quan nonrepeating, repeats on component peak 

This table has the following possible fields: 

• Time 

• Kind 

• Event OPCode 

• Event 

• Value 

• Value2 

• User Columns 1 to 5 
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Calibration File Table

The Calibration File table displays calibration levels, raw file names, and acquisition dates of 
standards.

Required data file: .xcal, .sld, .raw 

Section placement: Nonrepeating section

This table has the following possible fields: 

• Level 

• Response Factor 

• Component Name 

• Average Response Factor 

• %RSD 

• User Columns 1 to 5 

Component Cal Level Table

The Component Cal Level table displays the calibration levels, amounts, and acceptance test 
values defined for a specific component.

Required data file: .pmd

Section placement: Nonrepeating or Quan nonrepeating, repeats on component peak 

This table has the following possible fields: 

• Component Name 

• Cal Level 

• Amount 

• User Columns 1 to 5 
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Component QC Level Table

The Component QC Level table displays the QC levels, amounts, and percent test values 
defined for a specific component.

Required data file: .pmd

Section placement: Quan nonrepeating, repeats on component peak 

This table has the following possible fields: 

• QC Level 

• Amount 

• Test % 

• Component Name 

• User Columns 1 to 5 

Component Spectrum Table

The Component Spectrum table displays m/z and intensity data for up to fifty spectrum 
peaks. The Xcalibur data system uses this data to identify components when the Spectrum 
Peak Identification Method is specified in the processing method.

Required data file: .pmd

Section placement: Quan nonrepeating, repeats on component peak 

This table has the following possible fields: 

• # 

• m/z 

• Intensity (%) 

• User Columns 1 to 5 

Note  This method is only used for GC chromatography.
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Dilution Factor Table

The Dilution Factor table displays the names of calibration levels and dilution factors for 
components other than internal standards.

Required data file: .rst

Section placement: Nonrepeating section

This table has the following possible fields:

• Calibration Level 

• Dilution 

• User Columns 1 to 5 

Electronic Signature Table

The Electronic Signature table object displays up to six electronic signatures in table format.

Required data file: none

Section placement: possible in all sections.

The Electronic Signature table object displays two blocks of signatures. The Created By block 
displays the signature of the person who created the report. The Signed By block displays the 
signatures of the people who entered electronic signature information at the time the report 
was created. This object displays the electronic signature data in the following columns:

• Logon Name 

• Full Name 

• Date and Time 

• Comment 

Note  The Xcalibur application generates Electronic Signature information at the time the 
report is created, and the signature information can only be included in reports generated 
from either the Xcalibur Sequence Setup or Quan Browser. Reports generated from within 
XReport do not display signature information.
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Ion Ratio Confirmation Results Table

The Ion Ratio Confirmation Results table displays data about each qualifier ion, based on 
search criteria specified in the processing method.

Required data file: .rst

Section placement: Quan nonrepeating, repeats on component peak 

This table has the following possible fields: 

• Qualifier Ion # 

• Mass 

• Qualifier Ion Found 

• Coelution Passed 

• Ion Ratio Passed 

• Absolute Window % 

• Actual Ion Ratio % 

• Target % 

• Target Range % 

• User Columns 1 to 5 

IRC Settings Table

The IRC Settings Table displays up to five qualifier ions within tolerance limits to confirm the 
detection of a target analyte. The ions are specified in the processing method.

Required data file: .pmd

Section placement: Quan nonrepeating, repeats on component peak 

This table has the following possible fields: 

• Qualifier Ion # 

• m/z 

• Target Ratio (%) 

• Window (±%) 

• User Columns 1 to 5 
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IRC Summary Table

The IRC Summary table displays all of the information for the qualifier ion for each 
component. Most useful when the Name column is the first column.

Required data file: .rst

Section placement: Nonrepeating section

This table has the following possible fields: 

• Component Name 

• RT 

• Mass 

• Response 

• Calculated Amount 

• Actual Ion Ratio % 

• Ion Ratio Passed 

• Target Range % 

• Qualifier Ion # 

• User Columns 1 to 5 

Library Search Graphics Table

The Library Search Graphics table displays the graphical results from a library search on a 
Qual peak.

Required data file: .rst, .raw

Section placement: Qual nonrepeating, repeats on Qual peak

This table has the following possible fields:

• Hit Spectrum 

• Delta 

• Compound Structure 
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Library Search Results Table

The Library Search Results table displays the results of a library search on a Qual peak.

Required data file: .rst, .raw

Section placement: Qual nonrepeating, repeats on Qual peak

This table has the following possible fields:

• SI 

• RSI 

• Compound Name 

• Cas # 

• Probability 

• Area 

• Area % 

• Library 

• Molecular Formula 

• Molecular Weight 

• RT 

• Scan # 

• User Columns 1 to 5 
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Processing Method Programs Table

The Processing Method Programs table displays a list of programs to be run by the Xcalibur 
application after the sample has been analyzed and the data has been processed. The 
application runs programs in the order listed.

Required data file: .pmd

Section placement: Nonrepeating section

This table has the following possible fields: 

• Num 

• Enable 

• Std 

• QC 

• Unk 

• Action 

• Other 

• Parameters 

• Program or Macro Name 

• Sync 

• User Columns 1 to 5 
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Processing Method Sample Reports Settings Table

The Processing Method Sample Reports Settings table displays sample report information for 
each sample in a sequence, including the template name and the report file name. Specify the 
sample type in the processing method.

Required data file: .pmd

Section placement: Nonrepeating section

This table has the following possible fields: 

• Num 

• Enable 

• Std 

• QC 

• Unk 

• Other 

• Report Template Name 

• Save As 

• User Columns 1 to 5 

Processing Method Summary Reports Settings Table

The Processing Method Summary Reports Settings table displays summary reports to be 
issued after processing the samples in a bracketed or non-bracketed sequence.

Required data file: .pmd

Section placement: Nonrepeating section

This table has the following possible fields:

• Num 

• Enable 

• Save As 

• Report Template Name 

• User Column 1 to 5 
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Qual Peak Table

The Qual Peak table displays information specific to chromatogram peaks detected by 
qualitative analysis for a single sample. 

Required data file: .rst

Section placement: Nonrepeating section

This table has the following possible fields: 

• RT 

• Peak Area 

• Peak Height 

• BL 

• S/N 

• Area % 

• Peak Width 

• Saturated 

• User Column 1 to 5 

Note  To display information on chromatogram peaks for an entire sequence, use the Qual 
Summary Table. 
Thermo Scientific XReport User Guide 175



D XReport Reference
Report Objects
Quan Peak Table

The Quan Peak table displays information specific to component peaks detected by 
quantitative analysis for a single sample.

Required data file: .pmd, .rst 

Section placement: Nonrepeating section

The Quan Peak table has the following possible fields: 

Note  To display component peak information for all samples in a sequence, use the Quan 
Summary Table object. 

• Component Name 

• RT 

• Calculated Amount 

• Response 

• BL 

• %Diff 

• Area 

• Area % 

• Area Ratio 

• Calibration Flags 

• Component Found 

• Component Type 

• Data Flags

• Expected RT 

• Height 

• Height Ratio 

• Ion Ratio Status 

• ISTD Area 

• ISTD Height 

• ISTD Name 

• ISTD Response 

• Keys 

• Peak Purity 

• Peak Status 

• Response Ratio 

• S/N 

• Sample Type 

• Saturated 

• Specified Amount 

• System Suitability 

• Units 

• Width 

• User Columns 1 to 5 
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Qual Summary Table

The Qual Summary table displays information specific to chromatogram peaks detected by 
qualitative analysis for all samples in a sequence.

Required data file: .sld, .rst

Section placement: Nonrepeating section

The Qual Summary table has the following possible fields:

• RT 

• Peak Area 

• Peak Height 

• BL 

• Data File Name 

• Sample ID 

• S/N 

• Area % 

• Peak Width 

• Saturated 

• User Column 1 to 5 

Note  To display peak information for a single sample only, use the Qual Peak Table 
object. 
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Quan Summary Table

The Quan Summary table displays information specific to component peaks detected by 
quantitative analysis for all samples in a sequence.

Required data file: .sld, .pmd, .rst

Section placement: Nonrepeating section

The Quan Summary table has the following possible fields:

Note  To display component peak information for a single sample only, use the Quan Peak 
Table object.

• Component Name 

• RT 

• Calculated Amount 

• Response 

• BL 

• %Diff 

• Area 

• Area % 

• Area Ratio 

• Calibration Flags 

• Component Found 

• Component Type 

• Data File Name 

• Data Flags

• Expected RT 

• Height 

• Height Ratio 

• Ion Ratio Status 

• ISTD Area 

• ISTD Height 

• ISTD Name 

• ISTD Response 

• Keys 

• Peak Purity 

• Peak Status 

• Response Ratio 

• S/N 

• Sample ID 

• Sample Type 

• Saturated 

• Specified Amount 

• System Suitability 

• Units 

• Width 

• User Columns 1 to 5 

•
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Sample Table

The Sample table displays system suitability and flag processing results for each component in 
a sample, and repeats this information for every sample in a sequence.

Required data file: .sld

Section placement: Quan nonrepeating, repeats on component peak 

The Sample table has the following possible fields: 

• Sample ID 

• Data File Name 

• Area 

• Area Ratio 

• ISTD Area 

• Specified Amount 

• %Diff 

• %RSD 

• Actual RT 

• Calculated Amount 

• Calibration Flags

• Data Flags

• Excluded 

• Height 

• ISTD Height 

• Height Ratio 

• QC Failed 

• System Suitability 

• User Columns 1 to 5 
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Sequence Table

The Sequence table displays the contents of the sequence file.

Required data file: .sld

Section placement: Nonrepeating section

The Sequence table has the following possible fields: 

• Sample Type 

• File Name 

• Sample ID 

• Path 

• Inst Method 

• Cal File 

• Dil Factor 

• Inj Vol 

• ISTD Corr Amt 

• Level 

• Proc Method 

• Sample Vol 

• Sample Wt 

• Position 

• User Labels 1 to 5 

• User Columns 1 to 5 
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Spectrum Candidate Results Table

The Spectrum Candidate Results table displays the results of spectrum candidate processing 
for GC/MS data on a per component basis.

Required data file: .rst

Section placement: Nonrepeating section

The Spectrum Candidate Results table has the following possible fields: 

• Component Name 

• Cand. # 

• Forward Fit 

• Reverse Fit 

• Match 

• Area 

• End RT 

• Found RT 

• Height 

• Start RT 

• User Columns 1 to 5 

Spectrum List Table

The Spectrum List table displays the text equivalent of the spectrum graphic object.

Required data file: .rst, .raw 

Section placement: Qual or Quan repeating section, repeats on Qual or component peak 

The Spectrum List table has the following possible fields: 

• m/z 

• Intensity 

• Relative 

• Wavelength 

• User Columns 1 to 5 
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Text Objects

Text objects contain text labels and associated text fields. These fields can be deleted, 
cut/copied, and pasted anywhere in the report template (for example, a header). The text 
object fields are replaced with textual information when a report template is resolved with 
Xcalibur data.

These text objects are available in XReport:

Annotation

Use the Annotation object to insert static text into your report. To enter the text, right-click 
the object and choose Properties from the shortcut menu. The Annotation Properties dialog 
box opens. Type your text in the box. 

Required data file: None 

Section placement: Possible in all sections. 

Component IdentDetectCal Settings

The Component IdentDetectCal Settings object shows the peak detection, calibration, and 
integration parameters for a single component.

Required data file: .pmd

Section placement: Quan repeating section, repeats on component peak 

For this object’s possible fields and headings, see Table 67.

Component ISTD Settings Summary

The Component ISTD Settings object displays a summary of the configuration details for 
each component's ISTD configuration in the Quantitation section of a processing method.

Required data file: .pmd

Section placement: Quan repeating section, repeats on component peak 

For this object’s possible fields, see Table 67.

Annotation Processing Method - General

Component IdentDetectCal Settings Processing Method - Qual

Component ISTD Settings Summary Quan ISTD Peak Summary

Component Settings Summary Quan Peak Summary

Component Sys Suit/Flags Settings Report Info 

Instrument Method Sample Header
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Table 67. Component ISTD Settings object fields 

• Component Name 

• Detector Type 

• Filter 

• Trace 

• Mass Range 

• Wavelength Range 1 

• Wavelength Range 2 

• Expected Retention 
Time 

• Retention Time 
Window 

• View Width 

• Retention Time 
Reference 

• Component Type 

• ISTD Name 

• Peak Detection 
Algorithm 

Genesis Peak 
Integration/Detection

• Genesis Smoothing 
Points 

• Valley Detection 
Enabled 

• Genesis Constrain Peak 
Width 

• Genesis Identify By 

• Genesis Minimum 
Peak Height 

ICIS Peak 
Integration/Detection

• ICIS Smoothing Points 

• ICIS Constrain Peak 
Width 

• ICIS Identify By 

• ICIC Minimum Peak 
Height 

Avalon Peak 
Integration/Detection

• Avalon Smoothing 
Points 

Other

• <Blank Line > and 
<User Text> Data 
Items
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Component Settings Summary

The Component Settings Summary object displays a short list of peak detection and 
integration parameters for a specified component.

Required data file: .pmd

Section placement: Quan repeating section, repeats on component peak 

For this object’s possible fields and headings, see Table 68.

Table 68. Component Settings Summary object fields/headings 

• Component Name 

• Detector Type 

• Filter 

• Trace 

• Mass Range 

• Wavelength Range 1 

• Wavelength Range 2 

• Expected Retention 
Time 

• Retention Time 
Window 

• View Width 

• Retention Time 
Reference 

• Component Type 

• ISTD 

• Standard Dilution - 
Base Amount 

• Peak Detection 
Algorithm 

Genesis Peak 
Integration/Detection

• Genesis Smoothing 
Points 

• Valley Detection 
Enabled 

• Genesis Constrain Peak 
Width 

• Genesis Identify By 

• Genesis Minimum 
Peak Height 

ICIS Peak 
Integration/Detection

• ICIS Smoothing Points 

• ICIS Constrain Peak 
Width 

• ICIS Identify By 

• ICIC Minimum Peak 
Height 

Avalon Peak 
Integration/Detection

• Avalon Smoothing 
Points 

Other

• <Blank Line > and 
<User Text> Data 
Items
184 XReport User Guide Thermo Scientific



 D XReport Reference
Report Objects
Component Sys Suit/Flags Settings

The Component Sys Suit/Flags Settings object displays calibration, quantitation, and 
detection flags along with system suitability parameters, which allow automatic 
chromatographic checks that assign a pass/fail qualification to a target peak.

Required data file: .pmd

Section placement: Quan nonrepeating, repeats on component peak 

For this object’s possible fields and headings, see Table 69.

Instrument Method

The Instrument Method object displays general instrument method parameters.

Required data file: .raw

Section placement: Nonrepeating section

This object displays instrument method information for all the instruments associated with 
a .raw file. This object uses the default data, attribute, and font settings from Qual Browser, 
and has no configurable properties. 

Table 69. Component Sys Suit/Flags Settings object fields/headings 

System Suitability

• Component Name 

Resolution Parameters

• Resolution Threshold 

Symmetry Parameters

• Symmetry Peak Height 

• Symmetry Threshold 

Peak Classification 
Parameters

Detect Peak Width

• Width Peak Height 

• Min. Peak Width 

• Max. Peak Width 

Detect Tailing

• Tail Peak Height 

• Tail Failure Threshold 

Detect Column Overload

• Over Peak Height 

• Over Failure Threshold 

Detect Baseline Clipping

• Num. of Peak Widths 
for Noise Detection 

Detect Minimum 
Signal-to-Noise Ratio

• Signal-to-Noise Ratio 

Calibration and 
Quantitation Flags

Calibration Flag

• R-Squared 

Quantitation Flags

• Detection Limit 

• Quantitation Limit 

• Linearity Limit 

• Carry Over Limit 

Detection Flags

• Area Threshold 

• Height Threshold 

Other

• <Blank Line > and 
<User Text> Data 
Items
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Processing Method - General

The Processing Method - General object displays general processing method parameters.

Required data file: .pmd

Section placement: Nonrepeating section

For this object’s possible fields and headings, see Table 70.

Processing Method - Qual

The Processing Method - Qual object displays Qual processing method parameters.

Required data file: .pmd

Section placement: Nonrepeating section

For this object’s possible fields and headings, see Table 71.

Table 70. Processing Method – General object fields/headings 

Identification Baseline Options Other

• Created By 

• When Created 

• Last Modification 

• Modified By 

• Summary 

• Void Time 

• Baseline and Noise 
Window 

• Baseline Noise 
Tolerance 

• Min. Number of Scans 
in Baseline 

• Chromatography By 

• Calibration By 

• <Blank Line > and 
<User Text> Data 
Items
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Table 71. Processing Method – Qual object fields/headings 

Identification

• Detector Type 
• Detector Delay 
• Filter 
• 1st Trace Type 
• Operator 
• 2nd Trace Type 
• Mass Range 1 
• Wavelength Range 1 
• Mass Range 2 
• Wavelength Range 2 
• Range 

Detection Options

• Peak Detection 
Algorithm 

Genesis Peak Integration

• Genesis Smoothing 
Points 

• S/N Threshold 
• Valley Detection 
• Expected Peak Width 
• Genesis Constrain Peak 

Width 
• Genesis Peak Height 
• Genesis Tailing Factor 

Avalon Peak Integration

• Avalon Smoothing 
Points 

Limit Peaks

• Select Top Peaks 
• Select By 
• Number To Select 
• Relative Peak Height 

Threshold 
• Percent of Highest 

Peak 

Advanced Detection 
Options

Genesis Peak Detection

• Genesis Identify By 
• Minimum Masses 

Required 
• Minimum Percent of 

Masses Found 
• Minimum Peak Height 

Genesis Peak Edge 
Detection

• Peak S/N Cutoff 
• Report Noise As 

ICIS Advanced 
Parameters

• Noise Method 
• Minimum Peak Width 
• Multiplet Resolution 
• Area Tail Extension 
• Area Scan Window 

Spectrum Enhancement

• Spectrum 
Enhancement Usage 

Refine

• Window Size 
• Noise Threshold 

Combine

Background Subtraction 
Left Region 

• Left Region Width 
• Region End 

Peak Top Region

• Width 

Options

• Maximum Number of 
Hits 

• Reverse Search 
• Search with MW 

Append to User Library

• Availability 
• User Library 
• Match Factor 
• Reverse Match Factor 
• Probability 
• Search Libraries 

Library Search 
Constraints

• Molecular Weight 
Range 

• Other Databases 
• Name Fragment 
• Element Constraints 

Enabled 
• Elements in 

Compound 
• Element Infiltration 
• Mass Spectral Peak 

Constraints Enabled 
• Mass Spectral Peak 

Measurement 

ICIS Peak Integration

• ICIS Smoothing Points 
• Baseline Window 
• Area Noise Factor 
• Peak Noise Factor 
• ICIS Constrain Peak 

Width 
• ICIS Peak Height 
• ICIS Tailing Factor 

Genesis Apex Detection

• Window Size 
• Filter Width 

Genesis Valley Detection

• Rise % 
• Valley S/N 

Genesis Background 
Subtraction

• Recomputation 
Interval 

• Number of Scans in 
Background 

Background Subtraction 
Right Region 

• Right Region Width 
• Region Start 

Threshold

• Cutoff Threshold 

Library Search Options

Search Type

• Identity 
• Similarity 

Peak Purity Options

• Scan Threshold 
• Peak Coverage 
• Limit Scan Wavelength 

Range 

Other

• <Blank Line > and 
<User Text> Data 
Items
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Quan ISTD Peak Summary

The Quan ISTD Peak Summary object displays summary parameters for a Quan 
component's associated ISTD peak.

Required data file: .pmd, .rst 

Section placement: Quan nonrepeating, repeats on component peak 

For this object’s possible fields, see Table 72.

Quan Peak Summary

The Quan Peak Summary object displays component peak summary parameters.

Required data file: .pmd, .rst 

Section placement: Quan nonrepeating, repeats on component peak 

For this object’s possible fields, see Table 73.

Table 72. Quan ISTD Peak Summary object fields

• Component Name 

• ISTD Name 

• Actual RT 

• Response 

• Height 

• Width 

• Baseline Flags 

• Area 

• Signal-to-Noise 

• Saturated 

• Expected RT 

• Peak Status 

• System Suitability 

• Data Flags 

• <Blank Line > and 
<User Text> Data 
Items

Table 73. Quan Peak Summary object fields

• Component Name 

• Actual RT 

• Specified Amount 

• Calculated Amount 

• %Diff 

• Response 

• Response Ratio 

• Area 

• Area Ratio 

• Height 

• Height Ratio 

• Width 

• Ion Ratio Status 

• Peak Purity 

• Baseline Flags 

• Signal-to-Noise 

• Saturated 

• Expected RT 

• Sample Type 

• Component Type 

• Peak Status 

• System Suitability 

• Data Flags 

• Calibration Flags 

• <Blank Line > and 
<User Text> Data 
Items
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Report Info

The Report Info object displays general information about the report itself.

Required data file: None

Section placement: Report header and footer 

For this object’s possible fields, see Table 74.

Sample Header

The Sample Header object displays general information about a sample.

Required data file: .raw, .sld 

Section placement: Report header or footer or Nonrepeating section

For this object’s possible fields, see Table 75.

Table 74. Report Info object fields

• Page [a] of [b] 

• Date and Time 

• Template File 

• Layered App Name 

• Layered App Version 

• <Blank Line > and <User Text> Data Items

Table 75. Sample Header object fields

• Data File 

• Original Data Path 

• Current Data Path 

• Sample Type 

• Sample ID 

• Sample Name 

• Operator 

• Acquisition Date 

• Run Time 

• Comments 

• Vial 

• Injection Volume 

• Scans 

• Low Mass 

• High Mass 

• Sample Volume 

• Sample Weight 

• ISTD Amount 

• Calibration Level 

• Dilution Factor 

• Instrument Method 

• Processing Method 

• Current Processing 
Method 

• Calibration File 

• Revision 

• Barcode 

• Barcode Status 

• User Labels 1 to 5 

• <Blank Line > and 
<User Text> Data 
Items
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System Suitability Flags

The Quan Summary Table, Quan ISTD Peak Summary, Sample Table, and Quan Peak Table 
objects have an available System Suitability field, which displays the results of any system 
suitability tests carried out on the specified peak. Each test is represented by a flag letter. 
XReport displays the flags in categories according to whether the peak passed, failed, or was 
not tested.

These are the System Suitability flags.

Table 76. System Suitability flags 

Flag Description

S Symmetry: A peak passes this test if its calculated symmetry is greater than the 
symmetry threshold specified in the System Suitability page of Quan View in 
Processing Setup.

S Resolution: A peak passes this test if its calculated resolution is greater than the 
resolution threshold specified in the System Suitability page of Quan View in 
Processing Setup.

W Peak Width: A peak passes this test if its width falls between the minimum and 
maximum values specified in the System Suitability page of Quan View in 
Processing Setup.

T Tailing: A peak passes this test if its calculated tailing falls below the threshold 
specified in the System Suitability page of Quan View in Processing Setup.

O Column Overload: A peak passes this test if its calculated overloading falls 
below the threshold specified in the System Suitability page of Quan View in 
Processing Setup.

B Baseline Clipping: A peak passes this test if baseline clipping is not detected.

N Signal to Noise Ratio: A peak passes this test if its signal-to-noise ratio falls 
above the threshold specified in the System Suitability page of Quan View in 
Processing Setup.

C Concave: A peak passes this test if it does not exhibit a concave depression due 
to noise.

D Saturation: A peak passes this test if the detector did not saturate during data 
acquisition.
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<Blank Line > and <User Text> Data Items

All text objects except for the Annotation object and Instrument Method object have two 
special data items, <Blank Line> and <Text>. These data items appear in the Available Items 
list of the Data Page.

When you insert the <Blank Line> data item in the Selected list, XReport inserts a blank line 
at that spot. You can use this to control the spacing between items in a text object. Unlike 
ordinary data items, a <Blank Line> can appear in the Selected list more than once.

The <User Text> item allows you to insert additional custom text into the text object. The 
<User Text> item can be added to the Selected list more than once, and each instance can be 
configured to display different custom text. Custom text is displayed using the font settings 
for Headings.

Baseline Flags

The Quan Peak Summary, Quan ISTD Peak Summary, Quan Peak Table, Qual Peak Table, 
Qual Summary Table, and Quan Summary Table objects have an available Baseline flags field 
that displays how the data system detected the left and right peak edges of the current peak. 
The flags are displayed in pairs, with the first letter of the pair indicating the detection 
method for the left edge of the peak, and the second letter indicating the detection method for 
the right edge of the peak.

These are the Baseline flags.

Table 77. Baseline flags 

Flag Description

B Baseline: The edge of the peak is at baseline level.

V Valley: The edge of the peak is in a peak valley.

M Manual: The edge of the peak has been adjusted manually.

S Stripe: The edge of the peak reached the Constrain Peak Height Percent 
specified in the method.

T Tail: The edge of the peak reached the Constrain Peak Height Tailing Factor 
limit before the Height Percent.

- Tilt: An error occurred before the edge of the peak could be determined.

? Unknown: An unknown error occurred.
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Data Flags

XReport can display Data Flag letters in the Quan Summary Table, Quan ISTD Peak 
Summary, Quan Peak Table, and Quan Summary Table objects to indicate when a peak has 
exceeded threshold area or height values specified in Quan Browser. These are the data flags 
that can appear.

Calibration Flags

XReport can display Calibration Flag letters in the Quan Peak Summary, Quan Summary 
Table, and Quan Peak Table objects to indicate when certain peak characteristics exceed values 
specified in Quan Browser. These are the calibration flags that can appear.

Table 78. Data flags 

Flag Description

A Indicates that the peak area is outside the specified tolerance.

H Indicates that the height is outside the specified tolerance.

Table 79. Calibration flags 

Flag Description

E Detection limit: Indicates that the detection threshold for the concentration of 
the quantified peak is outside the specified tolerance. 

L Carry Over limit: Indicates that the carryover threshold for the concentration of 
the quantified peak is outside the specified tolerance.

Q R-squared: Indicates that the coefficient of determination is outside the specified 
tolerance. 

U Quantitation limit: Indicates that the quantitation threshold for the 
concentration of the quantified peak is outside the specified tolerance.

Y Linearity limit: Indicates that the linearity threshold for the concentration of the 
quantified peak is outside the specified tolerance.
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Report Templates
An XReport template is an XReport document (.xrt file) that defines the content, layout, and 
style of an Xcalibur report. You can include sections and report objects in the report template. 
An Xcalibur report is generated when a report template is resolved (combined) with Xcalibur 
data (data source files).

XReport comes with several example Xcalibur 2.0 report templates for you to use. These 
templates, described below, are located in the Xcalibur\Templates folder.

Table 80. XReport templates  (Sheet 1 of 2)

Report names Description Files needed 

CalibrationFile For reporting calibration data. .raw, .xcal

CompCalReport:
_Avalon,_Genesis,_ICIS

Generates summary reports showing processing method 
details, calibration curve, and sample table (Quan results). 
Use this report with results from Xcalibur batch processing and 
Quan Browser. 

.rst, .raw, .pmd,

.sld 

CustLibrSearRept
LibrarySearchReport

Generates Qual sample reports that display Qual peaks and 
library search details. Use this report with results from Xcalibur 
batch processing. 

.rst, .raw 

IonRatio
Confirmation

Generates a Quan sample report containing non-graphical ion 
ratio confirmation results. 

.rst, .raw, .pmd

IonRatio
Confirmation:

Graphical, GraphicalSimple, 
GraphicalStacked

Generates Quan sample reports containing graphical ion ratio 
confirmation results. These report templates take advantage of 
the explicit qualifier ion settings available when using the 
Chromatogram Properties Dialog Box and Wizard.

.rst, .raw, .pmd 

Peak Integration Generates a Quan sample report containing peak integration 
data generated using the Genesis peak integration algorithm. 

.rst, .raw, .pmd 

ProcessingMethod:
_Avalon, _Genesis, _ICIS

Generates processing method reports. Use this report with 
results from Xcalibur Processing Method Setup. 

.pmd

QualPeak Report Generates a simple Qual sample report. Use this report with 
results from Xcalibur batch processing. 

.rst, .raw 

QuanPeakResults:
_ISTD, _ESTD
QuanResults
QuanSimple

Generates Quan sample reports. Use this report with results 
from Xcalibur batch processing or Quan Browser. 

.rst, .raw, .pmd 

QuantifySampleReport Generates Quan sample reports containing chromatograms 
and a Quan summary table. 

.sld, .pmd, .rst,

.raw 
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Sequence
Report

Generates a summary report showing the sequence being 
processed. Use this report with results from Xcalibur batch 
processing. 

.sld

Spectrum
Candidates

Generates a Quan sample report (only applicable to GC/MS). 
Use this report with results from Xcalibur batch processing or 
Quan Browser. 

.rst, .raw 

Table 80. XReport templates  (Sheet 2 of 2)

Report names Description Files needed 
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Index
Numerics
2-column objects

in a nonrepeating section, with chromatogram and 
spectrum  99

in a nonrepeating section, with chromatogram and 
spectrum objects  100

in nonrepeating section with chromatogram  99
Left to right option  100
Top to bottom option  100

A
adding

custom text fields  48
objects  18
sections  16

Advanced Qual Peak Annotation Options
parameters  124
setting  85

Advanced Quan Peak Annotation Options  126
aligning objects  19
annotation object  182
Annotation Properties dialog box

Attributes page  53
configuring an object  52
Font page  53

Avalon Qual Events table  166
Avalon Quan Events table  166
Average Scan Filter Selection dialog box  149

B
Batch Reprocess dialog box  33
batch reprocessing, generating reports while  33
bitmap object

configuring  66
details  164

Bitmap Properties dialog box  152

C
Calibration File table  167
centering objects  19
choosing data sources  27
choosing table columns  55
chromatogram object  164
Chromatogram Properties dialog box  67
Chromatogram Properties wizard

Configure How the Peak Window Will Look page  126
Configure Normalization For The Chromatogram page  

127
reference  123
Select Chromatogram Style page  128
Select Chromatogram Type page  128
Select Component page  129
Select Demo File page  129
Select Enhance Details page  130
Select How The Chromatogram Axes Will Be Configured 

page  130
Select Mass Spectrum Quan Traces to Display page  131
Select Plot Details page  131
Select the Peak Labeling page  134
Select the Qual Peak page  134
Select the Quan Peak page  135
Use Container Supplied Qual Peak page  135
Use Container Supplied Quan Peak page  136

chromatograms, configuring  67
Column Properties dialog box

adding columns  21
parameters  154

columns
configuring  98
introduction  164
repeating behavior  98
resizing in a table  18
summary repeating  98–99
using  20

combined (resolved) documents  7
Component Cal Curve object  164
Component Cal Level table  167
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Index: D
Component Calibration Curve Configuration wizard  9
Component calibration curve, configuring  88
Component IdentDetect Cal Settings  182
Component Ion Ratio table  170
Component ISTD Settings Summary  182
Component QC Level table  168
Component Settings Summary  184
Component Spectrum table  168
Component Sys Suit/Flags Settings  185
Configure Component Calibration Curve dialog box  156
Configure Function dialog box  145
Configure Repeating Section dialog box

Exclude page  122
Ordering page  122
Page Breaks page  123
reference  121

configuring
annotation objects  52
bitmap objects  66
chromatograms  67
component calibration curves  88
repeating sections  17
spectra  89
table objects  54
text attributes  50
XReport Objects  8

creating
reports from Xcalibur  30
reports within XReport  27
templates  12

custom columns, configuring  55
custom text fields

adding  48
editing  49

D
Data Source Browser  9
data source files  7
Data Sources dialog box

reference  156
selecting data sources  28

default data set  25
deleting

objects  18
sections  16

Dilution Factor table  169

E
Edit Formula For dialog box

configuring custom columns  57
parameters  144

electronic signature  169
electronic signatures, creating a report with  37
exiting XReport  13

F
Font dialog box  51, 59
fonts

settings  23, 51
table  59

footer sections  4
formatting objects  7

G
generating reports

using a report template  13
when running a sample or sequence  31

graphic objects  6
grid, report template  19

H
header sections  4

I
instrument method  185
Ion Ratio Confirmation Result table  170
IRC Settings table  170
IRC Summary table  171

L
Layout menu  119
Library Search Graphic Table Properties dialog box

parameters  149
setting properties  61

Library Search Graphics table  171
Library Search Results table  172
Library Search Results Table Properties dialog box

parameters  150
setting properties  61

locking a template  26

N
nonrepeating sections  4, 159

O
objects

adding  18
aligning  19
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Index: P
annotation  52
centering  19
configuring  21
configuring bitmap  66
deleting  18
formatting  7
graphic  6
reference  182
repositioning  18
resizing  18
table  6, 54, 105
text  5, 103
types of objects  5

P
page breaks  21, 165
page layout  24
Page Setup dialog box  24
Preferences dialog box, reference  157
Preview window  25, 29, 157
previewing a template  25
processing method

fields  186
general  186
Programs table  173
Qual  186
Sample Reports Settings table  174
sample table  174
Summary reports settings table  174
summary table  174

Processing Setup, setting report options in  31

Q
Qual Peak table  175
Qual repeating section  161
Qual Summary table  177
Quan Browser window - Reports dialog box  35
Quan Browser, generating a report from  34
Quan ISTD Peak summary  188
Quan Peak summary  188
Quan Peak table  176
Quan repeating section  162
Quan Summary table  178

R
reordering sections  16
repeating objects in columns  98
Repeating Section Configuration dialog box  8
Repeating Section Properties dialog box

configuring a repeating section  17

Exclude page  44
Ordering page  45
Page Breaks page  46

repeating sections  4
report info  189
report objects  182
report options, in Processing Setup  31
report template grid  19
Report Template Outline pane  3
report templates  193
reports

creating from Xcalibur  30
creating within XReport  27
generating  13
generating from Quan Browser  34
generating from Sequence Setup  30
generating when batch reprocessing a sequence  33
generating when running a sample or sequence  31
resolved (combined) documents  7

Reports view  115
repositioning objects  18
resizing objects  18
resizing sections  16
Run Sequence dialog box  32

S
sample header object  189
sample reports  30
sample table

fields  179
properties  61

Sample Table Properties dialog box  61
Save As dialog box  26, 158
saving a template  25
sections

adding  16
deleting  16
footer  4
header  4
nonrepeating  4, 159
Qual repeating  161
Quan repeating  162
reordering  16
repeating  4

configuring  17, 43
reports  159
resizing  16
types of sections  4

Select A Peak dialog box  127
Select Component dialog box  89
Select Report Samples dialog box  36
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Index: T
Sequence Setup, generating a report from  30
sequence table  180
setting table fonts  59
setting table properties  60
signatures, electronic  37
sorting tables  58
specifying table sort order  58
spectra, configuring  89
Spectrum Candidate Results table  181
Spectrum Configuration dialog box
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Table Configuration wizard  8
table objects  6
table properties
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Set Table Sort Filter page  58

Table Properties wizard
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reference  141
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Set Table Sort Filter page  143
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Template Configuration dialog box  159
templates
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definition  3
locking  26
overview  3
prebuilt  9
previewing  25
saving  25

text attributes, configuring  50
text fields

adding custom  48
configuring  47

Text Object Properties dialog box
adding custom text fields  48
Attributes page  152
Data page  47, 151
Font page  51, 152
reference  150

text objects  5

U
user columns, configuring  55
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XReport Spectrum Control Properties  90
XReport window

features  1
new template  11
Report Template Outline pane  3
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